Teamcenter 10.1

Getting Started with Workflow
Proprietary and restricted rights notice

This software and related documentation are proprietary to Siemens Product Lifecycle Management Software Inc.

© 2013 Siemens Product Lifecycle Management Software Inc. All Rights Reserved.

Siemens and the Siemens logo are registered trademarks of Siemens AG. Teamcenter is a trademark or registered trademark of Siemens Product Lifecycle Management Software Inc. or its subsidiaries in the United States and in other countries. All other trademarks, registered trademarks, or service marks belong to their respective holders.
Contents

Proprietary and restricted rights notice ........................................... 2

What is a workflow? ................................................................. 5

Using Workflow in Teamcenter .................................................. 7

Managing your worklist in My Teamcenter and the thin client ........... 9
Tasks to Perform folder .................................................................. 9
Tasks to Track folder .................................................................... 10

What is Workflow Viewer? ......................................................... 11

What is Workflow Designer? ...................................................... 13

Workflow process template ......................................................... 15

Workflow task template ............................................................. 17

What are workflow handlers? .................................................... 19

Explicit and assumed links ......................................................... 21

Configuring and customizing Workflow ....................................... 23

Tips for using the Workflow Designer user interface .................... 25
Refreshing Workflow Designer ................................................... 25
Delete key removes workflow objects and backspace key removes text 25
Save time when creating multiple tasks of the same type ............... 25
Move and resize the Handler dialog box ...................................... 26

Creating workflow templates .................................................... 1-1
Create workflow process templates in Workflow Designer ............. 1-1
Insert a task into a template ....................................................... 1-2
Configuring tasks, attributes, and handlers ................................ 1-6
Link tasks manually ..................................................................... 1-13
Designing subprocesses .............................................................. 1-13
Assigning tasks and signoffs ....................................................... 1-23
Workflow examples ...................................................................... 1-54
Determining when and where templates run ............................... 1-66
Editing templates ....................................................................... 1-75

Using workflows processes to accomplish tasks .......................... 2-1
Initiate a workflow process using My Teamcenter ....................... 2-1
Sign off on tasks ......................................................................... 2-3
## Contents

Performing tasks assigned to you ................................................. 2-11  
Altering started workflow processes .......................................... 2-23  
Working with remote tasks .......................................................... 2-29  
Stopping a workflow process in Workflow Viewer ............................ 2-33  
Delete a workflow process in My Teamcenter ................................. 2-34  
Viewing workflow and schedule progress ..................................... 2-34  

**View audit information** ............................................................. 3-1  
Viewing audit information ............................................................ 3-1  
View audit logs in the Summary view ........................................... 3-1  
Process reports ............................................................................. 3-3  
Creating and running audit queries .............................................. 3-3  
Export audit logs to Microsoft Excel ............................................. 3-4  
View legacy audit log information .................................................. 3-5  

**Glossary** .................................................................................. A-1  

**Index** .................................................................................... Index-1  

## Figures

Task actions and states ................................................................. 2-24
What is a workflow?

A workflow is the automation of business procedures in which documents, information, or tasks are passed from one participant to another in a way that is governed by rules or procedures. Teamcenter workflows allow you to manage your product data processes. You can create any type of workflow to accommodate your business procedures.

**Example**

A pharmaceutical company decides to implement workflows to shorten drug development time, speeding medicines to people in need and strengthening business performance.

After researching workflow solutions and investigating their own company processes, the company determines the need for imaging software to manage the drug test case report forms, data query software to reduce correction time when errors were found in clinical data, and data management software to enforce data integrity. Life cycle data management software such as Teamcenter provides all these solutions in a single product.

A production workflow is created and run in Teamcenter. The workflow is initiated against each product revision (each version of each drug testing). The workflow sends the required forms to the appropriate users, verifies product requirements, routes approvals and notifications to stakeholders, sends cost spreadsheets to the financial department at specific intervals, and rigorously manages the company’s change management processes.

The benefits of automating your business processes include:

- Improved efficiency. The automation of your business processes can result in the elimination of unnecessary steps.

- Better process control. Company business processes are more easily managed with standardized work methods and the availability of audit trails.

- Improved customer service. Consistent business processes increases predictability in levels of response to customers.

- Flexibility. Computer-modeled processes can be quickly and easily redesigned to meet changing business needs.

- Continual process improvement. The resulting focus on business processes leads to their streamlining and simplification.
Using Workflow in Teamcenter

You can use workflows in Teamcenter to manage your processes and changes in many applications.

- **Change Manager**
  Workflows are ideal for managing your change process as problem reports lead to change requests which lead to change notices. With a well-designed change process and matching workflow process template, you can ensure that the right people perform the correct tasks in the proper order.
  For more information about using workflows with Change Manager, see the *Change Manager Guide*.

- **Systems Engineering**
  A typical Systems Engineering workflow is the requirements, functional, logical, and physical design (RFLP) process. The process is iterative and may be repeated during the design or development of a product.
You can construct a workflow process template that matches your organization’s version of the RFLP process.

For more information about RFLP, see *Getting Started with Systems Engineering*.

These are only a couple of examples where workflows are used. You can apply workflows throughout Teamcenter.
Managing your worklist in My Teamcenter and the thin client

Your My Worklist tree includes your own user inbox and any remote inboxes and resource pool inboxes to which you are subscribed.

For information about subscribing to resource pools and remote inboxes, see Using resource pools and Using remote inboxes.

- Use your Inbox to perform workflow jobs and view task information.
- If your inbox contains unviewed tasks, the inbox name is highlighted and the number of unviewed tasks is displayed.
- Each inbox contains two folders, Tasks to Perform and Tasks to Track.

Note: The Tasks to Perform and Tasks to Track folders associated with remote inboxes cannot be expanded in the tree. To access these folders, click the link corresponding to the Inbox.

Tasks to Perform folder

Any tasks you are assigned appear in the Tasks to Perform folder. Once the completion criteria of a task are met (for example, the required quorum of approvals for a perform-signoffs task have been granted), the task is complete and is removed from the folder.

Tasks to Perform entries are color-coded to help you prioritize work based on duration:

- Black
  The task has no duration.
- Green
  The task has a duration that has not yet been exceeded.
- Red
Managing your worklist in My Teamcenter and the thin client

The task has a duration that has been exceeded.

When a task is completed, it moves from the Tasks to Perform list to the Tasks to Track list.

Note

- Duration is based on the start date plus time. The duration includes weekends and holidays and is based on a 7-day week.

- The Task Manager daemon must be installed to see color-coding.
  For more information, see the System Administration Guide.

Tasks to Track folder

If you initiate a process, but are not responsible for the currently active task, Teamcenter places the task in the Tasks to Track folder.

When the completion criteria of the task are met, the task is complete and is removed from the folder.
What is Workflow Viewer?

Workflow Viewer is an application that provides more functionality than is available in My Teamcenter for workflows. In Workflow Viewer, you can:

- View any initiated workflow process, whether it is currently in process or has already completed.
- Edit an active workflow process, if you have write permissions.

You can view workflow processes from your worklist by selecting a task and selecting Process View in the Viewer view. However, this method limits you to viewing only those workflow processes that contain tasks assigned to you at the time the task remains in your worklist.

However, Workflow Viewer allows you to view the progress of a workflow process, even if you are not a participating member of that particular workflow process. If you have read privileges for the workflow process data, you can view any workflow process in the database, whether it is currently in process or has already achieved its final status.

**Note**  
My Worklist in My Teamcenter is designed to provide a more streamlined process for progressing through workflow processes to which you are associated. The worklist lists only those tasks that you can perform or that you are assigned to track.

For more information about using your worklist, see the My Teamcenter Guide.

**Example**  
The following workflow process shows that the Change Admin I task is complete, that the Author Technical Recommendation task has started, and that the remaining tasks are pending. You can tell by the name of the Check Change Type task (a Condition task) that the workflow branches to either an author or CRB business decision, depending on what type of change object is the target of the workflow.
What is Workflow Viewer?
What is Workflow Designer?

Workflow stems from the concept that all work goes through one or more workflow processes to accomplish an objective. Workflow is the automation of these business processes. Using workflow, documents, information, and tasks are passed between participants during the completion of a particular workflow process.

As a system administrator, use Workflow Designer to design workflow process templates that incorporate your company’s business practices and procedures into workflow process templates. End users use the templates to initiate workflow processes in My Teamcenter and Workflow Viewer.

To design and maintain workflow processes in Workflow Designer, you can perform the following actions:

• Create templates.

• View templates.

• Add tasks to templates.

• Link tasks.

• Modify task behavior.

• Import and export workflow templates.
Workflow process template

A workflow process describes the individual tasks and the task sequence required to model the workflow process. Workflow process templates define a blueprint of a workflow process or task to be performed at your site.

**Browse mode** is the default mode when you first access the Workflow Designer. Click **Browse** to view workflow process data and the details of the workflow process. You cannot make any modifications in this mode.

The graphic-oriented Workflow Designer display allows you to easily browse through the workflow process templates.

For more information about viewing templates, see the *Workflow Designer Guide*. 
Workflow task template

A task template is a blueprint of a workflow task. A task is a fundamental building block used to construct a workflow process. Each task defines a set of actions, rules, and resources used to accomplish that task.

<table>
<thead>
<tr>
<th>Task</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do Task</td>
<td>Has two options if at least one failure path is configured: <strong>Complete</strong> confirms the completion of a task and triggers the branching to a success path. <strong>Unable to Complete</strong> indicates the task is unable to complete, for various reasons. Uses the <strong>EPM-hold</strong> handler, which stops the task from automatically completing when started.</td>
</tr>
<tr>
<td>Acknowledge Task</td>
<td>Uses the <strong>Acknowledged</strong> and <strong>Not Acknowledged</strong> subtasks, each of which has its own dialog box.</td>
</tr>
<tr>
<td>Review Task</td>
<td>Uses the <strong>select-signoff-team</strong> and <strong>perform-signoffs</strong> subtasks, each of which has its own dialog box. <strong>Wait for Undecided Reviewers</strong> is an option that allows the workflow designer user to set the <strong>Review</strong> task to wait for all reviewers to submit their decisions before completing and following the appropriate path. Uses the <strong>Review</strong>, <strong>Acknowledge</strong>, and <strong>Notify</strong> subtasks, each of which has its own dialog box.</td>
</tr>
<tr>
<td>Route Task</td>
<td>Use it as a starting point for creating your own custom tasks, such as tasks to carry your custom forms or other site-specific tasks for users to complete. This task template is synonymous with the <strong>EPMTask</strong> template.</td>
</tr>
<tr>
<td>Task</td>
<td>Branches a workflow according to defined query criteria. Requires that the succeeding task contains an <strong>EPM-check-condition</strong> handler that accepts a Boolean value of either <strong>True</strong> or <strong>False</strong>.</td>
</tr>
<tr>
<td>Condition Task</td>
<td>Branches a workflow along two or more paths. Active paths flowing out of the task are determined by whether specified workflow errors occur.</td>
</tr>
<tr>
<td>Validate Task</td>
<td>Use this task to design workflows around anticipated errors.</td>
</tr>
</tbody>
</table>
## Workflow task template

<table>
<thead>
<tr>
<th>Task</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add Status Task</strong></td>
<td>Creates and adds a release status to the target objects of the workflow process. It is a visual milestone in a workflow process. No dialog box is associated with this type of task.</td>
</tr>
<tr>
<td><strong>Or Task</strong></td>
<td>Continues the workflow process when any one of its multiple task predecessors is completed or promoted. There is no limit to the number of predecessors an Or task may have.</td>
</tr>
<tr>
<td><strong>Impact Analysis Task</strong></td>
<td>Provides an impact analysis for a user to complete for the associated EC revision. The task provides Reference, Impact Analysis Form, Viewer, and Task Info tabs.</td>
</tr>
<tr>
<td><strong>Prepare ECO Task</strong></td>
<td>Provides EC requests or EC orders for a user to complete. The task provides ECO Sample and Task Info tabs.</td>
</tr>
<tr>
<td><strong>Checklist Task</strong></td>
<td>Provides a checklist for a user to complete. The checklist form is a form type with a number of logical fields. You can create a custom form type with a site-specific field list using Java code to represent the form as a checklist. The task provides Check List and Task Info tabs.</td>
</tr>
</tbody>
</table>

**Note:** You can no longer create new instances of the Impact Analysis Task template, but you can continue to use existing or imported instances.

The Impact Analysis Task template is for use in EC processes only. It cannot be used on a workflow process.

**Note:** You can no longer create new instances of the Prepare ECO Task template, but you can continue to use existing or imported instances.

The Prepare ECO Task template is for use in EC processes only. It cannot be used on a workflow process.

**Note:** You can no longer create new instances of the Checklist Task template, but you can continue to use existing or imported instances.

The Checklist Task template is for use in EC processes only: it cannot be used on a workflow process.
What are workflow handlers?

Handlers are the lowest-level building blocks in workflow. They are small ITK programs used to extend and customize tasks. There are two kinds of handlers:

- Action handlers extend and customize task actions. They perform such actions as displaying information, retrieving the results of previous tasks (inherit), notifying users, setting object protections and launching applications.

- Rule handlers integrate workflow business rules into EPM workflow processes at the task level. They attach conditions to an action. Rule handlers confirm that a defined rule has been satisfied. If the rule is met, the handler returns the \texttt{EPM\_go} command, allowing the task to continue. If the rule is not met, it returns the \texttt{EPM\_nogo} command, preventing the task from continuing.

Many conditions defined by a rule handler are binary (that is, they are either true or false). However, some conditions are neither true nor false. EPM allows two or more rule handlers to be combined using logical AND/OR conditions. When several rule handlers are combined using a logical \texttt{Or} condition, rule handler quorums specify the number of rule handlers that must return go for the action to complete.

For more information and a list of available handlers, see the \textit{Workflow Designer Guide}. 

Explicit and assumed links

A link establishes the sequence by which peer-level tasks are run, indicating that the task on the arrow end of the path cannot start until the task on the start end is completed.

Explicit links  Manually created links, drawn from the predecessor task to the successor task.

Assumed links  Automatically created by the system if no explicit links have been created from the Start node by the time the template is set to the Available stage.

When you put a workflow template in Edit mode and draw a single link from the Start node to another task node, assumed link behavior is disabled. The system does not draw assumed links, even if you leave tasks unlinked and change the workflow template to the Available stage. Any unlinked tasks are skipped when a workflow process based on the workflow template is initiated, and no error messages appear.

**Caution**  When you place workflow templates created before Teamcenter 8.3 and 8.1.1.1 in Edit mode, the system removes all links originating from the Start node. If this occurs, manually redraw any removed links.
Configuring and customizing Workflow

If you are a Teamcenter administrator or customizer, you can change user interactions with Workflow in the following ways:

- You can have Teamcenter filter the workflow templates based on the users’ current group and the types of the attachments when they create new processes or your own criteria.
  
  For more information, see the Business Modeler IDE Guide and the Client Customization Programmer’s Guide.

- You can customize the Perform Signoff dialog box in the following ways:
  o Add boxes and buttons.
  o Validate users’ input into the new boxes.
  o Customize the summary table.
  o Customize the configuration of the Signoff Decision dialog box.

  For more information, see the Client Customization Programmer’s Guide.
Tips for using the Workflow Designer user interface

Refreshing Workflow Designer
You can refresh the display by:
• Moving up or down a level.
• Going to the top level.
• Choosing View→Refresh All.
• Setting the template to the Available stage.

Delete key removes workflow objects and backspace key removes text
While working in Edit mode in Workflow Designer, the system interprets the use of the Delete key on your keyboard as an instruction to delete a workflow object.

Caution Do not use the Delete key to delete characters in text boxes within a workflow template.

To change existing text in a Description or Instructions box:
• Use the Backspace key to remove unwanted text; type new characters into the box

To change text in the Argument and Value(s) boxes in the Handlers dialog box:
• Double-click in the box containing the text you want to modify or delete. Use the Backspace key to remove unwanted text; type new characters into the box.

Note Handler values are case sensitive and must be accurate to the letter.

Save time when creating multiple tasks of the same type
When creating a workflow process template, sometimes the process calls for several of the same types of tasks, such as several Do tasks, that have the same or similar set of handlers and arguments.

Instead of adding the tasks, selecting the handlers, and typing the arguments and values individually, you can do the following:
1. Add the first task to the process template.
**Tips for using the Workflow Designer user interface**

2. Select the handlers you want to add and type the arguments and values for each one.

3. Copy the task and paste it back in the process template.

4. Edit the handler arguments and values in the new copy of the task.

This saves you the time and effort of retyping arguments and values as well as reduces the possibility of typos when creating your process template.

**Move and resize the Handler dialog box**

Undocking the Handler dialog box allows you resize it and move it anywhere in the Teamcenter window.

1. Click the Handler button to open the Handler dialog box.

2. Double-click anywhere in the dialog box to undock it.

<table>
<thead>
<tr>
<th>Behavior</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Docked</td>
<td><img src="image" alt="Docked Handler Dialog Box" /></td>
</tr>
</tbody>
</table>

![Docked Handler Dialog Box](image)
When you leave the **Handler** dialog box docked, you can move between one task’s handlers and another task’s handlers by selecting a different task in the task hierarchy tree. For example:

1. Click the **Handler** button to open the **Handler** dialog box.
   (Do not undock the dialog box.)

2. Select the **Change Admin II (CM)** task in the task hierarchy tree.
   The dialog box is populated with all the handlers on the **Change Admin II (CM)** task.
   Modify handler arguments and values as needed.

3. Select the **Check Change Type** task in the task hierarchy tree.
   The dialog box is populated with all the handlers on the **Check Change Type** task.
   Modify handler arguments and values as needed.
Tips for using the Workflow Designer user interface

Task hierarchy tree  Handler dialog box
Chapter

1 Creating workflow templates

Create workflow process templates in Workflow Designer ......................... 1-1

Insert a task into a template ........................................................................ 1-2

Configuring tasks, attributes, and handlers .................................................. 1-6
  Attributes and handlers .............................................................................. 1-6
  Edit task attributes ................................................................................... 1-6
  What are task handlers? ............................................................................. 1-9
  View task handlers ................................................................................... 1-9
  Create task handlers based on existing handlers ....................................... 1-10
  Create new task handlers ......................................................................... 1-11
  Edit task handlers ................................................................................... 1-12
  Delete task handlers ................................................................................. 1-12

Link tasks manually ...................................................................................... 1-13

Designing subprocesses .............................................................................. 1-13
  What are subprocesses? ............................................................................ 1-13
  Creating subprocesses from a workflow template ....................................... 1-14
    Creating subprocesses for multiple targets ............................................. 1-15
    Creating subprocesses for assemblies ................................................... 1-21
    Creating subprocesses for related objects ............................................. 1-22
  Creating ad hoc subprocesses .................................................................. 1-22
  What are workflow subprocesses? ............................................................. 1-23

Assigning tasks and signoffs ...................................................................... 1-23
  Completing select-signoff-team tasks using My Teamcenter or thin client ................................................ 1-23
    Select a signoff team from predefined profiles ..................................... 1-24
    Select a signoff team based on an ad hoc selection process ............... 1-25
    Complete signoff team selection for an entire workflow .................... 1-26
    Selecting members of the signoff team ................................................. 1-26
  Selecting a signoff team in Workflow Viewer .......................................... 1-27
    Select a signoff team from profiles ..................................................... 1-28
    Select a signoff team ad hoc ............................................................... 1-29
    Select a signoff team from address lists .............................................. 1-30
  Letting others perform your tasks ............................................................. 1-31
    Using the Out of Office Assistant in My Teamcenter or thin client .......... 1-31
    Set your out of office status .................................................................. 1-31
    Allowing surrogate users to perform tasks in My Teamcenter or thin client ................................................ 1-32
    Define a surrogate for another user (requires administrative privileges) ................................................ 1-33
Background processing requirements ................................................. 1-71
Configure Teamcenter Dispatcher for background processing .......... 1-71
Configure Security Services for background processing ..................... 1-73
Configure an SOA URL for background processing ............................. 1-73
Configure notifications for background processing ............................. 1-74
Configure tasks for background processing ........................................ 1-75

Editing templates .................................................................................. 1-75
  Determining which editing options to use ......................................... 1-75
  Editing offline versus online ............................................................... 1-77
  Edit workflow templates ..................................................................... 1-77
  Configure ability to apply template edits to active processes .............. 1-78
  Applying template edits to active workflow processes ....................... 1-80
  Apply template edits to all active workflow processes ...................... 1-80
Chapter 1  

Creating workflow templates

Create workflow process templates in Workflow Designer

The New Root Template dialog box appears.

2. In the New Root Template Name box, type a template name. The box can contain a maximum of 32 characters.

3. Select Process or Task for the template type.

4. From the Based On Root Template list, select an existing template on which to base the new template.
   
The list displays either workflow process templates or task templates.
   When you choose an existing template from the Based On Root Template list, workflow process and task information displays for the selected template in the task hierarchy tree and in the viewer. Selecting a task from the displays any subtasks in the viewer; the task name and description are displayed in their respective boxes. This information regarding the existing template is only for viewing within the New Root Template dialog box; it cannot be modified.
   
   You can also click the Task Attributes, Task Handlers and Task Signoff buttons to view the existing template’s task attribute, task handler, and task signoff information.

5. After you view all the necessary template information, click one of the following:
   
   • OK to create the template and close the dialog box.
   
   • Apply to create the template and retain the dialog box so you can create another template.
   
   • Cancel to cancel the operation.

   In Workflow Designer, the Task Hierarchy list displays the template name. The under construction symbol to the left of the template name indicates that the template is still in the process of being designed.

   [Note]  
   
   Templates with the under construction designation are visible only to system administrators within Workflow Designer. They are not visible to end users who are using the File→New Process option in My Teamcenter to associate a workflow process with objects.

6. Configure your template:
Chapter 1  Creating workflow templates

- Workflow process template
  For more information, see the Workflow Designer Guide and Explicit and assumed links.

- Task template
  For more information, see Attributes and handlers.

7. Close the New Root Template dialog box.

8. Select Set Stage to Available in the lower-left panel.

In Workflow Designer, the Process Template list no longer displays the under construction symbol next to the template name.

In My Teamcenter, the Process Template list, within the New Process dialog box, displays the template name. All users at your site can now access the template.

Insert a task into a template

1. On the Workflow Designer toolbar, click Edit Mode.

2. On the toolbar, click one of the task buttons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Task</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Do Task" /></td>
<td>Do Task</td>
<td>Has two options if at least one failure path is configured: Complete confirms the completion of a task and triggers the branching to a success path. Unable to Complete indicates the task is unable to complete, for various reasons. Uses the EPM-hold handler, which stops the task from automatically completing when started.</td>
</tr>
<tr>
<td><img src="image" alt="Acknowledged" /></td>
<td>Acknowledge Task</td>
<td>Uses the Acknowledged and Not Acknowledged subtasks, each of which has its own dialog box.</td>
</tr>
<tr>
<td><img src="image" alt="Review Task" /></td>
<td>Review Task</td>
<td>Uses the select-signoff-team and perform-signoffs subtasks, each of which has its own dialog box. Wait for Undecided Reviewers is an option that allows the workflow designer user to set the Review task to wait for all reviewers to submit their decisions before completing and following the appropriate path.</td>
</tr>
</tbody>
</table>
### Creating workflow templates

<table>
<thead>
<tr>
<th>Button</th>
<th>Task</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>📩</td>
<td>Route Task</td>
<td>Uses the <strong>Review, Acknowledge</strong>, and <strong>Notify</strong> subtasks, each of which has its own dialog box.</td>
</tr>
<tr>
<td>📠</td>
<td>Task</td>
<td>Use it as a starting point for creating your own custom tasks, such as tasks to carry your custom forms or other site-specific tasks for users to complete. This task template is synonymous with the <strong>EPMTask</strong> template.</td>
</tr>
<tr>
<td>✨</td>
<td>Condition Task</td>
<td>Branches a workflow according to defined query criteria. Requires that the succeeding task contains a <strong>EPM-check-condition</strong> handler that accepts a Boolean value of either <strong>True</strong> or <strong>False</strong>.</td>
</tr>
<tr>
<td>✅</td>
<td>Validate Task</td>
<td>Branches a workflow along two or more paths. Active paths flowing out of the task are determined by whether specified workflow errors occur. Use this task to design workflows around anticipated errors.</td>
</tr>
<tr>
<td>🏆</td>
<td>Add Status Task</td>
<td>Creates and adds a release status to the target objects of the workflow process. It is a visual milestone in a workflow process. No dialog box is associated with this type of task.</td>
</tr>
<tr>
<td>🔄</td>
<td>Or Task</td>
<td>Continues the workflow process when any one of its multiple task predecessors is completed or promoted. There is no limit to the number of predecessors an or task may have.</td>
</tr>
</tbody>
</table>

3. In the process flow pane, double-click where you want to place the new task.

A new task appears with the default name of **New task_typeTask #**, where *task_type* is the kind of task you selected and # is incremented until the task name becomes unique within this workflow process template.

4. (Optional, but recommended) In the **Name** box, type a new name for the task.

5. (Optional) In the **Instructions** box, type the actions users must perform for this task.

If this is a **Condition** task, see the **Workflow Designer Guide** to complete the insertion process.

6. Explicitly link the task to the predecessor tasks.

For more information about linking this task to predecessor and successor tasks, see **Link tasks manually**.
Chapter 1  
*Creating workflow templates*

7. (Optional) Configure task attributes by clicking **Task Attributes** in the template manager pane. Use task attributes to manage task security, duration, display, and quorum behavior.

For more information about using the **Task Attributes** dialog box, see *Edit task attributes*.

8. Configure task handlers by clicking **Task Handlers** in the template manager pane.

Handlers are essential to designing flexible, complex workflows. Use action handlers to perform all types of digital actions, such as running scripts, sending e-mails, creating forms, and assigning responsibility for various workflow tasks. Use rule handlers to implement workflow rules, such as adding status, demoting tasks, displaying forms, and notifying workflow participants.

For more information about using the **Task Handlers** dialog box, see *Edit task handlers*.

9. Follow the additional steps listed based on the task you inserted.

<table>
<thead>
<tr>
<th>Task</th>
<th>Additional steps</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Do Task</strong></td>
<td>None.</td>
</tr>
<tr>
<td><strong>Acknowledge Task</strong> or <strong>Review Task</strong></td>
<td>For more information about completing the insertion process, see step 10.</td>
</tr>
<tr>
<td><strong>Route Task</strong></td>
<td>None.</td>
</tr>
<tr>
<td><strong>Warning</strong> The <strong>Route</strong> task is designed to be used as an electronic routing sheet. The workflow process initiator assigns specific signoff members. Signoff profiles for the <strong>Review</strong> subtask should not be defined within this task. Signoff profiles are unavailable for the <strong>Acknowledge</strong> subtask. The task does not function properly if signoff profiles are defined at this stage.</td>
<td></td>
</tr>
<tr>
<td><strong>Task</strong></td>
<td>None.</td>
</tr>
<tr>
<td><strong>Condition Task</strong></td>
<td>For more information about completing the insertion process, see the <em>Workflow Designer Guide</em>.</td>
</tr>
<tr>
<td><strong>Validate Task</strong></td>
<td>For more information about configuring a <strong>Validate</strong> task, see the <em>Workflow Designer Guide</em>.</td>
</tr>
<tr>
<td><strong>Add Status Task</strong></td>
<td>None.</td>
</tr>
<tr>
<td><strong>Or Task</strong></td>
<td>None.</td>
</tr>
</tbody>
</table>
10. For an **Acknowledgment Task** or **Review Task**:

   a. Define a signoff profile:

      A. Double-click the task in the task hierarchy tree.

      The task expands, listing the `select-signoff-team` and `perform-signoffs` subtasks.

      B. Select the `select-signoff-team` subtask, and then click the **Task Signoff Panel** button in the lower left of the Workflow Designer window.

      The **Signoff Profiles** dialog box appears.

   C. Select a group from the **Group** list then select a role from the **Role** list.

      Define the signoff profiles by group or role, not by individual users. For example, if you want three managers from the Marketing group, all of the managers from the Engineering group, and 51% of the engineers from the Engineering group to sign off on this particular Acknowledgment task, create three group profiles: a **Marketing/manager** profile, an **Engineering/manager** profile, and an **Engineering/engineer** profile.

      You can use the wildcard (*) to leave both the group and role category undesignated.

   D. Select or type the number of reviewers or percentage required for this particular group/role signoff profile.

      In the previous example, the **Marketing/manager** profile requires three reviewers, the **Engineering/manager** profile requires all reviewers, and the **Engineering/engineer** profile requires 51% of reviewers.

   E. Select the **Allow sub-group members** check box to grant members of subgroups permission to sign off instead of members of the designated group.

   F. Click **Create** to add this profile to the **Signoff Profiles** list.

   G. Click **Modify** to change an existing profile in the **Signoff Profiles** list.

   H. Click **Delete** to delete an existing profile in the **Signoff Profiles** list.

   b. Select and type the number or percentage of reviewers required to satisfy a quorum.

      You can designate the number or percentage of reviewers required for the quorum to be between one and the total number of users required for the selected signoff. The default setting is **Numeric** and the value is **All**. Select **Wait for Undecided Reviewers** if you want all of the required users to have a chance to review and comment before the workflow process can be rejected or approved.

   c. After you add all the customer profiles, close the **Signoff Profiles** dialog box by clicking **Close** in the upper right corner of the dialog box.
Configuring tasks, attributes, and handlers

Attributes and handlers

You can modify the behavior of a task within a workflow process template by using:

- **Attributes**
  Allows you to set requirements and/or restrictions on a task. Possible task attributes are:
  
  o Named ACL
  o Template name
  o Signoff quorum
  o Release status
  o Icons

  For more information, see *Edit task attributes*.

- **Handlers:**
  Small ITK programs or functions. Handlers are the lowest-level building blocks in EPM. You use handlers to extend and customize tasks. The following is a list of the types of functions you can add to a task:
  
  o Set protections
  o Assign reviewers
  o Demote a task
  o Perform a signoff
  o Change a status

  There are two kinds of handlers:
  
  o **Action handlers:**
    Extend and customize task actions. Action handlers perform such actions as displaying information, retrieving the results of previous tasks (inherit), notifying users, setting object protections and launching applications.

  o **Rule handlers:**
    Integrate workflow business rules into EPM workflow processes at the task level. Rule handlers attach conditions to an action.

    Many conditions defined by a rule handler are binary (that is, they are either true or false). However, some conditions are neither true nor false. EPM allows two or more rule handlers to be combined using logical **AND/OR** conditions. When several rule handlers are combined using a logical **OR** condition, rule handler quorums specify the number of rule handlers that must return go for the action to complete.

    For more information, see *What are task handlers?*.

**Edit task attributes**

You can customize a task by editing its attributes.

1. On the Workflow Designer toolbar, click **Edit Mode**.
2. Click **Task Properties** in the toolbar.
   The system displays the **Task Properties** dialog box.
   The **Name** box lists the name of the selected workflow process template or task template.

3. (Optional) Type task instructions into the **Instructions** box.

4. Click the **Attributes Panel** tab.
   The system displays the **Attributes Panel** dialog box.

5. Click **Named ACL** to add permissions for the task and target objects.
   a. Use one of the following methods to select an ACL to apply to the task.
      - In the **ACL Name** box, select an existing ACL.
         o Click the system **Named ACL** button to list ACL names created in Access Manager.
         o Click the workflow **Named ACL** button to list ACL names created in Workflow Designer.
      - In the **ACL Name** box, type a new ACL name and click **Create**.
        The new ACL is added to the list of workflow named ACLs.
        A. Add access control entries (ACEs) to define the permissions for the named ACL.
        B. Click **Save** to save the ACEs for the named ACL.

           For information about creating a named ACL, see the *Access Manager Guide*.

           For information about workflow accessors and privileges, see the *Security Administration Guide*.

   b. Click **Assign to ACL Name** to update the **Assigned ACL Name** box.
      This action creates the **EPM-set-rule-based-protection** handler on the **Start** action for the task.

   c. (Optional) To verify the assignment, view the **Task Handler** panel.

6. If the selected task is a Condition task, you can:
   - Select a graphic from the **Icons** list.
   - Click **Condition Query** to define a query.
      The system displays the **Condition Query** dialog box.
   - Define a query for the Condition task. For information about defining queries, see *Query Builder Guide*.
      The **Duration** box displays the length of time allowed for the completion of the project. You can define the duration length in the template of the
selected task. You can also define duration length in the Attributes dialog box when the selected task is in a Pending state.

**Note** The Task Manager daemon must be installed to see color-coding relating to task completion.

For more information, see the *System Administration Guide*.

7. To set the **Duration** box:
   - Type an integer value for any or all of the following boxes to indicate the length of time that can pass before the selected tasks needs to reach completion:
     - Years
     - Weeks
     - Days
     - Hours
     - Minutes
   - Click one of the following, as needed:
     - **OK**
       Saves the changes to the database and closes the dialog box.
     - **Clear**
       Clears all boxes.
     - **Cancel**
       Closes the dialog box without making any changes.

The **Recipients** list displays the names of users selected to receive program mail when the selected task becomes overdue. You can set the **Recipients** list from this dialog box.

8. To set the **Recipients** list:
   - Click **Set** to the right of the **Recipient** box.
     The system displays the Select Recipients dialog box.
   - Type the user, group, or address list search criteria for users you want to select.
   - Based on the search criteria you entered, click either **User**, **Group**, or **Address List**.
     The search results display in the box below. To display all users in the selected grouping, type * and click the appropriate button. All users in the selected grouping display in the box.
   - Select the users you want to define as recipients from the search results. You can choose multiple users by pressing Ctrl and clicking the desired names.
   - Click **Users**.
The selected users display in the box in the right side of the dialog box. These are the selected recipients.

- To delete a recipient, click **Delete**.
- Close the Named ACL dialog box.

**Note**  
When a named ACL is applied to a task and the Named ACL dialog box is closed, the **Show Task in Process Stage List** property on the Tasks Attributes Panel is automatically selected.

- The **Show Task in Process Stage List** displays the task in the Process Stage List property for the target object.
- Tasks in the **Process Stage List** are used to determine the ACL for the target objects.

9. Select **Show Task in Process Stage List** to display the task in the Process Stage List property for the target object.

- Select the **Show Task in Process Stage List** property when a named ACL is defined for a task.

- Clear **Show Task in Process Stage List** when there are no named ACL and **EPM-set-rule-based-protection** handler defined for this task, and the task does not need to appear in the target object Process Stage List. For example, clear this box for subtasks or parent tasks.

**Note**  
The Process Stage List also determines the task's attributes, such as responsible party or signoff approvers, factored into the currently active named ACL.

10. Select **Process in Background** to run the task in the background so the user can continue to work with Teamcenter while the task is executing.

Clear **Process in Background** to run the task in the foreground. The user must wait for it to complete.

11. Click **Close** to save the changes to the database and close the dialog box.

**What are task handlers?**

You can customize task behavior by creating and modifying task handlers. A task handler is a small ITK program or function. Handlers are the lowest level building blocks in EPM and are used to extend and customize tasks.

**View task handlers**

You can display the task handlers of a selected task from Workflow Designer or from Workflow Viewer while in design mode by performing the following steps:

1. Click **Browse Mode**.
Chapter 1 Creating workflow templates

2. Select the task whose handlers you want to view. To view handler information for the root task of the workflow process (the initial Start task) select the workflow process.

3. Click the Task Handlers pane.

The system displays the Task Handlers dialog box. In the left pane, the handler tree lists the handlers assigned to the selected task.

To more easily view the contents of the handler tree, you can click Expand All Folders or Collapse All Folders.

Create task handlers based on existing handlers

You can create new task handlers based on an existing handler. Use this procedure when one or more attributes of the new handler are contained in an existing handler. To create a handler, perform the following steps from the Task Handlers dialog box in either Workflow Designer or when in design mode in Workflow Viewer:

1. On the toolbar, click Edit Mode.

2. Select the handler from the handler tree that you want to use as a template for the new handler.

   The Handler Type, Quorum, Task Action, and Action/Rule Handler boxes display the current settings for the selected handler.

3. Edit the data in the boxes as required for the new handler.

   If the selected task involves selecting signoff teams or performing signoffs, select and enter type the number or percentage required for the approval quorum in the Quorum box.

4. Edit existing arguments in the Argument table by selecting the value cell to the right of the argument cell and deleting the existing values. Add new value information by double-clicking in the cell to initiate the text-field editor, and then entering the required values.

   Separate multiple values by a comma.

5. Add a new argument row by clicking the Argument table. Type the new argument name into the argument cell by double-clicking in the cell to initiate the text-field editor, then entering the required argument name. Type the corresponding values into the value cell to the right of the argument cell by double-clicking in the cell to initiate the text-field editor, then entering the required values.

   Separate multiple values by a comma. You can display documentation for the selected handler by clicking Help.

6. Change the argument order by selecting an argument row and clicking Up or Down (located to the right of the table) to move the argument row up or down, respectively.
7. Change the handler order by selecting a handler in the handler tree and clicking **Up 🔸** or **Down 🔽** (located below the tree) to move the argument row up or down, respectively.

8. Click **Create** to create a new handler based on the data now displayed in the dialog box.

The system creates the new handler and displays it in the handler tree.

**Create new task handlers**

You can create new task handlers with no preexisting data. Use this procedure when no existing handlers contain the necessary attributes. To create a new handler, perform the following steps from the **Task Handlers** dialog box in either Workflow Designer or when in design mode in Workflow Viewer:

1. Decide the type of handler you want to create:
   - **Rule handler**
     - Click **Rule Handler**.
   - **Action handler**
     - Click **Action Handler**.

2. If the selected task involves selecting signoff teams or performing signoffs, select and type the number or percentage required for the approval quorum in the **Quorum** box.

3. Select a handler from the **Action Handler** or **Rule Handler** list.

4. Add a new argument row by clicking **Add** next to the **Argument** table. Type the new argument name into the argument cell by double-clicking in the cell to initiate the text-field editor, then typing in the required argument name. Type the corresponding values into the cell to the right of the argument cell by double-clicking in the cell to initiate the text-field editor, then entering the required values.

Separate multiple values by a comma. You can display documentation for the selected handler by clicking **Help**.

5. Change the argument order by selecting an argument row and clicking **Up 🔸** or **Down 🔽** (located to the right of the table) to move the argument row up or down, respectively.

6. Change the handler order by selecting a handler in the handler tree and clicking **Up 🔸** or **Down 🔽** (located below the tree) to move the argument row up or down, respectively.

7. Click **Create** to create a new handler based on the data currently displayed in the handler's display area.

The system creates the new handler and displays it in the handler tree.
Edit task handlers

To modify task handlers, you must edit the argument table. To edit a handler, perform the following steps from the Task Handlers dialog box in either Workflow Designer or when in design mode in Workflow Viewer:

1. Select the handler you want to edit from the handler tree.
   The Handler Type, Quorum, Task Action and Action/Rule Handler boxes display the current settings for the selected handler.

2. If the selected task involves selecting signoff teams or performing signoffs, select and type the number or percentage required for the approval quorum in the Quorum box.

3. Edit existing arguments in the Argument table by deleting the existing values from the value cell to the right of the argument cell, and then double-clicking in the cell to initiate the text-field editor and entering the required values.
   Separate multiple values by a comma. You can display documentation for the selected handler by clicking Help.

4. Change the argument order by selecting an argument row and clicking Up ▲ or Down ▼ (located to the right of the table) to move the argument row up or down, respectively.

5. Change the handler order by selecting a handler in the handler tree and clicking Up ▲ or Down ▼ (located below the tree) to move the argument row up or down, respectively.

6. Add a new argument to the Argument table.
   a. Type the new argument name in the argument cell by double-clicking in the cell to initiate the text-field editor, then entering the required argument name.
   b. Type the corresponding values in the value cell to the right of the argument cell by double-clicking in the cell to initiate the text-field editor, and then entering the required values.
   Separate multiple values by a comma.

7. Click Modify to update the selected handler to reflect the data currently displayed in the handler’s display area.
   The system modifies the selected handler.

Delete task handlers

When a handler is no longer required, you can delete it as explained in this section. To delete a handler, perform the following steps from the Task Handlers dialog box in either Workflow Designer or when in design mode in Workflow Viewer:

- Select the desired handler from the handler tree and click Delete.
   The system deletes the selected handler and no longer displays it in the tree.
Link tasks manually

Drawing a path between two tasks establishes the sequence in the execution of the tasks by declaring that the task on the arrow end of the link cannot start until the task on the start end of the link has been completed.

Manually drawing either success or failure paths between tasks creates explicit links between your tasks. Always explicitly link your tasks to ensure predictable results. Draw your success or failure path immediately after inserting tasks into the workflow process, before saving the workflow process or switching away from the Workflow Designer application. Saving the workflow process or switching applications before manually drawing paths prompts Teamcenter to automatically insert implicit links.

1. On the Workflow Designer toolbar, click Edit Mode.
2. Click the task node you want to be the predecessor task.
   Do not click the title bar of the task node: doing so begins a drag process.
3. Drag your cursor to the task node you want to be the successor task.
   A link arrow follows the cursor as you drag. When your cursor moves over a task node, the node is highlighted.
4. Release the mouse button.
   A link arrow connects the predecessor and successor nodes.

Designing subprocesses

What are subprocesses?

Subprocesses are workflow processes associated with a parent workflow process.

If there is an association between the parent process and subprocess, but not a dependency, the parent process may complete before the subprocess completes.

If the parent process is dependent on the subprocess, the parent process cannot complete until the subprocess completes. For example, if the EPM-create-sub-process action handler is used to create subprocesses for multiple targets from a parent process, the parent processes are dependent on the subprocesses.

If a subprocess is created from an in-process task, the task cannot complete until the subprocess completes. End users can create subprocesses in this manner.

Subprocesses are created in two locations:

Parent workflow templates

Administrators can configure workflow templates to create subprocesses. For example, a parent workflow template can be configured to automatically launch subprocesses for each target of the parent workflow.

For more information about creating subprocesses from a parent workflow template, see Creating subprocesses from a workflow template.
Chapter 1  

Creating workflow templates

My Worklist

End users can create ad hoc workflow subprocesses while performing tasks from their worklist or from Workflow Viewer.

For more information about creating ad hoc subprocesses, see Creating ad hoc subprocesses.

Creating subprocesses from a workflow template

Sometimes you want a workflow process to generate additional workflows as it proceeds. For example, you may want a workflow to generate additional workflows (subprocesses) for each target of the parent process.

Use the EPM-create-sub-process action handler to create subprocesses. You can add the handler multiple times to a single task action, allowing you to use different workflow process templates per target object type. Use the handler to:

- Set dependencies between the parent process and its subprocesses.
- Define targets and attachments for the subprocesses.
- Transfer attachments from the parent process to a subprocess.
- Create subprocesses for multiple targets.
- Create subprocesses for assemblies.
- Create subprocesses for related objects.

The handler accepts numerous arguments, allowing you to create a wide variety of instances for generating subprocesses. For example:

- The following argument settings create a subprocess based on the Clinical Trials Phase I template, which inherits all the targets and reference attachments from the parent process. Because the workflow process name is not defined, a workflow process name for the child process is automatically generated in the format parentprocess:count.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>-template</td>
<td>Clinical Trials Phase I</td>
</tr>
<tr>
<td>-from_attach</td>
<td>ALL</td>
</tr>
<tr>
<td>-to_attach</td>
<td>ALL</td>
</tr>
</tbody>
</table>

- The following argument settings launch a subprocess based on the Clinical Trials Phase I workflow process template. All item revisions from the parent process are excluded as targets for the new workflow process.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>-template</td>
<td>Clinical Trials Phase I</td>
</tr>
<tr>
<td>-from_attach</td>
<td>ALL</td>
</tr>
<tr>
<td>-to_attach</td>
<td>TARGET</td>
</tr>
<tr>
<td>-exclude_type</td>
<td>ItemRevision</td>
</tr>
</tbody>
</table>
The following argument settings launch multiple subprocesses based on the **Clinical Trials Phase I** workflow process template. Each item revision that was a target or reference attachment of the parent process launches a new subprocess with that item revision as the target.

For example, if the parent process contained three item revisions as targets, three different subprocesses are launched.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>-template</td>
<td>Clinical Trials Phase I</td>
</tr>
<tr>
<td>-from_attach</td>
<td>ALL</td>
</tr>
<tr>
<td>-to_attach</td>
<td>TARGET</td>
</tr>
<tr>
<td>-include_type</td>
<td>ItemRevision</td>
</tr>
<tr>
<td>-multiple_processes</td>
<td></td>
</tr>
</tbody>
</table>

For more information about using this handler to create subprocesses, see **EPM-create-sub-process**.

**Creating subprocesses for multiple targets**

You can use various configurations of the **EPM-create-sub-process** action handler to create subprocesses for multiple targets from a parent process.

The most straightforward method to create subprocesses for multiple targets is to use the **-multiple_processes** argument to create individual subprocesses for each target in the parent process. The newly created subprocesses can either be a clone of the parent process or a different workflow process.

You can refine this method by using the **-include_type** argument along with the **-multiple_processes** argument to create individual subprocesses for each target of a specific type in the parent process. Or you can use the **-exclude_type** argument along with the **-multiple_processes** argument to create individual subprocesses for each target except the specified types in the parent process.

All these methods are based on the concept of the parent process always creating one or more subprocesses.

Depending on your business process needs, a more elegant method is to create a workflow process branched with a **Condition** task that is configured to query for multiple targets. The technique of querying for multiple targets means a subprocess is only created when there are multiple targets. When there is a single target, the other branch of the parent process is followed. This is an efficient design if subprocesses are only needed when multiple targets are involved.

Consider the following workflow template, in which a generic task template is named **Multiple Targets** and configured to create subprocesses for each target.
In this example, Pharmaceuticals, Inc., uses such a workflow for its drug trial reviews. The typical trial contains multiple products, but occasionally a trial contains only one product.

If this workflow process is initiated on an item revision containing three targets, the **Condition** task query returns **True** and follows the **True** path containing the **Multiple Targets** task, which creates three subprocesses: one subprocess for each target in the parent process. Each subprocess is a clone of the parent process.

Because each of the subprocesses always only contains a single target, as each subprocess is initiated the **Condition** task query returns **False** and follows the **False** path containing the **Launch Trial** and **Review Results** tasks.

In trials that review only a single product, the parent process follows the **False** path. No unnecessary subprocess is created.

The following procedure illustrates how to configure the workflow in this example:

**Note** Before you begin, confirm that the **EPM_multiple_processes_targets** preference is set to **ON** by choosing **Edit→Options** to launch the **Options** dialog box and locating the preference using the **Filters** link.

If the preference is not created at your site, create the preference and set it to **ON**.

For more information about creating preferences, see the *Rich Client Interface Guide*.

1. In Workflow Designer, choose **File→New Root Template** to create a new workflow process template.

2. Type a name for the new workflow process in the **New Root Template Name** box, select **Empty Template** from the **Based On Root Template** list, and click **OK**.

   The workflow process template appears in the process flow pane.

3. On the toolbar, ensure you are in **Edit** mode.

   This allows you to edit the workflow process template.

4. Insert a **Condition** task into the workflow process by clicking the **Condition Task** button on the toolbar, and then double-clicking in the process flow pane to the right of the **Start** node.
The new **Condition** task is inserted at the cursor point.

5. Rename the **Condition** task by selecting the task in the task hierarchy tree, and then typing **Has Multiple Targets?** in the **Name** box in the template manager pane, and pressing the Enter key.

6. Create a query for the **Has Multiple Targets?** task to determine whether the workflow process contains multiple targets by completing the following steps:

a. In Teamcenter, switch to the Query Builder application.

b. In Query Builder, create a new query called **WF - Has Multiple Targets** by completing the query boxes as shown and clicking **Create**.

c. Return to Workflow Designer.

7. Associate the **WF - Has Multiple Targets** query with the **Has Multiple Targets?** task.

a. Select the **Has Multiple Targets?** task and click **Task Attributes** in the template manager pane.
Getting Started

Chapter 1  Creating workflow templates

b. In the Task Attributes dialog box, click the Condition Query box. (The box currently indicates it is empty because no queries are associated with the Condition task.)

The Condition Query dialog box appears.

c. In the Condition Query dialog box, scroll down the Build/Select Query list to the WF - Has Multiple Targets query and double-click the query.

The query name appears in the New Query box at the bottom of the dialog box.

d. Select Task as the Query Against option.

e. Click OK to choose the query and exit the dialog box.

The Task Attributes dialog box reappears. WF - Has Multiple Targets displays in the Condition Query box.

f. Close the Task Attributes dialog box.

The Has Multiple Targets? task is now configured to query whether the workflow process contains multiple targets. When the workflow process contains multiple targets the True path is followed; when the workflow process contains a single target, the False path is followed.

8. Configure the Has Multiple Targets? task to retrieve the number of targets from the Multiple Targets task by completing the following steps:

a. In the process flow pane, select the Has Multiple Targets? task and click Task Handlers in the template manager pane.

b. In the task action in the left-side of the dialog box, select the Start action.

c. In the right-side of the dialog box, select Action Handler for the handler type.

d. In the Action Handler list, select EPM-set-task-result-to-property.

e. Type -property in the Argument box and num_targets in the Value(s) box.

f. Click Add in the right side of the dialog box to add another argument/value line.

g. Type -source in the Argument box and task in the Value(s) box.

h. Click Create at the bottom of the dialog box to add the handler to the Start action of the Has Multiple Targets? task.

9. When you created the WF - Has Multiple Targets query on the Has Multiple Targets? task, the EPM-set-condition handler was automatically placed on the task’s Start action.

Confirm the handler contains the following settings:

a. The -query in the Argument box and WF - Has Multiple Targets in the Value(s) box.
b. The -query_type in the Argument box and Task in the Value(s) box.

10. Select the EPM-set-task-result-to-property handler in the folder list and click the Up button under the folder list to move it above the EPM-set-condition handler in the Start action.

**Note** The order of the two handlers on the Start action is important. EPM-set-task-result-to-property must be before EPM-set-condition.

11. Close the Handlers dialog box.

12. Draw a flow path from the Start task to the Has Multiple Targets? task by placing the cursor in the body of the Start task and dragging it to the body of the Has Multiple Targets? task.

13. Insert a Do task above and to the right of the Condition task.

14. Rename the Do task to Launch Trial.

15. Configure the Launch Trial task to attach the dataset and BOM view revision by completing the following steps:
   a. In the process flow pane, select the Launch Trial task and click Task Handlers in the template manager pane.
   b. In the task action tree in the left side of the dialog box, select the Start action.
   c. In the right side of the dialog box, select Action Handler for the handler type.
   d. In the Action Handler list, select EPM-attach-related-objects.
   e. Type -relation in the Argument box and IMAN_specification in the Value(s) box.
   f. Click Add in the right side of the dialog box to add another argument/value line.
   g. Type -attachment in the Argument box and target in the Value(s) box.
   h. Click Create in the bottom of the dialog box to add the handler.
   i. Select the EPM-attach-related-objects handler you just created from the folder list on the left.
   j. Replace IMAN_specification with PSBOMViewRevision as the value for the -relation argument and click Create.

You should have two EPM-attach-related-objects handlers in the Start action, one with the IMAN_specification relation and one with the PSBOMViewRevision relation.

k. Close the Handlers dialog box.
16. Insert a Review task to the right of the Launch Trial task.

17. Rename the Review task to Review Results.

18. Draw a flow path from the Launch Trial task to the Review Results task by placing the cursor in the body of the Launch Trial task and dragging it to the body of the Review Results task.

19. Draw a flow path from the Has Multiple Targets? task to the Launch Trial task.
   By default, the path is a True path.

20. Change the flow path to a False path by right-clicking the line you have just drawn and choosing Set Path To False Path.
    The flow path changes to a False path.

21. Insert a generic task below and to the right of the Has Multiple Targets? task.

22. Rename the task to Multiple Targets.

23. Draw a flow path from the Has Multiple Targets? task to the Multiple Targets task.
    By default, the path is a True path.

24. Reconcile the True and False paths by inserting an Or task and linking it to the Review Results and Multiple Targets tasks and then to the Finish task.
   a. Click the Or task button on the toolbar, and then double-click in the process flow pane to the right of the Review Results and Multiple Targets tasks.
      The new Or task is inserted at the cursor point.
   b. Draw a flow path from the Review Results task to the Or task.
   c. Draw a flow path from the Multiple Targets task to the Or task.
   d. Draw a flow path from the Or task to the Finish node.

25. Configure the Multiple Targets task to generate subprocesses by completing the following steps:
   a. In the process flow pane, select the Multiple Targets task and click Task Handlers in the template manager pane.
   b. In the task action tree in the left side of the dialog box, select the Complete action.
   c. In the right side of the dialog box, select Action Handler for the handler type.
   d. In the Action Handler list, select EPM-create-sub-process.
   e. Type -from_attach in the Argument box and Target in the Value(s) box.
Creating workflow templates

f. Click Add in the right side of the dialog box to add another argument/value line.

g. Type -to_attach in the Argument box and Target in the Value(s) box.

h. Click Add in the right side of the dialog box to add another argument/value line.

i. Type -process_name in the Argument box and SubProcess in the Value(s) box.

j. Click Add in the right side of the dialog box to add another argument/value line.

k. Type -multiple_processes in the Argument box. Do not type a value in the Value(s) box.

l. Type -template in the Argument box and the name for this template that you used in step 2 in the Value(s) box.

m. Click Create in the bottom of the dialog box to add the handler to the Complete action of the Multiple Targets task.

   The system responds with a warning that says The use of EPM-create-sub-process handler has resulted in a loop. Teamcenter detected that the -template argument referenced the template that you are creating. However, since the subprocesses generated will follow the False path, no loop occurs. Click OK.

n. Close the Handlers dialog box.

26. Select the Set Stage to Available check box to put your template online.

The template is now ready to use.

Creating subprocesses for assemblies

In workflow processes that contain assemblies, there are various arguments you can use with the EPM-create-sub-process action handler to create subprocesses for components of the assemblies.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>-process_assembly</td>
<td>Searches for assemblies in the target, reference, or all (as specified by the -from_attach argument) and creates subprocesses for each component.</td>
</tr>
<tr>
<td>-depth</td>
<td>Specifies the depth to which the assembly is traversed.</td>
</tr>
<tr>
<td>-rev_rule</td>
<td>Specifies the revision rule applied to the assembly.</td>
</tr>
</tbody>
</table>
Creating workflow templates

<table>
<thead>
<tr>
<th>Argument</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>-include_related_type</td>
<td>Creates subprocesses only for assembly components of the types specified in this argument.</td>
</tr>
<tr>
<td>-exclude_related_type</td>
<td>Does not creates subprocesses for assembly components of the types specified in this argument.</td>
</tr>
</tbody>
</table>

**Note**: The -include_related_type and -exclude_related_type arguments can be used in conjunction with each other. If used in conjunction, the -include_related_type argument takes precedence; first the objects are processed against -include_related_type and then processed against -exclude_related_type.

Creating subprocesses for related objects

There are various arguments you can use with the EPM-create-sub-process action handler to create subprocesses for related objects of target and reference data.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>-relation</td>
<td>Creates subprocesses for each object attached by the specified relation to the target or reference object. (Specify a particular target, or reference object, or all, using the -from_attach argument.)</td>
</tr>
<tr>
<td>-include_related_type</td>
<td>Creates subprocesses only for related objects of the type(s) specified in this argument.</td>
</tr>
<tr>
<td>-exclude_related_type</td>
<td>Does not creates subprocesses for related objects of the type(s) specified in this argument.</td>
</tr>
</tbody>
</table>

**Note**: The -include_related_type and -exclude_related_type arguments can be used in conjunction with each other. If used in conjunction, the -include_related_type argument takes precedence; first the objects are processed against -include_related_type, and then -exclude_related_type.

Creating ad hoc subprocesses

End users can create ad hoc workflow subprocesses while performing tasks from their worklist or from Workflow Viewer.

For example, users might want to create a workflow subprocess after receiving a task in their worklist dependent upon the completion of one or more tasks not tracked by the existing workflow. They create a workflow subprocess to track the additional tasks.

For more information about how users create ad hoc subprocesses, see the Workflow Viewer Guide.
What are workflow subprocesses?

Subprocesses are child workflow processes of a parent workflow process. You can create subprocesses while performing tasks from your worklist. When created in this manner, parent workflow processes are dependent on subprocesses; they cannot complete until the subprocess completes.

A typical scenario is one in which you receive a task in your worklist that is dependent upon the completion of an additional workflow process. You decide to create a workflow subprocess to track the work which must be completed before you can complete the task in the parent workflow.

Generally, any user can create a workflow subprocess from a task within their worklist. This functionality is not limited to privileged users.

When you create a workflow subprocess from an in-process task in your worklist, you create a dependency between the selected task in the parent process and the newly created subprocess. The targets of the active parent workflow process are carried over if you check the Inherit Targets box.

Assigning tasks and signoffs

Completing select-signoff-team tasks using My Teamcenter or thin client

The Review, Acknowledge, and Route tasks each contain a select-signoff-team subtask.

When you initiate a process on a Teamcenter object and that process contains one of these parent tasks, you are usually responsible for selecting the signoff team. Each member of the signoff team you select is responsible for reviewing the target object and signing off on it.

Note
The Route task contains a Review task, an Acknowledge task, and a Notify task. The Route task contains both signoff team subtasks.

The Route task also lets you specify the action for each user: Review, Acknow (for acknowledge), or Notify.

You can select a signoff team either by completing predefined profiles or by ad hoc selection.

Signoff Team

Profiles ➔ Predefined profiles
- Engineering/Designer/1
- */Standards Engineer/2

Users ➔ Ad hoc selection

Address Lists

The requirements of the selected workflow template determine the method used to select a signoff team.

- Predefined profiles
Chapter 1  Creating workflow templates

An administrator defines profiles and associates them with workflow processes. When you initiate a workflow process that contains predefined signoff profiles, you must select the specified number of users for each specified group and role. For example, a typical workflow can include predefined signoff profiles that require one user who is a member of the Engineering group and whose role is Designer, and two users who are members of any group and whose role is Standards Engineer.

- Ad hoc selection

Ad hoc selection allows the initializing user, address list members, and resource pool members to add users to the signoff team individually. When the task template contains predefined signoff profiles, the ad hoc selections make one-time-only additions to the required signoff team. When the task template does not contain predefined signoff profiles, the ad hoc additions are the entire signoff team.

Select a signoff team from predefined profiles

1. Select the select-signoff-team task in your Tasks to Perform folder.

2. (Optional.) If you know you have additional tasks to perform before you can perform the current task, you can create a subprocess from this task. The subprocess must complete before the current task can complete.

   For more information about creating a subprocess, see Creating subprocesses from a workflow template.

3. Click the Viewer tab, and then click the Task View option at the top of it.
   - Predefined profiles are listed in the Profiles folder.
   - The group, role, and user name of the assigned members is displayed for group/role/#, where # indicates the number of users required on the signoff team for that particular group and role.
   - You can replace group and role with an asterisk (*) to represent all groups and roles.

4. Select each profile in turn.

   User names that meet the predefined group/role criteria are displayed in the Organization tab to the right.

5. For each profile, select the specified number of users.

   For example, if a signoff profile is Design Office/Architect/3, select three users who are members of the Design Office group and who have the role of Architect.

6. Click Add to assign each user to the signoff team.

7. Repeat the previous steps to assign the required number of users to the selected signoff team.
Quorum requirements are displayed in the Review Quorum pane. You must select the specified numbers of users for each predefined profile before you can complete this task.

8. (Optional) Add other users to the signoff team.
   a. Click the Users folder directly below the Profiles folder.
      This displays all users in the Organization tab to the right.
   b. Select the additional users you want to add to the signoff team.

9. (Optional) Add comments in the Comments field.

10. Select the Ad-hoc done check box to indicate you have completed your signoff team member selections.

11. Click Apply.

The task is complete and the Viewer tab now displays No View Data Available.

Select a signoff team based on an ad hoc selection process

1. Select the select-signoff-team task in your Tasks to Perform folder.

2. (Optional.) If you know you have additional tasks to perform before you can perform the current task, you can create a subprocess from this task. The subprocess must complete before the current task can complete.

   For more information about creating a subprocess, see Creating subprocesses from a workflow template.

3. Assign specific users to the signoff process:
   a. Click the Viewer tab, and then click the Task View option at the top of it.
      The system displays the Signoff Team tree in the left pane of the window.
   b. Click Users in the Signoff Team tree.
      The right pane displays the Organization tab.
   c. In the Organization tab, select a group, role and user.
   d. Select a user; then click Add to assign the user to the signoff team.
   e. Repeat the previous steps to assign additional users to the signoff team.

4. Assign users from an address list to the signoff team, as follows:
   a. Click Address Lists.
   b. Select an address list.
   c. Click Add.
      • The address list appears in the Signoff Team tree.
The group, role, and user values for each member are listed below the selected address list.

d. Repeat the previous steps to add additional address lists.

5. (Optional) Add comments in the Comments field.

6. Select the Ad-hoc done check box □ to indicate you have finished adding signoff team members.

7. Click Apply.

The task is complete and the Viewer tab now displays No View Data Available.

**Complete signoff team selection for an entire workflow**

Rather than select signoff teams as the select-signoff-team task appears in your worklist, you can select signoff team members for all the different signoff teams required within an entire workflow using process assignment lists.

For information about using process assignment lists, see Assigning all tasks in a process using process assignment lists.

**Selecting members of the signoff team**

When you create a process, you can assign other users responsibility for performing a particular task within the process.

- While performing a task, the responsible party can reassign responsibility for the task to another user.

- When a task is reassigned to a user other than the process owner, the process owner and the responsible party are different users.

The user who initiates the workflow process must select a signoff team. As the process progresses, a select-signoff-team task appears in the Tasks to Perform folder of the process initiator’s Inbox each time a task requiring a signoff team reaches a Started state.

Tasks that require signoff teams include:

- **Review** tasks
- **Acknowledge** tasks
- **Route** tasks

When you are assigned a select-signoff-team task, you select users as signoff team members who are assigned the responsibility of signing off a target object, such as a document.

- You can assign signoff responsibility to an entire address list or resource pool of users, as well as individual users.

- You can assign signoff responsibility by completing predefined profiles or by ad hoc selection.
• You can select a signoff team in the Task Hierarchy tree and the Task Flow pane.

A green light in the upper left hand corner of the task node indicates that a signoff team has been assigned.

Selecting a signoff team in Workflow Viewer

To perform a select-signoff-team task, the responsible party selects users to be members of the signoff team. Each member of the signoff team is responsible for reviewing and signing off on the attached target objects. They do this using the perform-signoffs task, which is sent to their worklist as soon as the signoff team is selected.

There are three methods of selecting a signoff team.

Selection method | Description
--- | ---
Profiles | Select the specified number of users to be members of the signoff team or use a resource pool. Each user must meet the group and role requirements of the profile.

In this example, you must select one user from the Change Specialist group, of any role. (The * is a wildcard.) You must select three users from the Engineering group with the role of Designer. (Profile requirements can be met using resource pools, as well as individual members.)

The OK button in the Select Signoff Team dialog box remains unavailable until you fulfill all profile requirements.

Users | Select any number of users, from any group and role, to be members of the signoff team. This is an ad hoc selection method. You can also select resource pools.

If the Ad-hoc done check box is enabled at the bottom of the Select Signoff Team dialog box, you can use this selection method, regardless of whether you also use the profiles and address list methods.

Address lists | Select all the members of one or more address lists to be members of the signoff team. You can also select resource pools.

If the Ad-hoc done check box is enabled at the bottom of the Select Signoff Team dialog box, you can use this selection method, regardless of whether you also use the profiles and ad hoc methods.
Select a signoff team from profiles

1. Select a **select-signoff-team** task that has reached **Started** status, either in the task hierarchy tree or the process flow pane.

2. Review any task instructions written in the **Instructions** box, at the bottom of the template manager pane.

3. (Optional) If you know you have additional tasks to perform before you can perform the **select-signoff-team** task, you can create a subprocess from this task. The subprocess must complete before the **select-signoff-team** task can complete.

   For more information about creating a subprocess, see *Creating subprocesses from a workflow template*.

4. Click **Perform Task** on the toolbar or the button in the middle of the task in the process flow pane.

   The **Select Signoff Team** dialog box appears.

5. Expand the **Profiles** folder in the **Signoff Team** tree.

6. Select a profile. The **Organization** tab displays to the right, filtered to the group and role required by the selected profile.

7. Search or select a user from the **Organization** tree. You can assign a resource pool to the task in **Resource Pool Options**.

   For more information about using and defining resource pools, see the *My Teamcenter Guide*.

8. Click **Add** to add the selected user to the signoff team.

   The user name is added under the selected profile.

9. Repeat these steps to assign additional users to the signoff process. You must select the specified number of users, of the specified group and role, for each profile.

   For example, if the profile states: **Engineering/Designer/3**, you must select three users from the Engineering group, with the role of Designer.

   All profiles must be satisfied before the **select-signoff-team** task can complete.

10. (Optional) Type a description of the workflow process in the **Process Description** box.

11. (Optional) From the **Review Quorum** box, select the amount of users who must approve in order for the task to complete. The initial setting is inherited from the process template. If you want to change that setting, select a quorum using one of the following methods:

    - Select the **Numeric** option and type a number in the box.

    - Select the **Percent** option and type a percentage in the box.

12. (Optional) Type any comments regarding the task in the **Comments** box.
13. If you want the workflow process to wait for all reviewers before continuing, select the *Wait for Undecided Reviewers* check box.

14. Click **Ad-hoc done** to indicate you have completed adding signoff team members.

15. Click **OK** to complete the task and close the dialog box.

**Select a signoff team ad hoc**

1. Select a **select-signoff-team** task that has reached **Started** status, either in the task hierarchy tree or the process flow pane.

2. Review any task instructions written in the **Instructions** box, at the bottom of the template manager pane.

3. (Optional) If you know you have additional tasks to perform before you can perform the **select-signoff-team** task, you can create a subprocess from this task. The subprocess must complete before the **select-signoff-team** task can complete.

   For more information about creating a subprocess, see *Creating subprocesses from a workflow template*.

4. Click **Perform Task** on the toolbar.

   The **Select Signoff Team** dialog box appears.

5. Click **Users** in the **Signoff Team** tree.

   The **Organization** tab displays to the right.

6. Search and select a user from the **Organization** tree. You can assign a resource pool to the task in the **Resource Pool Options**.

   For more information about using and defining resource pools, see the *My Teamcenter Guide*.

7. Click **Add** to add the selected user to the signoff team.

8. Repeat these steps to assign additional users to the signoff process.

9. (Optional) Type a description of the workflow process in the **Process Description** box.

10. (Optional) From the **Review Quorum** box, select the amount of users who must approve in order for the task to complete. Select a quorum using one of the following methods:

    - Select the **Numeric** option and type a number in the box.
    - Select the **Percent** option and type a percentage in the box.

11. (Optional) Type any comments regarding the task in the **Comments** box.

12. If you want the workflow process to wait for all reviewers before continuing, select the **Wait for Undecided Reviewers** check box.

13. Click **Ad-hoc done** to indicate you have completed adding signoff team members.
14. Click **OK** to complete the task and close the dialog box.

**Select a signoff team from address lists**

1. Select a **select-signoff-team** task that has reached **Started** status, either in the task hierarchy tree or the process flow pane.

2. Review any task instructions written in the **Instructions** box, at the bottom of the template manager pane.

3. (Optional) If you know you have additional tasks to perform before you can perform the **select-signoff-team** task, you can create a subprocess from this task. The subprocess must complete before the **select-signoff-team** task can complete.
   
   For more information about creating a subprocess, see *Creating subprocesses from a workflow template*.

4. Click **Perform Task** on the toolbar.

   The **Select Signoff Team** dialog box appears.

5. Click **Address Lists** in the **Signoff Team** tree.

   The **Address Lists** tab displays to the right.

6. Select an address list from the list to display the members of the address list.

7. Click **Add**.

   All members of the address list appears under **Addresses** in the **Signoff Team** tree.

8. Repeat these steps to add additional address lists.

9. (Optional) Type a description of the workflow process in the **Process Description** box.

10. (Optional) From the **Review Quorum** box, select the amount of users who must approve in order for the task to complete. Select a quorum using one of the following methods:

    • Select the **Numeric** option and type a number in the box.

    • Select the **Percent** option and type a percentage in the box.

11. (Optional) Type any comments regarding the task in the **Comments** box.

12. If you want the workflow process to wait for all reviewers before continuing, select the **Wait for Undecided Reviewers** check box.

13. Click **Ad-hoc done** to indicate you have completed adding signoff team members.

14. Click **OK** to complete the task and close the dialog box.
Letting others perform your tasks

Using the Out of Office Assistant in My Teamcenter or thin client

The Out of Office Assistant command lets you forward your tasks to another user or to a resource pool while you are out of the office.

You can set the period of time you will be out of the office and to set the name of the user or the resource pool to receive your tasks during your absence.

- System administrators can modify Out of Office Assistant settings for any user.
- Group administrators can modify Out of Office Assistant settings for members of their group.

For more information about resource pools, see Using resource pools.

**Note**

- The Out of Office Assistant menu command is available only when My Worklist is selected.
- The Out of Office Assistant does not reassign existing tasks in your inbox. These tasks must be manually reassigned using the Assign command on the Actions menu.
- If you clear both the start and end dates (in other words, set them to null), the Out of Office Assistant is turned off.

Set your out of office status

   The system displays the Out of Office Assistant dialog box.

2. Select the user, group, and role for whom these settings apply. You must be an administrator to change another user's out of office status.

3. Set the Out of Office Dates absence beginning date and time by performing the following steps:
   a. Click the calendar button next to the From box to open the calendar. The calendar initially shows the current day, month, and year.
   b. Select the month in which your absence begins. Click the right-arrow button to move forward in the calendar. Click the left-arrow button to move backward in the calendar.
   c. Type a year in the Year box.
   d. Type the hour, minute, and second at which your absence begins in the h, m, and s boxes.
      Use the 24-hour clock format; for example, type 1:30 p.m. as 13h, 30m, and 00s.
   e. Click OK to accept the date and time and close the calendar.
Chapter 1  Creating workflow templates

4. Set the **Out of Office Dates** absence ending date and time by performing the following steps:
   a. Click the calendar button next to the To box to open the popup calendar. The calendar initially shows the current day, month, and year.
   b. Select the month in which your absence ends. Click the right-arrow button to move forward in the calendar. Click the left-arrow button to move backward in the calendar.
   c. Type a year in the Year box.
   d. Type the hour, minute, and second at which your absence ends in the h, m, and s boxes. Use the 24-hour clock format; for example, type 1:30 p.m. as \textbf{13 h, 30 m, and 00 s}.
      \textbf{Note} If you are unsure of your return date, leave the date blank. Your assigned tasks are forwarded until you reset your status.
   e. Click \textbf{OK} to accept the date and time and close the calendar.
      \textbf{Note} If you clear both the start and end dates (in other words, set them to null), the **Out of Office Assistant** is turned off.

5. Set the **New Task Recipient** by selecting the group, role and user name of the person to whom the assigned tasks will be forwarded. If the system indicates the selected person is out of office, that person cannot be selected as a recipient.

6. Click \textbf{OK}.

**Allowing surrogate users to perform tasks in My Teamcenter or thin client**

You can define a list of surrogate users who are authorized to perform your workflow tasks. Once defined, a link to your inbox appears in the inbox of the surrogate user and they can claim responsibility for a task or designate themselves the active surrogate and perform any of the tasks in your inbox, provided that they match the group and role profile of the task.

- Surrogate users can perform workflow tasks when the user to whom the task was originally assigned is out of the office or is unable to perform the task. This prevents unnecessary stoppages in the workflow process, yet allows the original user to retain control of the task.
- Multiple surrogate users can be defined for a single task; however, only a single user can be the active surrogate for the task at any given time.
- Surrogate users are automatically granted all access privileges afforded to the original responsible party or approver.
  - Any user can be designated as a surrogate, but only a user who belongs to the group and role specified by the task profile can perform a task.
  - Any user can take responsibility for a task, even if that user does not match the group and role profile of the task.
Note: You cannot define special access control lists (ACLs) for a surrogate user.

Define a surrogate for another user (requires administrative privileges)

1. Click My Worklist in the navigation pane.
   The system displays your inbox.

2. Choose Tools→Workflow Surrogate.
   The system displays the Workflow Surrogate dialog box.

3. Select the group, role, and user for whom you are defining surrogates.
   The dialog box displays surrogates for the selected user in the Current Surrogate User(s) list.

   Note: You can choose all roles within a group by selecting the asterisk (*) rather than selecting a specific role.

4. Select the group, role, and user to be a surrogate.

5. Set the Surrogate Effective Dates effectivity start date for the surrogate user as follows:
   a. Click the calendar button in the From box to open the popup calendar.
   b. Select the month in which the surrogate user becomes effective. Click the back arrow to scroll to the previous month or click the forward arrow to scroll to the next month.
   c. Type the year in which the surrogate user becomes effective.
      Click the back arrow to scroll to the previous month or click the forward arrow to scroll to the next month.
   d. Select the day the surrogate user becomes effective by clicking the appropriate square on the calendar.
   e. Type the hour, minute, and second at which the surrogate user’s effectivity begins in the h, m, and s boxes.
      Use the 24-hour clock format; for example, type 1:30 p.m. as 13 h, 30 m, and 00 s.
      If you do not specify another time or clear the boxes, the current time is entered.
   f. Click OK to accept the effectivity start date and time and close the calendar.

6. Set the Surrogate Effective Dates effectivity end date for the surrogate user:
   a. Click the calendar button in the To box to open the popup calendar.
   b. Select the month in which the surrogate user’s effectivity ends.
      Click the back arrow to scroll to the previous month or click the forward arrow to scroll to the next month.
Chapter 1  Creating workflow templates

c. Select the year in which the surrogate user's effectivity ends.
   Click the back arrow to scroll to the previous year or click the forward arrow to scroll to the next year.

d. Select the day the surrogate user's effectivity ends by clicking the appropriate square on the calendar.

e. Type the hour, minute, and second at which the surrogate user's effectivity ends in the h, m, and s boxes.
   Use the 24-hour clock format; for example, type 1:30 p.m. as 13 h, 30 m, and 00 s.
   If you do not specify another time or clear the boxes, the current time is entered.

f. Click OK to accept the effectivity end date and time and close the calendar.
   To allow the surrogate user to be effective indefinitely, leave the end date unset. To reset the effectivity dates, click Reset.

7. Click Add.
   The system displays the surrogate user in the Current Surrogate Users list, the surrogate user is notified via e-mail, and a link is created in the surrogate user's inbox.
   The link in the surrogate user's inbox allows the surrogate user to access the inbox of the user for whom they are acting surrogate.

Define a surrogate for your workflow tasks

1. Click My Worklist in the navigation pane.
   The system displays your inbox.

2. Choose Tools→Workflow Surrogate.
   The system displays the Workflow Surrogate dialog box.

3. Select the group, role, and user to be a surrogate.
   You can choose all roles within a group by selecting the asterisk (*) rather than selecting a specific role.

4. Set the Surrogate Effective Dates effectivity start date for the surrogate user:
   a. Click the calendar button in the From box to open the popup calendar.
   b. Select the month in which the surrogate user becomes effective. Click the back arrow to scroll to the previous month or click the forward arrow to scroll to the next month.
   c. Select the year in which the surrogate user becomes effective. Click the back arrow to scroll to the previous year or click the forward arrow to scroll to the next year.
d. Select the day the surrogate user becomes effective by clicking the appropriate square on the calendar.

e. Type the hour, minute, and second at which the surrogate user's effectivity begins in the h, m, and s boxes.

Use the 24-hour clock format; for example, type 1:30 p.m. as 13 h, 30 m, and 00 s.

If you do not specify another time or clear the boxes, the current time is entered.

f. Click OK to accept the effectivity start date and time and close the calendar.

5. Set the Surrogate Effective Dates effectivity end date for the surrogate user:

You have set the effectivity start date for the surrogate user. Now you must set the effectivity end date.

a. Click the calendar button in the To box to open the popup calendar.

b. Select the month in which the surrogate user's effectivity ends. Click the back arrow to scroll to the previous month or click the forward arrow to scroll to the next month.

c. Select the year in which the surrogate user's effectivity ends. Click the back arrow to scroll to the previous year or click the forward arrow to scroll to the next year.

d. Select the day the surrogate user's effectivity ends by clicking the appropriate square on the calendar.

e. Type the hour, minute, and second at which the surrogate user's effectivity ends in the h, m, and s boxes.

Use the 24-hour clock format; for example, type 1:30 p.m. as 13 h, 30 m, and 00 s.

If you do not specify another time or clear the boxes, the current time is entered.

f. Click OK to accept the effectivity end date and time and close the calendar.

[Tip] To allow the surrogate user to be effective indefinitely, leave the end date unset. To reset the effectivity dates, click Reset.

6. Click Add.

The system displays the surrogate user in the Current Surrogate Users list. In addition, a link is created in the surrogate user's inbox. This link allows them to access the inbox of the user for whom they are acting surrogate. The surrogate user is notified via e-mail.

Remove a surrogate user

1. Click My Worklist in the navigation pane.
The system displays your Inbox.

2. Choose **Tools→Workflow Surrogate**.
   
The system displays the **Workflow Surrogate** dialog box.

3. Select the user to be removed from the **Current Surrogate Users** list.

4. Click **Remove**.

5. Click **Close** to exit the **Workflow Surrogate** dialog box.

**Claiming active surrogate status for a task**

If an administrator has defined you as a surrogate user, you can become the active surrogate for a task by performing the task as a surrogate, or by taking complete responsibility of the task.

To perform a task as the active surrogate, you must belong to the group and role matching the profile of the task. However, you are not required to belong to the group and role matching the task profile when assuming responsibility for a task.

**Note**

Unlike performing a task as the active surrogate, assuming responsibility for a task removes control from the original user.

**Use Surrogate Actions options**

1. From your worklist, click the link corresponding to the worklist of the user for whom you will act as a surrogate.

2. Select the task in the original user’s worklist.

3. Choose **Actions→Stand-In**.
   
The system displays the task name, responsible party, and surrogate user in the **Surrogate Actions** dialog box.

4. Select one of the following options:

   - **Stand-In**
     
     Allows you to perform the task while allowing the original user to retain control.

   - **Release**
     
     Releases the active surrogate from the task. At this point, the active surrogate cannot perform the task without first reclaiming it.

     When you select the **Release to Responsible Party** option, the checkout on the target object is transferred from the active surrogate to the responsible party (original user), and the system releases the checkout status from the surrogate user and reassigns it to the original user.

   - **Transfer Check-Out(s)**
     
     Transfers checkout of the target objects from the original user to the active surrogate when you select the **Stand-In** option.
5. Click OK.

Teamcenter designates the user as the active surrogate and grants the surrogate all privileges assigned to the original user. The system indicates that there is an active surrogate for the task by displaying the surrogate task symbol in the task display.

**Assign one or more tasks to other users in My Teamcenter or thin client**

1. Select the current task in your Tasks to Perform folder.

2. Choose Actions→Assign.

   The system displays the Assign Responsible Party dialog box.

3. Use the Organization or Project Teams tab to select the responsible party.

   **Note** You can only reassign tasks to a user who meets the group and role criteria specified for the task.

4. (Optional) Reassign multiple tasks, as follows:

   a. Click Show Tasks.

      The system displays the pending tasks associated with the selected process in a tree structure.

   b. Select individual tasks to be reassigned, or click the Select All the Tasks button to select all displayed tasks.

      **Note** Click the Clear the Selection button to clear selections you have made in the tree.

5. Click OK to reassign the selected tasks to the new user.

**Claim a task in Workflow Viewer**

You can claim a task from a resource pool or another user whose worklist you have access to. This reassigns the task to you and makes you the responsible party. This is a simpler way of reassigning a task to yourself using the Assign action.

1. Open a process in Workflow Viewer.

   For more information, see the Workflow Viewer Guide.

2. Select the task in the workflow you want to claim.

3. Choose Actions→Claim Task.

4. If the task is assigned to a single user, such as a Do task or select-signoff-team task, click OK in the confirmation dialog box.

   If the task is assigned to multiple users, such as a perform-signoffs task, the Claim Perform Signoff dialog box appears.

5. In the Claim Perform Signoff dialog box, select the user you want to claim the task from and click Claim.
Chapter 1  
Creating workflow templates

If the Claim button is not active after selecting a user, you cannot claim the task from that user.

The task appears in your worklist, and you become the responsible party for the task.

**Reassign a task in Workflow Viewer**

If you are the responsible party or a privileged user, you can reassign any task that has not already been started.

For example, if you are the initiator of a process, the tasks of selecting a signoff team and performing signoffs are automatically assigned to you. You may want to reassign one or both of these tasks to another user.

- You can only reassign a task to another user who meets the group and role criteria defined for the selected task.
- If you want to reassign the task to yourself, use the Claim Task menu command instead.

For more information about claiming tasks, see *Claim a task in Workflow Viewer*.

1. Select the task to be reassigned.
   You can select it in either in the task hierarchy tree or the process flow pane. In the process flow pane, the selected task's subtasks appear.

2. Choose Actions→Assign.
   The Assign Responsible Party dialog box appears.

3. If the Responsible Party entry contains a link, you can reassign the responsible party for this signoff task. Reassign the responsible party by clicking the link next to this entry.
   The Assign Responsible Party dialog box appears. The Organization and Project Teams lists display the available groups, roles, and users to which you can reassign the task.

4. Select the desired group, role, or user. You can only reassign the selected task to a user who meets the group and role criteria required by the task.

5. (Optional) Reassign multiple tasks, as follows:
   a. Click Show Tasks.
      The system displays the pending tasks associated with the selected process in a tree structure.
   b. Select individual tasks to be reassigned, or click the Select All the Tasks button to select all displayed tasks.
      Click the Clear the Selection button to clear selections you have made in the tree.

6. Click OK or click Cancel at any time to cancel the operation without making changes to the database.
Assigning tasks using process assignment lists in My Teamcenter or thin client

Managing process assignment lists

Process assignment lists are distribution lists associated with workflow process templates. These lists assign resources to all tasks in a workflow process. Assignment lists can be used to assign resources to single-user tasks, such as Do tasks, and to multiple-user tasks, such as perform-signoffs tasks.

When used with single-user tasks, assignments are replaced with the resources specified in the list. When used with multiple-user tasks, the resources defined in the list are appended to the resources to whom the tasks are currently assigned. In addition, multiple process assignment lists can be associated with a single workflow process, providing users with multiple task assignment configurations.

Process assignment lists can be either shared or private.

- **Shared** lists are generated by members of the **DBA** group or by a user designated as a group administrator. These lists are available for use by all users and cannot be modified by end users.
- **Private** lists can be created by any user and are only visible to that user.

Create process assignment lists

1. Choose **Tools→Process Assignment List→Create/Edit**.
   The system displays the **Create/Edit Assignment List** dialog box.
   
   **Tip** You can create an assignment list based on another list by selecting the list from one of the assignment list folders, entering a new name, and clicking **Create**.

2. Type a name for the list in the **Name** box.

3. Choose the process template to associate with the list:
   a. Choose **Assigned** to select from all process templates assigned to your group or choose **All** to select from available process templates.
   b. Select a template from the **Process Template** list.

4. (Optional) Select the **Create Shared List** check box. This option is only available to members of the **DBA** group and to group administrators.

5. (Optional) Type a description of the process assignment list in the **Description** box.

6. Click the **Resources** tab.
   The system displays the process and its associated task templates in a tree structure. You can view the task flow by clicking the **Process View** tab. This view allows you to view the subtasks, handlers and properties of the selected task.
   
   **Note** The **select-signoff-team** and **perform-signoffs** subtasks associated with **Route, Review**, and **Acknowledge** tasks are not displayed in the tree.
Assign responsible parties:

a. Select the task node in the tree.
   
The system displays Group, Role, and User lists in the right side of the window.
   
   These lists let you select responsible parties based on their group and role within the organization. In addition, when assigning responsible parties for a task, the only action that can be assigned is **Perform**.

b. Use the Group, Role, and User lists to select the responsible party.

c. Click Add (+).
   
The system displays the user information and action assigned to that user beneath the task node in the process tree.

d. Repeat the previous steps to assign a responsible party for other tasks in the process.

Assign users:

a. Expand the task node in the tree to begin to assign users to review, acknowledge, or receive notification of a task.
   
The system displays the Users node and the Profiles node.
   
The Users node allows you to assign resources using an ad hoc selection process.
   
   Profiles limit the pool of users that can be assigned to the task.
   
   The system displays the Profiles node when user profiles were defined as part of the process template.

b. Select the Users or Profiles node.

c. Use the Group, Role, and User lists to select a user.

d. Select an action from the list.
   
The system displays the actions in this list based on the task template type. For example, if a Route task is selected, the Review, Acknowledge, and Notify actions are displayed. If a Review task is selected, only the Review action is available; if an Acknowledge task is selected, only the Acknowledge action is available.

e. Click Add (+).
   
The system displays the user information and action assigned to that user beneath the task node in the process tree.

f. Repeat the previous steps to assign users to review, acknowledge, or receive notification of other tasks in the tree.

   **Tip** You can copy user nodes and paste them in to another task using the Copy and Paste buttons located beneath the tree.
g. (Optional) Modify or set the quorum value for Review and Acknowledge tasks in the Rev Quorum and Acknow Quorum boxes.

7. Click Create.

The system displays the process assignment list in your My Lists folder.

Modify task assignments in your process assignment lists

1. In My Teamcenter, choose Tools→Process Assignment List→Create/Edit.
   The system displays the Create/Edit Assignment List dialog box.

2. Select a list from the My Lists folder. If you are a group administrator you can modify lists contained in the My Group Lists folder, as well as those contained in the My Lists folder. If you are a member of a DBA group, you can modify lists contained in any of the folders.

3. Assign responsible parties to the task:
   a. Click the Resources tab.
   b. Select the task node in the tree.
      The system displays Group, Role, and User lists in the right side of the window.
      These lists let you select responsible parties based on their group and role within the organization. In addition, when assigning responsible parties for a task, the only action that can be assigned is Perform.
   c. Use the Group, Role, and User lists to select the responsible party.
   d. Click Add (+).
      The system displays the user information and action assigned to that user beneath the task node in the process tree.
   e. Repeat the previous steps to assign a responsible party for other tasks in the process.

4. Assign users to review, acknowledge, or receive notification of a task:
   a. Expand the task node in the tree to begin to assign users to review, acknowledge, or receive notification of a task.
      The system displays the Users node and the Profiles node.
      The Users node allows you to assign resources using an ad hoc selection process.
      Profiles limit the pool of users that can be assigned to the task.
      The system displays the Profiles node when user profiles are defined as part of the process template.
   b. Select the Users or Profiles node.
   c. Use the Group, Role, and User lists to select a user.
Chapter 1  Creating workflow templates

d. Select an action from the list.
   The system displays the actions in this list based on the task template type. For example, if a Route task is selected, the Review, Acknowledge, and Notify actions are displayed. If a Review task is selected, only the Review action is available; if an Acknowledge task is selected, only the Acknowledge action is available.

e. Click Add (+).
   The system displays the user information and action assigned to that user beneath the task node in the process tree.

f. Repeat the previous steps to assign users to review, acknowledge, or receive notification of other tasks in the tree.
   Tip You can copy user nodes and paste them into another task using the Copy and Paste buttons located beneath the tree.

g. (Optional) Modify or set the quorum value for Review and Acknowledge tasks in the Rev Quorum and Acknow Quorum boxes.

5. Click Modify to save the changes you have made.

Replacing users in process assignment lists

To replace a user who is assigned responsibility for tasks within a process, or multiple processes, through assignment lists, both the old and new user must be members of the same group and fill the same role within the group.

Replace a user in one or more process assignment lists

   The system displays the Replace Group Member wizard.

2. Select the old group member from the organization tree by clicking the button to the right of the Old Group Member box.
   The system displays the Select Group Member dialog box.

3. Expand the tree to locate and select the group member.
   Teamcenter closes the dialog box and displays the wizard.

4. Select the new group member by clicking the button to the right of the New Group Member box.
   The system displays the Select Group Member dialog box.

5. Expand the tree to locate and select the group member.
   Teamcenter closes the dialog box and displays the wizard.
   Note If you do not select a new group member, the old group member is removed from the process assignment list.

6. Click Next.
Creating workflow templates

The system displays all process assignment lists that include the user designated as the old group member.

7. Select the lists in the Lists Found section and click Add (+) to move the lists to the Selected Lists section.

Teamcenter replaces the user in these lists.

8. Click Finish.

The system displays the Replace Success dialog box.

9. Click OK to close the dialog box.

Importing and exporting process assignment lists

You can use Import and Export options in the Create/Edit Assignment List dialog box to import and export process assignment lists (PALs) in PLM XML format.

- Exporting a process assignment list also exports its associated workflow template.

- Importing a process assignment list also imports its associated workflow template.

  o When importing a PAL and the importing site does not have one with the same name:
    ■ The PAL is successfully imported if at least one resource is assigned to the PAL.
    ■ The associated workflow template is also successfully imported if a template with the same origin_id property does not exist at the importing site.
    ■ Otherwise, neither the PAL nor the template is successfully imported.

  o When the Overwrite Duplicate Assignment Lists check box is not selected, a PAL with the same name as one at the importing site is not imported.

  o When the Overwrite Duplicate Assignment Lists check box is selected, and you import a PAL that has the same name as one at the importing site:
    ■ The PAL successfully overwrites the one at the importing site if at least one resource is assigned to the PAL and a workflow template with the same origin_id property exists at the importing site.
    ■ Otherwise, neither the PAL nor the template is successfully imported.

Assigning all tasks in a process using process assignment lists

You can assign all tasks in a new or in-progress workflow process using process assignment lists. These lists let you choose configurations of users to assign to the tasks in a given process template.

Access to this feature is controlled by the EPM_valid_user_to_apply_assignment_list preference.
Chapter 1  Creating workflow templates

Note  For information about assigning all tasks when you initiate a new process, see *Initiate a workflow process using My Teamcenter*.  

Assign tasks to an in-progress process

1. Select an in-process data object.

2. Choose **Tools**→**Process Assignment List**→**Assign**.

   The system displays the assignment lists associated with the workflow process template in the **Assign All Tasks** dialog box. To select from all process assignment lists rather than only those associated with the process template, select the **Show All Assignment Lists** check box.

3. Select a list from the **Assignment Lists** list.

   Teamcenter applies the assignment list to the tasks in the process. Users are displayed as nodes in the process tree, and the action assigned to the user is displayed to the right of the tree under the **Actions** heading.

   Note  The **select-signoff-team** and **perform-signoffs** subtasks associated with **Route**, **Review**, and **Acknowledge** tasks are not displayed in the tree.

4. (Optional) Modify the task assignments by assigning responsible parties:

   a. Select the task node in the tree.

      The system displays **Group**, **Role**, and **User** lists in the right side of the window.

      These lists let you select a responsible party based on their group and role within the organization. In addition, when assigning a responsible party for a task, the only action that can be assigned is **Perform**.

   b. Use the **Group**, **Role**, and **User** lists to select the responsible party.

   c. Click **Add (+)**.

      The system displays the user information and action assigned to that user beneath the task node in the process tree.

   d. Repeat the previous steps to assign a responsible party for other tasks in the process.

5. (Optional) Modify the task assignments by assigning users to review, acknowledge, or receive notification of a task.

   a. Expand the task node in the tree to display the **Users** node and the **Profiles** node.

      • The **Users** node lets you assign resources using an ad hoc selection process.

      • The **Profiles** node, displayed when user profiles are defined as part of the process template, lets you limit the pool of users that can be assigned to the task.

   b. Select the **Users** or **Profiles** node.
c. Use the **Group**, **Role**, and **User** lists to select a user.

d. Select an action from the list.

   The system displays the actions in this list based on the task template type. For example, if a **Route** task is selected, the **Review**, **Acknowledge**, and **Notify** actions are displayed. If a **Review** task is selected, only the **Review** action is available; if an **Acknowledge** task is selected, only the **Acknowledge** action is available.

e. Click **Add** (+).

   The system displays the user information and action assigned to that user beneath the task node in the process tree.

f. Repeat the previous steps to assign users to review, acknowledge, or receive notification of other tasks in the tree.

   **Tip** You can copy user nodes and paste them into another task using the **Copy** and **Paste** buttons located beneath the tree.

g. (Optional) Modify or set the quorum value for **Review** and **Acknowledge** tasks in the **Rev Quorum** and **Acknow Quorum** boxes.

6. (Optional) To save modifications to the process assignment list, select the **Save Modifications Back to List** check box.

   **Note** You can only save modifications to personal process assignment lists. Shared lists can be modified, but the changes cannot be saved.

7. Click **Assign**.

   Teamcenter sends the tasks to the **Tasks to Perform** folders of the assignees.

**Managing work contexts in My Teamcenter**

**Managing work contexts**

You can create work contexts and associate them with data objects.

- A **work context** is a profile that a user assumes to complete a specific assignment.

- Work contexts are created from a combination of user name, group, role, and project; however, it is not necessary to include all four of these elements in the definition of a work context.

  - If task can be performed by anyone, regardless of their group and role, the work context specifies only the project to which the context applies.

  - If a task can be performed only by a user with a specific role within a group, the work context definition specifies the project, group, and role, but not a specific user.

- Work contexts are related to data objects by the **TC_WorkContext_Relation** relationship. This relationship can only be established between a work context object and a workflow task, item, or item revision.
Create a work context

1. Select the workflow process, task, item, or item revision for the work context.

2. Choose **File→New→Work Context**.
   The system displays the **New Work Context** dialog box.

3. Type a name for the work context in the **Name** box.

4. (Optional) Type a description of the work context in the **Description** box.

5. Select any combination of group, role, user, and project from the lists.

6. (Optional) Select the **Subgroup Members Allowed** check box. When this option is selected in addition to specifying a group for the work context, Teamcenter allows members of subgroups of the specified group to perform the task.

7. (Optional) Select the **User Setting Modifiable** check box. When this option is selected, users can modify the user settings associated with this work context.

   **Note**
   The default setting for this option is controlled by the **TC_wc_setting_modifiable_default** preference.
   For more information, see the *Preferences and Environment Variables Reference*.

8. Click **OK**.

Assign a work context to a workflow task, item, or item revision

1. Select the object to which you want to assign the work context.

2. Choose **Tools→Assign Work Context**.
   The system displays the **Assign Work Context** dialog box.

3. Find the work context by typing its name or partial name and wildcard in the **Name** box and click **Find**.
   The system displays the first page of work contexts that match the search criteria. Click the right-arrow or left-arrow buttons to load the next or previous page of results.

4. Select the work context from the list and click **Apply** or **OK**.
   Teamcenter assigns the work context to the selected item, item revision, or workflow task.

   **Note**
   In addition to using this method, you can assign a work context to an object by selecting the work context object in a tree or table, copying to the clipboard, and pasting to another object.

Remove work contexts from an object

- To remove a work context that is assigned to an object, select the work context and choose **Cut** from the shortcut menu.
Work contexts that are not referenced by another object can be deleted from the database.

Assigning tasks using resource pools in My Teamcenter

Using resource pools
You can use resource pools to balance workflow tasks between groups of users.

- Resource pools let you balance workflow task assignments. They allow open-ended assignments, permitting any user to accept responsibility for a task that is assigned to a group, role, or a role in a group.

- All users can subscribe to resource pool inboxes; however, they can only perform tasks if they are valid members of the group or are assigned the appropriate role.

  Administrators can use the EPM_resource_pool_restrict_subscription preference to restrict users to subscribe only to resource pools belonging to groups and roles in which the user is a member.

  For more information about this preference, see the Preferences and Environment Variables Reference.

- Tasks assigned to a resource pool appear in the Tasks to Perform folder and the Tasks to Track folder of the appropriate resource pool inbox. Any member of the resource pool can then accept responsibility and perform the task. All members of a group, role, or role-in-group can take ownership of the assignment. The assignment is delivered to the Tasks to Perform folder for all members.

Assigning tasks to a resource pool
Any select-signoff-team task can be assigned to a resource pool.

Resource pools are assigned responsibility for a task in the same way that a user is assigned responsibility: a group and role are defined, and the resource pool is indicated by the use of an asterisk (*) in place of a specific user name.

Subscribe or unsubscribe a resource pool of a group, role, or role in a group

   The system displays the Resource Pool Subscription dialog box.

2. Define the group and role for the resource pool worklist:
   a. Click Accessible to list the groups and roles to which you belong. As a member of the resource pool’s defined group and role, you are able to access and perform tasks assigned to the resource pool.
   b. Click All to list all groups and roles. If you are not a member of the resource pool’s defined group and role, you are not able to access and perform tasks assigned to the resource pool.
   c. Select the group and role you want assigned to the resource pool.
Chapter 1  Creating workflow templates

3. Click **Subscribe a Resource Pool (+)**.
   The resource pool is added to the list in the **My Worklist** tree.

4. In the **My Worklist** tree, select a resource pool.

5. Click **Unsubscribe a Resource Pool (x)** to remove a resource pool from the **My Worklist** tree.

6. Click **Cancel** at any time to close the dialog box without making changes to the database.

**Setting due dates and durations for tasks**

**Set a due date for a task using My Teamcenter**

**Note**
- You can set a due date for a task and create a list of users who are notified if the task is not completed by the due date, but you can only set due dates for tasks that are started.

- The **Task Manager** daemon must be installed to see color-coding relating to task completion.

For more information, see the *System Administration Guide*.

1. From your inbox in **My Worklist**, select a task in the **Tasks to Track** or **Tasks to Perform** folder.

2. Click **Task Properties 📝** on the toolbar.
   The system displays the **Task Properties** dialog box.

3. Set the due date, as follows:
   a. Click **Due Date** to open the calendar.
      The calendar initially shows the current day, month, and year.
   b. Select the month in which the task becomes due. Click the right-arrow button to move forward in the calendar. Click the left-arrow button to move backward in the calendar.
   c. Type a year in the **Year** box.
   d. Type the hour and minute by which the task must be completed in the **h** and **m** boxes. Use the 24-hour clock format; for example, type 1:30 p.m. as **h: 13 m: 30**. If you do not specify another time or clear the boxes, the current time is entered. If you clear the boxes, the time is set to **0** and no required completion time is set for the task.
   e. Click **OK** to accept the due date and time and close the calendar.

You have set a due date for the task. Next, you must create a list of recipients to receive late notices by Teamcenter mail if the task is not performed by the due date. You can specify individual users or assign multiple users to the task using address lists.
4. Define the recipient list by typing a comma-separated list of user names in the **Recipients** box in the **Task Properties** dialog box or as follows:
   a. Click **Set** to the right of the **Recipients** box.
      The system displays the **Select Recipients** dialog box.
   b. Locate a user, group, or address list by entering the name, or a partial name and wildcard character, in the **Search** box and clicking the **User**, **Group**, or **Address list** button. You can display all users, groups, or address lists by entering an asterisk (*) in the **Search** box.
      The system displays the search results in the area beneath the **Search** box.
   c. Select the users, groups, or address list from the results and click **To**.
   d. Click **OK** to accept the recipient list and exit the **Select Recipients** dialog box.
      The system displays the names of the recipients in the **Recipients** box of the **Task Properties** dialog box.

5. Click **Close** to exit the **Task Properties** dialog box.

**Set task duration and assign overdue notice recipients using My Teamcenter**

The **duration** of a task is the time allowed for the completion of a task that is not yet started.

**Note**
- Duration is based on the start date plus time. The duration includes weekends and holidays, and is based on a 7-day week. For times exceeding a single week, you should include the nonwork days in the duration time.

- The **Task Manager** daemon must be installed to see color-coding relating to task completion.

For more information, see the **System Administration Guide**.

1. From your inbox in **My Worklist**, select a task in the **Tasks to Track** or **Tasks to Perform** folder.
2. Open the **Viewer** view and select the **Process View**.
3. Click **Task Properties** on the toolbar.
   The system displays the **Task Properties** dialog box.
4. Click **Set** to the right of the **Duration** box.
   The system displays the **Set Duration** dialog box.
5. Enter integer values in one or more of the following boxes to specify the duration:
   - **Years**
   - **Weeks**
   - **Days**
• Hours

• Minutes

After you set a duration for the task, you must create a list of recipients to receive late notices by Teamcenter mail if the task becomes overdue. You can specify individual users or assign multiple users to the task using address lists.

6. Define the recipient list by typing a comma-separated list of user names in the Recipients box in the Task Properties dialog box or as follows:

a. Click Set to the right of the Recipients box.

   The system displays the Select Recipients dialog box.

b. Locate a user, group, or address list by entering the name, or a partial name and wildcard character, in the Search box and clicking the User, Group, or Address list button. You can display all users, groups, or address lists by entering an asterisk (*) in the Search box.

   The system displays the search results in the area beneath the Search box.

c. Select the users, groups, or address list from the results and click To.

d. Click OK to accept the recipient list and exit the Select Recipients dialog box.

   The system displays the names of the recipients in the Recipients box of the Task Properties dialog box.

7. Click Close to exit the Task Properties dialog box.

**Set due date in Workflow Viewer**

**Due Date** displays the date when completion of the task is due. If the task is not complete by the specified date, the task’s status changes to late and the task becomes overdue. Overdue tasks display in red in your worklist.

The default setting is **No date set**. The due date can be set from this dialog box.

1. Click the Due Date button.

   The popup calendar displays the current month.

2. Enter the date using any of the following methods:

   • Type a date directly in the box at the top.

   • Type a year in the Year box to change it, scroll through previous or succeeding months using the arrows, and click the desired date in the calendar display.

   • Click the Today button.

3. Enter the hour, minute, and second of the task completion time to the left of the respective h:, m:, and s: boxes. Base entries on a 24-hour clock. For example, enter 1:30 p.m. as 13 h: 30 m: 00 s. Empty boxes automatically default to 0.

4. Choose one of the following:

   • Click OK to save the changes to the database and close the popup calendar.
• Click **Clear** to clear all settings.

**Note**  
The amount of time it takes for a due date to reflect **late** status depends on the interval setting defined for the **Task Manager** daemon. This daemon can be modified in the preference XML file by editing the **TASK_MONITOR_SLEEP_TIME** value.

**Set duration in Workflow Viewer**

The **Duration** box displays the length of time allowed for the completion of the project. If the task is not completed within the specified amount of time, the task’s status changes to **late** and the task becomes overdue. The duration length can be defined in the template of the selected task. The duration length can also be defined in the **Attributes** dialog box when the selected task is in a **Pending** state.

**Note**  
The **Task Manager** daemon must be installed to see color-coding relating to task completion.

For more information, see the **System Administration Guide**.

1. Click **Set** to the right of the **Duration** box.  
The **Set Duration** dialog box appears.

2. Type an integer value for any or all of the following boxes to indicate the length of time that can pass before the selected task needs to reach completion:

   - **years**
   - **weeks**
   - **days**
   - **hours**
   - **minutes**

3. Click one of the following buttons:
   - Click **OK** to save the changes to the database and close the dialog box.
   - Click **Clear**.
   - Click **Cancel** at any time to close the dialog box without making any changes.

**Set recipients list in Workflow Viewer**

**Recipients** displays the names of users selected to receive program mail when the selected task becomes overdue. The recipients list is set from this dialog box.

1. Click **Set** to the right of the **Recipients** box.  
The **Select Recipients** dialog box appears.

2. Enter the **User**, **Group**, or **Address List** search criteria for users you want to select.

3. Click **User**, **Group**, or **Address List**, based on the search criteria entered.  
The search results appear in the box below. To display all users in the selected grouping, type * and click the appropriate button. All users in the selected grouping display in the box below.
4. Select the users you want to define as recipients from the search results. You can choose multiple users by pressing the control key and clicking the desired names.

5. Click the To button.
   The selected users display in the box in the right side of the dialog box. These are the selected recipients.

6. To delete a recipient, select the recipient and click the X button.

7. Click one of the following buttons:
   - Click OK to save the changes to the database and close the dialog box.
   - Click Cancel at any time to close the dialog box without making changes.

Create an ACL and recipients for a task

1. On the toolbar, click Edit Mode.

2. Click Task Properties in the toolbar.
   The system displays the Task Properties dialog box.
   The Name box lists the name of the selected workflow process template or task template.

3. Click the Attributes Panel tab.
   The system displays the Attributes Panel dialog box.

4. Click Named ACL to add permissions for the task and target objects.
   a. Click Assign to ACL Name to update the Assigned ACL Name box.
      This action creates the EPM-set-rule-based-protection handler on the Start action for the task.
   b. (Optional) To verify the assignment, view the Task Handler panel.

5. Use one of the following methods to select an ACL to apply to the task.
   - In the ACL Name box, select an existing ACL.
     o Click the system Named ACL button to list ACL names created in Access Manager.
     o Click the workflow Named ACL button to list ACL names created in Workflow Designer.

6. In the ACL Name box, type a new ACL name and click Create.
   The new ACL is added to the list of workflow named ACLs.
   a. Add access control entries (ACEs) to define the permissions for the named ACL.
   b. Click Save to save the ACEs for the named ACL.
For information about creating a named ACL, see the Access Manager Guide.
For information about workflow accessors and privileges, see the Security Administration Guide.

7. To set the Recipients list:
   - Click Set to the right of the Recipient box.
     The system displays the Select Recipients dialog box.
   - Type the user, group, or address list search criteria for users you want to select.
   - Based on the search criteria you entered, click either User, Group, or Address List.
     The search results display in the box below. To display all users in the selected grouping, type * and click the appropriate button. All users in the selected grouping display in the box.
   - Select the users you want to define as recipients from the search results. You can choose multiple users by pressing Ctrl and clicking the desired names.
   - Click Users.
     The selected users display in the box in the right side of the dialog box. These are the selected recipients.
   - To delete a recipient, click Delete.
   - Close the Named ACL dialog box.

**Note** When a named ACL is applied to a task and the Named ACL dialog box is closed, the Show Task in Process Stage List property on the Tasks Attributes Panel is automatically selected.
   - The Show Task in Process Stage List displays the task in the Process Stage List property for the target object.
   - Tasks in the Process Stage List are used to determine the ACL for the target objects.

8. Select Show Task in Process Stage List to display the task in the Process Stage List property for the target object.
   - Select the Show Task in Process Stage List property when a named ACL is defined for a task.
   - Clear the Show Task in Process Stage List when there are no named ACL and EPM-set-rule-based-protection handler defined for this task, and the task does not need to appear in the target object Process Stage List. For example, clear this box for subtasks or parent tasks.

**Note** The Process Stage List also determines the task's attributes, such as responsible party or signoff approvers, factored into the currently active named ACL.
9. Click **Close** to save the changes to the database and close the dialog box.

**Workflow examples**

**Change Manager workflow example**

You can change this example to match your participants, organization, and conditions.

*[Note]* If you are using Aerospace and Defense business objects (for example, `Ade0ChangeRqstRevision`), you can add them to the `-type` and `-include_types` arguments.

When this example is completed, the workflow should look like the following.

1. In Workflow Designer, select **File→New Root Template**, name your template, and use **Empty Template** as your root template. Click **OK**.

2. For the **Start** task, ensure the **CR-assign-team-selector** and **EPM-auto-assign-rest** handlers are attached to the **Start** task action. To the **Start** task action, add the **EPM-set-property** handler with the following arguments and values:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-property</td>
<td>CMIsFastTrack</td>
</tr>
<tr>
<td>-value</td>
<td>No</td>
</tr>
<tr>
<td>-to_attach</td>
<td>TARGET</td>
</tr>
<tr>
<td>-include_type</td>
<td>ChangeRequestRevision</td>
</tr>
<tr>
<td>-bypass</td>
<td></td>
</tr>
</tbody>
</table>

This sets the ECR **CMIsFastTrack** property to **No**. This ensures the ECR starts on the standard track.

3. Create a **Validate** task named **Is Specialist Assigned ?** to check if a change specialist is assigned to the ECR. Add the **EPM-check-object-properties** handler to the **Start** task action with the following arguments and values:
### Arguments and Values

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-include_type</td>
<td>ChangeRequestRevision</td>
</tr>
<tr>
<td>-property</td>
<td>ChangeSpecialist1</td>
</tr>
<tr>
<td>-attachment</td>
<td>target</td>
</tr>
</tbody>
</table>

4. **Validate** task needs tasks at the end of a **Complete** path and **Error** path. In this case, if a change specialist is not assigned, that is an error that the user needs to correct. To do this, create a **Do** task called **Assign Specialist** and draw an **Error** path from the **Validate** to the **Do** task and a **Complete** path back. To the **Do** task, add the **EPM-auto-assign** handler to the **Start** task action with the following argument and value:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-assignee</td>
<td>resourcepool:Change Management::Manager</td>
</tr>
</tbody>
</table>

This assigns the task to any user who has the Manager role in the Change Management group. The Manager must edit the ECR object to add a change specialist 1 to it. Once that is done, the user can go back to the workflow, click **Complete** on the task, and the workflow moves along the **Complete** path.

**Note** By default, the **Do** task has automatically configured **EPM-check-condition**, **EPM-inherit**, and **EPM-hold** handlers. You do not have to alter these.

5. Create another **Validate** task named **Are Analyst & CRB Assigned?** to check if an analyst and change review board members are assigned to the ECR. Draw a **Complete** path from the **Is Specialist Assigned? Validate** task to this task. Add the **EPM-check-object-properties** handler to the **Start** task action of this task with the following arguments and values:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-include_type</td>
<td>ChangeRequestRevision</td>
</tr>
<tr>
<td>-property</td>
<td>Analyst,ChangeReviewBoard</td>
</tr>
<tr>
<td>-attachment</td>
<td>target</td>
</tr>
</tbody>
</table>

6. If an analyst or change review board members are not assigned, that is an error that the user needs to correct. To do this, create a **Do** task called **Assign Analyst & CRB** and draw an **Error** path from the **Validate** to the **Do** task and a **Complete** path back. To the **Validate** task, add the **EPM-auto-assign** handler to the **Start** task action with the following argument and value:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-assignee</td>
<td>$CHANGE_SPECIALIST1</td>
</tr>
</tbody>
</table>

This assigns the task to the user who has been assigned as the change specialist 1 for the ECR. The change specialist 1 must edit the ECR object to add the missing analyst or change review board members to it. Once that is done, the
user can go back to the workflow, click Complete on the task, and the workflow moves along the Complete path.

**Note** By default, the Do task has automatically configured EPM-check-condition, EPM-inherit, and EPM-hold handlers. You do not have to alter these.

7. Create a Do task named Identify Impacted Items, Propose Solution and add the EPM-auto-assign handler to the Start task action with the following argument and value:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-assignee</td>
<td>$ANALYST</td>
</tr>
</tbody>
</table>

This assigns the task to the user who has been assigned as the analyst for the ECR. The analyst follows the instructions in the workflow. Once that is done, the analyst can go back to the workflow, click Complete on the task, and the workflow moves along the Complete path.

**Note** By default, the Do task has automatically configured EPM-inherit and EPM-hold handlers. You do not have to alter these.

8. Create a Condition task named Planning Complete ? and add the EPM-auto-assign handler to the Start task action with the following argument and value:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-assignee</td>
<td>$CHANGE_SPECIALIST1</td>
</tr>
</tbody>
</table>

This assigns the task to the user who has been assigned as the change specialist 1 for the ECR. The change specialist 1 follows the instructions in the workflow. Once that is done, the analyst can go back to the workflow and select one of the three paths based on the results. The three paths are added once more tasks further along the workflow are created.

**Note** By default, the Condition task has automatically configured the EPM-check-condition handler. You do not have to alter it.


10. Create a Do task named Derive CN, Start CN, Fast Track and add the following handlers.

a. Add the EPM-auto-assign handler to the Start task action with the following argument and value:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-assignee</td>
<td>$CHANGE_SPECIALIST1</td>
</tr>
</tbody>
</table>

This assigns the task to the user who has been assigned as the change specialist 1 for the ECR. The analyst follows the instructions in the workflow.
Once that is done, the analyst can go back to the workflow, click **Complete** on the task, and the workflow moves along the **Complete** path.

b. To the **Start** task action, add a **EPM-set-property** handler with the following arguments and values:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-property</td>
<td>CMMaturity, CMDisposition</td>
</tr>
<tr>
<td>-value</td>
<td>Reviewing, Approved</td>
</tr>
<tr>
<td>-to_attach</td>
<td>TARGET</td>
</tr>
<tr>
<td>-include_type</td>
<td>ChangeRequestRevision</td>
</tr>
<tr>
<td>-bypass</td>
<td></td>
</tr>
</tbody>
</table>

This sets the ECR’s **Maturity** and **Disposition** properties to **Reviewing** and **Approved**, respectively, which allows the ECR to be placed on the fast track.

c. To the **Start** task action, add another **EPM-set-property** handler with the following arguments and values:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-property</td>
<td>CMIsFastTrack</td>
</tr>
<tr>
<td>-value</td>
<td>Yes</td>
</tr>
<tr>
<td>-to_attach</td>
<td>TARGET</td>
</tr>
<tr>
<td>-include_type</td>
<td>ChangeRequestRevision</td>
</tr>
<tr>
<td>-bypass</td>
<td></td>
</tr>
</tbody>
</table>

This sets the ECR’s **Is Fast Track?** property to **Yes**, which notes the ECR went through the fast track process.

d. To the **Complete** task action, add another **EPM-set-property** handler with the following arguments and values:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-property</td>
<td>CMMaturity</td>
</tr>
<tr>
<td>-value</td>
<td>Executing</td>
</tr>
<tr>
<td>-to_attach</td>
<td>TARGET</td>
</tr>
<tr>
<td>-include_type</td>
<td>ChangeRequestRevision</td>
</tr>
<tr>
<td>-bypass</td>
<td></td>
</tr>
</tbody>
</table>

This sets the ECR’s **CMMaturity** property to **Executing**, which completes the ECR in the change process and allows a change notice to be derived from it.
11. Create a Review task named **CRB Review Proposed Solution** and add the **EPM-set-property** handler to the **Start** task action with the following arguments and values:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-property</td>
<td>CMMaturity</td>
</tr>
<tr>
<td>-value</td>
<td>Reviewing</td>
</tr>
<tr>
<td>-to_attach</td>
<td>TARGET</td>
</tr>
<tr>
<td>-include_type</td>
<td>ChangeRequestRevision</td>
</tr>
<tr>
<td>-bypass</td>
<td></td>
</tr>
</tbody>
</table>

This sets the ECR’s **Maturity** property to **Reviewing**, which notes that the change review board is looking at the proposed change.

Note By default, the **Review** task has automatically configured the **EPM-inherit, EPM-set-rule-base-protection, and EPM-execute-follow-up** handlers. You do not have to alter these.

12. Draw paths from the **Planning Complete ?** task to the **Derive CN, Start CN, Fast Track** and **CRB Review Proposed Solution** tasks. You need to customize the three paths so the change specialist 1 can choose which path the workflow must go. Right click on each path, choose **Set Custom Result**, and set the paths as follows:

<table>
<thead>
<tr>
<th>Target task</th>
<th>Path name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Or Plan not OK</td>
<td>Plan not OK</td>
</tr>
<tr>
<td>Derive CN, Start CN, Fast Track Plan OK - Fast Track</td>
<td>Plan OK - Fast Track</td>
</tr>
<tr>
<td>CRB Review proposed solution Plan OK - Standard Track</td>
<td>Plan OK - Standard Track</td>
</tr>
</tbody>
</table>

13. Create a Condition task named **Set CRB Results** and add the **EPM-auto-assign** handler to the **Start** task action with the following argument and value:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-assignee</td>
<td>$CHANGE_SPECIALIST1</td>
</tr>
</tbody>
</table>

This assigns the task to the user who has been assigned as the change specialist 1 for the ECR. The change specialist 1 follows the instructions in the workflow. Once that is done, the analyst can go back to the workflow and select one of the three paths based on the results. The three paths are added once more tasks further along the workflow are created.

Note By default, the **Condition** task has automatically configured the **EPM-check-condition** handler. You do not have to alter it.
14. Create a custom task named **Notify CR Approved** and add the following handlers:

   a. Add the **EPM-set-property** handler to the **Start** task action with the following arguments and values:

      | Arguments    | Values              |
      |--------------|---------------------|
      | -property    | CMDisposition       |
      | -value       | Approved            |
      | -to_attach   | TARGET              |
      | -include_type| ChangeRequestRevision|

   **-bypass**

   This sets the ECR's **Disposition** property to **Approved**, which allows a change notice to be derived from the ECR.

   b. Add the **EPM-notify** handler to the **Start** task action with the following arguments and values:

      | Arguments    | Values                        |
      |--------------|-------------------------------|
      | -recipient   | $REQUESTOR,$ANALYST           |
      | -subject     | CR Approved                   |
      | -attachment  | $TARGET                       |

   This sends an e-mail to the ECR requestor and analyst notifying them that the ECR has been approved by the change review board.

15. From the **CRB Review Proposed Solution** task, draw an **Approved** path to the **Notify CR Approved** task and a **Rejected** path to the **Set CRB Results** task.

16. Create a custom task named **Set Disposition: Investigate** and add the **EPM-set-property** handler to the **Start** task action with the following arguments and values:

      | Arguments    | Values              |
      |--------------|---------------------|
      | -property    | CMDisposition       |
      | -value       | Investigate         |
      | -to_attach   | TARGET              |
      | -include_type| ChangeRequestRevision|

   **-bypass**

   This sets the ECR's **Disposition** property to **Investigate**, which indicates the analyst needs to do more work on the ECR.

   **Note** By default, the task has automatically configured the **EPM-check-condition** handler. You do not have to alter it.
17. Create a custom task named **Notify Rejected** and add the following handlers:

a. Add the **EPM-set-property** handler to the **Start** task action with the following arguments and values:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-property</td>
<td>CMDisposition</td>
</tr>
<tr>
<td>-value</td>
<td>Disapproved</td>
</tr>
<tr>
<td>-to_attach</td>
<td>TARGET</td>
</tr>
<tr>
<td>-include_type</td>
<td>ChangeRequestRevision</td>
</tr>
</tbody>
</table>

**-bypass**

This sets the ECR’s **Disposition** property to **Disapproved**, which indicates no further action is to be taken with the ECR.

b. Add the **EPM-notify** handler to the **Start** task action with the following arguments and values:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-recipient</td>
<td>$REQUESTOR,$ANALYST</td>
</tr>
<tr>
<td>-subject</td>
<td>CR Rejected</td>
</tr>
<tr>
<td>-attachment</td>
<td>$TARGET</td>
</tr>
</tbody>
</table>

This sends an e-mail to the ECR requestor and analyst notifying them that the ECR has been rejected by the change review board.

**Note** By default, the task has automatically configured the **EPM-check-condition** handler. You do not have to alter it.

18. Draw the following paths:

a. Draw paths from the **Set CRB Results** task to the **Notify CR Approved**, **Set Disposition: Investigate**, and **Notify Rejected** tasks. You need to customize the three paths so the change specialist 1 can choose which path the workflow must go. Right click on each path, choose **Set Custom Result**, and set the paths as follows:

<table>
<thead>
<tr>
<th>Target task</th>
<th>Path name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify CR Approved</td>
<td>Approved</td>
</tr>
<tr>
<td>Set Disposition: Investigate</td>
<td>Rework</td>
</tr>
<tr>
<td>Notify Rejected</td>
<td>Rejected</td>
</tr>
</tbody>
</table>

b. Also draw a **Complete** path from the **Set Disposition: Investigate** task to the **Or** task. This sends the workflow back to the **Identify Impacted Items, Propose Solution** task for rework.

19. Create a **Do** task named **Close PRs** and add the following handlers.
a. Add the **EPM-auto-assign** handler to the **Start** task action with the following argument and value:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-assignee</td>
<td>$CHANGE_SPECIALIST1</td>
</tr>
</tbody>
</table>

This assigns the task to the user who has been assigned as the change specialist 1 for the ECR. The analyst follows the instructions in the workflow. Once that is done, the analyst can go back to the workflow, click **Complete** on the task, and the workflow moves along the **Complete** path.

b. To the **Start** task action, add a **EPM-set-property** handler with the following arguments and values:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-property</td>
<td>CMClosure, CMMaturity</td>
</tr>
<tr>
<td>-value</td>
<td>Closed, Complete</td>
</tr>
<tr>
<td>-to_attach</td>
<td>TARGET</td>
</tr>
<tr>
<td>-include_types</td>
<td>ChangeRequestRevision</td>
</tr>
<tr>
<td>-bypass</td>
<td></td>
</tr>
</tbody>
</table>

This sets the ECR's **Closure** and **Maturity** properties to **Closed** and **Complete**, respectively, which closes out the ECR.

**Note** By default, the **Do** task has automatically configured **EPM-inherit** and **EPM-hold** handlers. You do not have to alter these.

20. Create a **Do** task named **Derive CN** and add the following handlers.

a. Add the **EPM-auto-assign** handler to the **Start** task action with the following argument and value:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-assignee</td>
<td>$CHANGE_SPECIALIST1</td>
</tr>
</tbody>
</table>

This assigns the task to the user who has been assigned as the change specialist 1 for the ECR. The analyst follows the instructions in the workflow. Once that is done, the analyst can go back to the workflow, click **Complete** on the task, and the workflow moves along the **Complete** path.

b. To the **Start** task action, add a **EPM-set-property** handler with the following arguments and values:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-property</td>
<td>CMMaturity</td>
</tr>
<tr>
<td>-value</td>
<td>Reviewing</td>
</tr>
<tr>
<td>-to_attach</td>
<td>TARGET</td>
</tr>
</tbody>
</table>
Arguments | Values
---|---
-include_type | ChangeRequestRevision
-bypass | 

This sets the ECR’s **Maturity** property to **Reviewing**, which allows an ECN to be derived.

c. To the **Complete** task action, add a **EPM-set-property** handler with the following arguments and values:

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>-property</td>
<td>CMMaturity</td>
</tr>
<tr>
<td>-value</td>
<td>Executing</td>
</tr>
<tr>
<td>-to_attach</td>
<td>TARGET</td>
</tr>
<tr>
<td>-include_type</td>
<td>ChangeRequestRevision</td>
</tr>
<tr>
<td>-bypass</td>
<td></td>
</tr>
</tbody>
</table>

This sets the ECR’s **Maturity** property to **Executing**, which closes out the ECR after the ECN has been derived.

**Note** By default, the **Do** task has automatically configured **EPM-inherit** and **EPM-hold** handlers. You do not have to alter these.

21. Create another **Or** task called **Or** and draw paths from the **Derive CN** and **Close PRs** tasks to it. Then draw a path from the new **Or** task to the **Finish** task. Then also draw a path from the **Derive CN, Start CN, Fast Track** tasks to the **Finish** task.

This completes the workflow. You can apply this workflow to any ECR revision object.

### Replace status of target objects workflow example

This workflow process example illustrates how to add status to objects which, for whatever reason, do not have the required status.
For example, after importing numerous objects from another system, a one-time change of status may be required so the status of the newly imported objects conform with the current system.

This workflow process applies a status of ACMERP to all target objects. If any targets have a different status, that status is replaced with ACMERP.

The **Start** node contains all the handlers for the root task. The root task contains all the other tasks within a workflow process. It is the first task to start and the last task to complete. Therefore, the handlers placed on the root task control the beginning and end of the workflow process itself, not merely the behavior of an individual task.

In this workflow example, handlers placed on the **Start** action of the root task:

- Confirm the workflow process is initiated by the correct role.
- Confirm the correct target objects are selected.
- Confirm the selected target objects are checked in.
- Automatically attach the correct target objects to the workflow.
- Attach all the components of the target assembly as targets of the workflow process.
- Configure the assembly to **Working**.
- Exclude any release objects from being attached.
• Attach all assembly components that were not added as targets as references.
• Attach all objects with various specified relations as targets of the workflow.

<table>
<thead>
<tr>
<th>Start action</th>
<th>Rule handler: EPM-check-action-performer-role</th>
</tr>
</thead>
</table>
| Arguments:Values | - responsible:DBA  
- responsible:ME |
| Description: | Checks whether a member of the DBA or ME groups initiated the workflow. If not, the workflow does not proceed. |

<table>
<thead>
<tr>
<th>Start action</th>
<th>Rule handler: EPM-validate-target-objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arguments:Values</td>
<td>- include_type:ACMEPartMfgRevision,ACMEMEMEProcessRevision,ACMEMEOPRevision</td>
</tr>
<tr>
<td>Description:</td>
<td>Restricts the types of objects that can be added as target objects to ACMEPartMfgRevision, ACMEMEProcessRevision and ACMEMEOPRevision.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Start action</th>
<th>Rule handler: EPM-assert-targets-checked-in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arguments:Values</td>
<td>No arguments set. (This handler does not accept arguments.)</td>
</tr>
<tr>
<td>Description:</td>
<td>Confirms that all objects selected as targets of the workflow process are checked in.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Start action</th>
<th>Action handler: PS-attach-assembly-components</th>
</tr>
</thead>
</table>
| Arguments:Values | - depth:1  
- exclude_released  
- rev_rule:Working  
- include_related_type:ACMETypes  
- add_excluded_as_ref |
| Description: | Traverses one level into the assembly and attaches all the components of the target assembly as targets of the workflow process, and then configures the assembly to Working. Excludes any release objects, collects only ACMETypes objects, and attaches all assembly components that were not added as targets as references. |

<table>
<thead>
<tr>
<th>Start action</th>
<th>Action handler: EPM-attach-related-objects</th>
</tr>
</thead>
</table>
| Arguments:Values | - relation:IMAN_METTarget  
- attachment:target |
| Description: | Attaches all objects with an IMAN_METTarget relation as targets of the workflow. |

<table>
<thead>
<tr>
<th>Start action</th>
<th>Action handler: EPM-attach-related-objects</th>
</tr>
</thead>
</table>
| Arguments:Values | - relation:IMAN_specification  
- attachment:target |
| Description: | Attaches all objects with an IMAN_specification relation as targets of the workflow. |
### ACMERP (Status task)

<table>
<thead>
<tr>
<th>Start action</th>
<th>Action handler: EPM-attach-related-objects</th>
</tr>
</thead>
</table>
| **Arguments:Values** | - relation: IMAN_Rendering  
| |  
| | - attachment: target |
| **Description:** | Attaches all objects with an IMAN_Rendering relation as targets of the workflow. |

<table>
<thead>
<tr>
<th>Start action</th>
<th>Action handler: EPM-attach-related-objects</th>
</tr>
</thead>
</table>
| **Arguments:Values** | - relation: IMAN_Reference  
| |  
| | - attachment: target |
| **Description:** | Attaches all objects with an IMAN_Reference relation as targets of the workflow. |

<table>
<thead>
<tr>
<th>Start action</th>
<th>Action handler: EPM-attach-related-objects</th>
</tr>
</thead>
</table>
| **Arguments:Values** | - relation: PSBOMViewRevision  
| |  
| | - attachment: target |
| **Description:** | Attaches all objects with a PSBOMViewRevision relation as targets of the workflow. |

In this workflow example, handlers placed on the Start action of the ACMERP task:

- Attach the ACMERP status to the ACMERP task.

Handlers placed on the Complete action of the ACMERP task:

- Delete all existing statuses assigned to any target objects and replace them with the ACMERP status.
Chapter 1  Creating workflow templates

<table>
<thead>
<tr>
<th>Arguments:Values</th>
<th>-status:ACMERP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description:</td>
<td>Attaches the ACMERP status to the ACMERP task.</td>
</tr>
</tbody>
</table>
| Note             | The ACMERP status should be already defined in the Business Modeler IDE.  
|                   | For more information about defining status types, see the Business Modeler IDE Guide. |

<table>
<thead>
<tr>
<th>Complete action</th>
<th>Action handler: EPM-set-status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arguments:Values</td>
<td>-action:replace</td>
</tr>
<tr>
<td>Description:</td>
<td>Deletes all existing statuses assigned to any target objects and replaces them with the ACMERP status.</td>
</tr>
</tbody>
</table>

Determining when and where templates run

Using workflow templates at multiple sites

Using workflow templates at multiple Teamcenter sites

There are two methods to distribute your workflow templates to different Teamcenter sites:

- Replicating templates using Multi-Site Collaboration
- Importing and exporting templates in an XML format

Replicating workflow templates

You can distribute your workflow templates to different Teamcenter sites by replicating templates using Multi-Site Collaboration. You can replicate your workflow templates, including those under construction, on several Teamcenter sites by using the data_share utility and update them with the data_sync utility. You cannot edit the replicas, only the template at the owning site. Also, handlers attached to the templates must exist at all sites where the templates are replicated.

Replicate a workflow template

1. If necessary, create the template you want to replicate.
   For more information, see Create workflow process templates in Workflow Designer.

2. Run the data_share utility with the following arguments:
   ```
   data_share -u=user-id -p=password -g=group -f=send
   -site=remote-site-name1 -name=workspace-object-class=class-name
   ```
For example, if you want to replicate the demotemplate workflow template at the teamcentersite2 site, run the following utility command (the required logon information is omitted from the example):

```
data_share -f=send -site=teamcentersite2 -name=demotemplate
-class=EPMTTaskTemplate
```

**Note**
- If you want to transfer ownership to the specified site, add the -transfer argument to the command.
- If you want to import the template at another site to the current site, change the -f argument to -f=remote_import.
- If you want to replicate the template at more than one site, add more -site arguments to the command.
- If you want to replicate several templates, type the template names in a text file and replace the -name and -class arguments with the -filename and -classoffile arguments, respectively.

The replicate template appears at the new site with the ☐️ symbol.

**Synchronize replicated templates**

1. Update the template at the owning site that is replicated at another site.
   
   For more information, see *Configure ability to apply template edits to active processes.*

   **Note** If you want active workflow processes based on the synchronized template to be updated at the replica site, set the `WRKFLW_multisite_apply_template_changes` preference to `true`.
   
   For more information, see the *Preferences and Environment Variables Reference.*

2. Run the `data_sync` utility with the following arguments:

   ```
data_sync -u=user-id -p=password -g=group -f=sync
-site=remote-site-name1 -class=class-name -update
```

   For example, if you changed the demotemplate workflow template and wanted to update the replica at the teamcentersite2 site, run the following utility command (the required logon information is omitted from the example):

   ```
data_sync -f=sync -site=teamcentersite2 -class=EPMTTaskTemplate -update
```

   **Note** If you want to synchronize the template at more than one site, add more -site arguments to the command.

   The replicate template is updated at the specified sites.
Importing and exporting workflow templates using Workflow Designer

You can distribute your workflow templates to different Teamcenter sites by importing and exporting workflow process and task templates from the Teamcenter database in an XML format.

- You can import workflow process and task templates into the Teamcenter database from an exported workflow template file. Importing templates is useful for transferring workflow templates between different Teamcenter sites. The templates must first be exported from a Teamcenter database into an export file, after which you can import the file into the Teamcenter database at another site.

- You can export workflow process and task templates from the Teamcenter database in XML format, storing the templates in a single export file. After exporting the templates, you can import the file into the Teamcenter database at another site. You can also easily search the XML to determine handler and argument usage.

Best practice

If your enterprise encompasses more than one site, always make workflow template changes at the master site, and then propagate the changes by exporting the workflow template from the master site to other sites. If additional changes are required at a later date, again make the workflow template changes at the master site, export the workflow template from the master site, and then import it at all other sites.

This method ensures that the origin_uid value of each workflow template continues to match from site to site. If you export/import a workflow template between nonmaster sites, its origin_uid value eventually becomes mismatched between versions, resulting in the following error when you choose to overwrite during import:

```
The origin_uid’s of the importing template(s) do not match with the origin_uid’s of the existing template(s). The import of template(s) in overwrite mode failed. Matching origin_uid’s are required to apply template changes to active workflow processes. You can replace the existing template by deleting it, and then re-importing, but this will prevent you from applying template changes to active workflow processes.
```

If you receive this error, you can manually replace the existing template with the importing template by first deleting the importing template, then repeating the import. However, using this method breaks the link between origin_uid values. If you use this method, the system cannot apply template changes to active workflow processes, as described in Applying template edits to active workflow processes.

Import workflow templates

1. Choose **Tools→Import**.
   The system displays the **Import Workflow Templates** dialog box.

2. Type the path to the directory containing the export file in the **Import File** box, or click the **Browse** button to locate the directory.

3. (Optional) If you want the system to continue the transfer if one or more workflow templates fail to transfer, select the **Continue On Error** check box. If one or more workflow templates fail to transfer, the system records transfer

---

Chapter 1  *Creating workflow templates*
errors in its log files, bypasses the failed workflow templates, and transfers the remaining workflow templates.

If you do not select this option, the system stops the transfer process if one workflow template fails to transfer and only includes in the transfer those workflow templates that transferred successfully.

4. (Optional) If you want the system to overwrite any workflow template of the same name that already exists in the database, select the Overwrite Duplicate Templates check box. The system does not display or log any errors.

Select this option when the imported workflow template contains changes that you want applied to the database.

For example, you have added two custom tasks to the QuarterlyReview workflow template and thoroughly tested the revised template in your test database. Now you are ready to import the changes to the production database. By choosing to overwrite duplicate templates when importing the workflow template to the production database, you are effectively editing the QuarterlyReview workflow template. On import, the original QuarterlyReview workflow template is overwritten by the importing workflow template; it now contains the two custom tasks.

If you do not select this option, any importing template with the same name as an existing template is ignored and the import process continues. A message is logged that a workflow template of the same name exists.

5. (Optional) If you chose to overwrite duplicate templates, you can also choose ignore the origin ID of the template you are importing by selecting the Ignore origin ID check check box.

Select this option if you get the following error when attempting to import workflow templates:

The importing template(s) do not match with the existing template(s).
The import of template(s) in overwrite mode failed.

6. (Optional) If you chose to overwrite duplicate templates, you can also choose to apply the differences in the imported templates to all active workflow processes based on the original version of the workflow template. In other words, you can choose to apply the edits you have made to the importing template to active workflow processes.

To continue the example in the previous step, if you select the Apply template changes to all active workflow processes check box while importing the QuarterlyReview workflow template into the production database, the two custom tasks added during import are also applied to all active workflow processes that were based on the original version of the QuarterlyReview workflow template.

Updates are applied as described in Applying template edits to active workflow processes.
Chapter 1  Creating workflow templates

Note

- This check box is visible only if the EPM_enable_apply_template_changes preference is set to OPTIONAL.
- This check box is not available if you selected the Ignore origin ID check check box.

7. (Optional) If you chose to apply edits to active workflow processes, you can also choose to process the edits in the background by selecting the Update processes in background check box.

Your edits are applied in the background. The updates run asynchronously and you are notified by Teamcenter mail when the updates complete. Typically, you only want to update workflow processes in real time when your changes impact 10–20 active workflow processes, as in testing scenarios.

Caution

Asynchronous processing must be configured.

For more information about the required configuration procedures, see Background processing requirements.

8. Click OK to import the templates contained within the file you selected into the Teamcenter database.

The imported template names now exist in the database and appear in the Process Template list.

Export workflow templates


The Export Workflow Templates dialog box appears.

2. Type the path to the directory containing the objects you want to export in the Export Directory box, or click the Browse button to locate the directory.

3. Specify the name of the export file in the File Name box, for example, template_export.

4. In the Templates section of the dialog box, select the templates you want to export from the All Templates list. (Use the Ctrl key to select multiple templates.)

5. Add the selected templates to the Selected Templates list. These are the templates the system exports.

6. If you want the system to continue the transfer if one or more templates fail to transfer, select Continue On Error. If one or more templates fail to transfer, the system records transfer errors in its log files, bypasses the failed templates, and transfers the remaining templates.

    If you do not choose this option, the system stops the transfer process if one template fails to transfer and only includes in the transfer those templates that transferred successfully.

7. Click OK to export the templates in the Selected Templates list and close the dialog box.
The selected templates are exported in XML format to the file name you defined in step 3 in the directory you defined in step 2.

**Processing templates and tasks in the background**

**Background processing requirements**

Background processing of template edits applied to active workflow processes allows the edits to be performed asynchronously (behind the scenes) without pausing your interaction with Workflow Designer.

Consider the processing time required to apply edits to all active workflow processes based on a particular workflow template. If Workflow Designer is processing edits to 10–20 active workflow processes, as may occur when testing the edits, the Workflow Designer interface does not noticeably slow down. But if the workflow template is in a production environment and has generated hundreds of active templates, processing time can be extensive. Performing the edits in the backgrounds prevents Workflow Designer from pausing until the edits complete.

Background processing of workflow objects requires a four-tier architecture environment. Users running in a two-tier environment can successfully submit requests for asynchronous processing if there is a four-tier Teamcenter environment available to accept the request.

Configuring background processing of workflow objects requires the following configuration tasks:

- Configure Teamcenter Dispatcher for background processing
- Configure Security Services for background processing
- Configure an SOA URL for background processing
- Configure notifications for background processing

You can also configure individual tasks in a workflow process to execute in the background with asynchronous processing:

- Configure tasks for background processing

**Configure Teamcenter Dispatcher for background processing**

Background processing also requires that Teamcenter Dispatcher be enabled and configured for background processing.

1. Open the `translator.xml` file from the `Dispatcher\Module\conf` directory.

```xml
<AsyncService provider="SIEMENS" service="asyncservice"
  inactive="false">
  <TransExecutable name="asyncservice.bat"
    dir="&MODULEBASE/Translators/asyncservice"/>
  <Options>
    <Option name="inputpath" string=""
      description="Full path to the input file or directory."/>
    <Option name="outputdir" string=""
      description="Full path to the output file."/>
    <Option name="OutputFileName" string="" value="output.txt"
      description="Name of the output file."/>
  </Options>
  <TransErrorStrings>
```
Chapter 1  
Creating workflow templates

```xml
<TransInputString string="AsyncInvoker Report"/>
<TransErrorStream string="AsyncInvoker Report"/>
</TransErrorStrings>
</AsyncService>
```

2. Set the `isactive` attribute to `true` to activate this translator.

   **Note**  
   Skip this step if you use TEM to install and configure this service.

3. Set the `maxlimit` attribute to the maximum number of requests your server manager pool can process simultaneously.

   For example:

   ```xml
   <AsyncService provider="SIEMENS" service="asyncservice" maxlimit="2" isactive="true">
   
   By default, the Dispatcher module runs only one request of a particular type at a time, which limits your throughput for test cases of submitting numerous requests.


   For example, the following settings direct the Dispatcher to check the database and staging directory every 2 hours and to clean up successful and unsuccessful requests when they become 3 days old:

   ```properties
   Service.RequestCleanup.Successful.Interval=120
   Service.RequestCleanup.Successful.Threshold=4320
   Service.RequestCleanup.Unsuccessful.Interval=120
   Service.RequestCleanup.Unsuccessful.Threshold=4320
   ```

   By default, the Dispatcher checks the database and staging area every 5 minutes and cleans up successful and unsuccessful requests when they become three days old.


   For example, the following setting sets the polling interval to 5 seconds:

   ```properties
   Service.PollingInterval=5
   ```

   By default, the Dispatcher client pools for new requests every 60 seconds.

6. Edit the `CHANGE_ME` properties in the `asyncservice.bat` (Windows) or `asyncservice.sh` (UNIX) file from the `Dispatcher\Module\Translators\asyncservice` directory.

   **Note**  
   Skip this step if you use TEM to install and configure this service.

7. (Optional) Reset the `async_invoker` retry count.

   By default, if `async_invoker` cannot connect to the destination four-tier system, it retries 60 times, one time every 60 seconds. If it has not connected after 60 attempts, it fails.
To reset the retry count or interval, use the `preferences_manager` utility to import and set the following preferences:

- `preferences_manager -u=infodba -p=infodba -g=dba -mode=import -preference=ASYNC_connection_retries -scope=SITE -values=1 -action=OVERWRITE`

- `preferences_manager -u=infodba -p=infodba -g=dba -mode=import -preference=ASYNC_connection_retry_interval -scope=SITE -values=10 -action=OVERWRITE`

Configure Security Services for background processing

Background processing (asynchronous functionality) supports Security Services for authentication of the asynchronous session in **BACKGROUND** and **BLOCKING** mode.

When calling requests on a different site, both the calling and destination site must be using the same Security Services directory. In addition, Teamcenter and Security Services must be configured to define a long time-out period for asynchronous requests.

1. In the Security Services LDAP directory, define a pseudo-application ID for each Teamcenter application ID, with the original application ID and the suffix `Async`.

   For example, if the Teamcenter application ID is `Tc1`, define a pseudo-application as `Tc1Async`.

   Configure this pseudo-application with the desired long time-out period (in seconds) for asynchronous requests.

   For example, if all asynchronous requests are to be ran in the same day, set the time-out value to \(60^2 \times 24 = 86400\).

2. Determine the mediator password for the Security Services installation. This value must be installed as an encryption key in the Teamcenter database. Run the `install_encryptionkeys` utility as follows, and enter the mediator password when prompted:

   ```bash
   install_encryptionkeys -u=infodba -p=password -g=dba -f=install_mediator_key
   ```

   When the caller calls an asynchronous request in **BACKGROUND** mode, the native C++ SOA framework obtains a special double-encrypted token from the Security Services Identity Service and stores it in the `DispatcherRequest` along with the other information for the request. When the Dispatcher schedules and calls the request, `async invoker` uses the mediator key to decrypt the token and uses it to log on to the new Teamcenter session as the original user.

Configure an SOA URL for background processing

Background processing (asynchronous functionality) requires a service oriented architecture (SOA) URL.

1. Open the Organization application in Teamcenter.

2. Select the top-level Sites node 🌐 from the Organization List tree.
Chapter 1  

Creating workflow templates

The Sites pane appears.

3. Type the SOA URL in the SOA URL box.

This URL is used for SOA calls to this site.

Configure notifications for background processing

Background processing (asynchronous functionality) uses Subscription Manager to notify users of completed and failed requests. Configure notification behavior by importing and configuring the ASYNC_subscribe_to_background_tasks preference and defining event types.

1. Use the preferences_manager utility to import and set the preference:

```bash
preferences_manager -u=infodba -p=infodba -g=dba -mode=import
-preference=ASYNC_subscribe_to_background_tasks -scope=SITE
-values=NONE|BOTH|FAIL|SUCCEED -action=OVERRIDE
```

The -values value must be one of the following:

- **NONE**  
  No notification e-mail is sent.
- **Both**  
  Notification e-mail is sent upon success and upon failure.
- **FAIL**  
  Notification e-mail is sent upon failure.
- **SUCCEED**  
  Notification e-mail is sent upon success.

2. If the following event type mappings do not exist, create them in the Event Type Mapping editor in Business Modeler IDE and make the event types subscribable:

<table>
<thead>
<tr>
<th>Primary Object</th>
<th>Event Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>DispatcherRequest</td>
<td>__Async_Request_Failed</td>
</tr>
<tr>
<td>DispatcherRequest</td>
<td>__Async_Request_Succeeded</td>
</tr>
</tbody>
</table>

For more information, see the Business Modeler IDE Guide.

3. Ensure Subscription Manager preferences are configured to correctly send notifications.

a. Choose Edit→Options to open the Options dialog box.

b. Click the Filter tab at the bottom left of the dialog box and type TC_subscription in the Search by preference name box.

   Confirm that the value is set to ON.

c. Type Mail_server_name in the Search by preference name box.

   Set the value to your mail server.

d. Type TC_notification_msg_ext in the Search by preference name box.

   Confirm that the value is set to txt to ensure your e-mail system does not block the attachment in the notification e-mail.
Configure tasks for background processing

You can configure individual tasks in a workflow process to run in the background. If they are configured for background processing, all of those tasks’ actions, except Perform and Assign, are processed asynchronously.

**Note** Your system must be configured for background processing.

For more information, see *Background processing requirements*.

1. Set the **EPM_task_execution_mode** preference to either CONFIGURABLE or BACKGROUND.

   If you set the preference to BACKGROUND, all tasks run in the background.

   If you set the preference to CONFIGURABLE, tasks that have their Process in Background check box selected in the workflow process template are sent to be run in the background.

2. If the **EPM_task_execution_mode** preference is set to CONFIGURABLE, open Workflow Designer and select the process template with the tasks you wanted ran in the background.

3. In Edit mode, click the task and then click the Task Attributes button.

4. Select the Process in Background check box and close the Attributes dialog box.

   Repeat for each task you want to run in the background

   Children tasks of those chosen to process in the background are processed in the background also.

5. When you have configured all the tasks in the workflow process template you want to run in the background, select the Set Stage to Available check box and click Yes in the Stage Change dialog box.

When a user creates a workflow using the process template, the workflow runs the tasks that have the Process in Background check box selected in the background.

**Editing templates**

**Determining which editing options to use**

Perform edits on existing workflow process templates by selecting the template to be edited and clicking the Edit button.

Consider the following questions before editing a workflow template.
## Editing task Description

### Edit offline or online?
Offline editing prevents users from accessing the workflow template while you edit. Use this option when you do not want the old version of the workflow template available for use until your edits are complete.

Online editing allows users to initiate workflows based on the old version of the workflow template while you edit a copy of the same workflow template. When you switch the edited version to the Available stage, the older copy is overwritten; only the edited copy remains available from the interface.

For more information about the behavior of offline and online editing, see *Editing offline versus online*.

### Apply edits to running workflow processes?
After editing a workflow template, you can choose to apply the edits to all active workflow processes based on that template.

When you select the Set Stage to Available check box to change the template's stage to Available, the Apply Template Changes dialog box asks whether to apply the edits to all active workflow processes based on the template.

Select the **Apply template changes to all active workflow processes** check box to update each active workflow process based on the workflow template as follows:

- If the edits in the workflow template occur *later* in the workflow than the active workflow process has reached, the edits are applied to the workflow.

- If the edits in the workflow template occur *earlier*, and the active workflow has already passed the place where the edits were made, the edits do not take effect, unless the task/path is re-run using backward branching/loops or when a task is demoted.

- If the edits in the workflow template impact an active task, the edits are applied after the task completes and only take effect if the task is re-run.

- If the edits deletes the currently active task, the next task is started.

For more information about applying template edits to active workflow processes, see *Applying template edits to active workflow processes*.
Creating workflow templates

<table>
<thead>
<tr>
<th>Editing task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which workflow components can be edited?</td>
<td>You can edit any aspect of the workflow process template, including:</td>
</tr>
<tr>
<td></td>
<td>• Changing the template name</td>
</tr>
<tr>
<td></td>
<td>• Adding and removing tasks</td>
</tr>
<tr>
<td></td>
<td>• Adding, deleting, redrawing, and resetting flow paths</td>
</tr>
<tr>
<td></td>
<td>• Adding, deleting, and resetting handlers, attributes, task attributes, and attachments</td>
</tr>
</tbody>
</table>

For more information about the editing workflow template procedure, see *Edit workflow templates*.

Editing offline versus online

Deciding whether to edit a workflow template online or offline is determined by whether you want to grant users access to the existing version of the workflow template while you edit it.

- **Online editing** allows users to initiate workflows based on the old version of the workflow template while you edit a copy of the same workflow template.
  
  Select **No** in the Offline? dialog box to edit online. The system makes a copy of the workflow template and sets it to the Under Construction stage; this is the version you edit. Both versions of the workflow template display in the Process Template list in the New Process dialog box. The Under Construction symbol displays next to the version being edited.

  Users can continue to use the unedited version of the workflow template. When you switch the edited version to the Available stage, the older copy is overwritten; only the edited copy remains available from the interface.

- **Offline editing** prevents users from accessing the workflow template while you edit it.
  
  Select **Yes** in the Offline? dialog box to edit offline. With this option, there is only one instance of the template. The system sets the workflow template to the Under Construction stage. The template is not available to users initiating workflow processes against objects; it does not display in the Process Template list in the New Process dialog box.

  Only users with privileges to edit workflow templates can see the workflow template in the Process Template list, which is marked with the Under Construction symbol. When you switch the workflow template to the Available stage, the edited workflow template becomes available to users.

Edit workflow templates

1. Select the desired workflow template from the Process Template box.
Chapter 1  Creating workflow templates

2. Select Edit mode.

A dialog box asks whether you want to take the selected process template offline. Select Yes to take the workflow template offline, preventing users from initiating workflow processes based on this template while you edit. The workflow template is not available to users from the Process Template list while you keep the template offline.

3. (Optional) Rename the template by selecting the existing template name in the Name box under the Set Stage to Available check box and typing a new name over the selection. Alternatively, backspace from the end of the name to delete the characters. After you type a new name, click one of the tasks in the task hierarchy tree to set the new name. You cannot change the name using the Process Template box.

**Warning** You cannot select the existing name and use the Delete key to delete the entire name at once. The system interprets use of the Delete key as a command to delete an object from the database.

4. (Optional) Add, place, and remove tasks.

For more information about tasks, see Insert a task into a template.

5. (Optional) Add, remove, and modify task attributes by clicking the Task Attributes button.

For more information, see Edit task attributes.

6. (Optional) Edit task handlers by clicking the Task Handlers button.

For more information, see Edit task handlers.

7. (Optional) Edit perform signoff teams by clicking the Task Signoff button.

For more information, see Completing select-signoff-team tasks using My Teamcenter or thin client.

8. After you finish editing the workflow template, select the Set Stage to Available check box.

The Stage Change dialog box appears, stating that changing the template stage to available makes the template visible to all users and asking if you want to continue. Click Yes to save your changes to the database, make the template visible to all users, and return to Browse mode.

Click No to remain in Edit mode.

**Configure ability to apply template edits to active processes**

Before you can apply workflow template edits to active workflow processes, you must configure the EPM_enable_apply_template_changes preference. By default, this preference is set to NONE, which suppresses this functionality.

1. Choose Edit→Options to open the Options dialog box.
2. Click the **Filter** tab at the bottom left of the dialog box and type EPM_enable_apply_template_changes in the **Search by preference name** box.

3. Select the **EPM_enable_apply_template_changes** and set the value to one of the following:

**OPTIONAL**

Allows you to choose on a case-by-case basis whether to apply workflow template edits to active workflow processes based on the workflow template.

After editing a workflow template and selecting the **Set Stage to Available** check box to change its stage to Available, the **Apply Template Changes** dialog box allows you to apply your edits to all active workflow processes based on the edited template.

Select the **Apply template changes to all active workflow processes** check box to apply your edits as described in Applying template edits to active workflow processes.

**AUTOMATIC**

Automatically applies edits to a workflow template to all active workflow processes based on the edited template.

After editing a workflow template and selecting the **Set Stage to Available** check box to change its stage to Available, the edits are automatically applied to all active workflow processes based on the edited template.

By default, this setting applies the edits in the background. However, this functionality requires a four-tier architecture environment. (Users running in a two-tier environment can successfully submit requests for asynchronous processing if there is a four-tier Teamcenter environment available to accept the request.) Additionally, Dispatcher must be enabled and configured for asynchronous processing.

**Note** If background processing is not configured and supported at your site, active workflow processes are updated in real time. When updating in real time, the Teamcenter interface pauses until the updates complete.

For more information about this preference, see the *Preferences and Environment Variables Reference*.

Updating the workflow processes in the background is the recommended method, and, by default, the **Update processes in background** check box is selected.

**Note** If you apply the updates in real time, the Teamcenter interface is unavailable until the updates complete. This method is suitable for testing. It is not recommended when updating more than 30–50 workflow processes.

The update duration depends on the type of edits made to the workflow processes. For example, it takes longer to remove tasks than add tasks. Edits within tasks (handlers, attributes, etc.) require minimal processing time.
Chapter 1  Creating workflow templates

Applying template edits to active workflow processes

You can use Workflow Designer to apply workflow template edits to all active workflow processes based on the previous (unedited) version of the workflow template.

Applying workflow template edits to all active workflow process is a powerful way to edit many active processes simultaneously. Because this is a far-reaching procedure, it is important to understand exactly how the edits are applied:

• If the edits in the workflow template occur later in the workflow than the active workflow process has reached, the edits are applied to the workflow.

• If the edits in the workflow template occur earlier, and the active workflow has already passed the place where the edits were made, the edits do not take effect, unless the task/path is re-run using backward branching/loops or when a task is demoted.

• If the edits in the workflow template impact an active task, the edits are applied after the task completes and only take effect if the task is re-run.

• If the edits deletes the currently active task, the next task is started.

  **Note**  This can result in users logging on and finding that tasks they were working on were removed from their worklist.

Additionally, active workflow processes can be updated in a similar manner when importing updated versions of a workflow template, either through the Workflow Designer application or using the `plmxml_import` utility.

For more information about importing workflow templates using Workflow Designer, see *Import workflow templates*.

For more information about importing workflow templates using the *plmxml_import* utility, see the *Utilities Reference*.

Before you can fully use this behavior, several procedures are required to enable and configure two types of functionality:

• Applying template edits to active workflow processes

• Allowing the active workflow processes to be updated in the background

For more information about the required configuration procedures, see *Configure ability to apply template edits to active processes* and *Background processing requirements*.

Apply template edits to all active workflow processes

You can apply edits to active workflow processes after you have completed editing a workflow template and are ready to make the workflow template available to users.

1. Select the **Set stage to available** check box to change the workflow template’s stage to **Available**.

   The **Apply Template Changes** dialog box appears asking whether to apply your edits to all active workflow processes based on the template.
You can also change a workflow template’s stage from **Under Construction** to **Available** when closing Workflow Designer. The **Set To Available Stage Template** dialog box displays whenever under construction workflow templates exist when you close Workflow Designer. Using this dialog box to change a template’s stage does not allow you to apply template edits to active workflow processes.

2. Select the **Apply template changes to all active workflow processes** check box.

   Your edits are applied to each active workflow process based on that workflow template. Edits are applied as listed in **Applying template edits to active workflow processes**.

3. (Optional) Select the **Update processes in background** check box.

   Your edits are applied in the background. The updates run asynchronously and you are notified by Teamcenter mail when the updates complete.

   Typically, you only want to update workflow processes in real time when your changes impact 10–20 active workflow processes, as in testing scenarios.

   **Caution**   Asynchronous processing must be configured.

   For more information about the required configuration procedures, see **Background processing requirements**.

You can also edit an active workflow process in Workflow Viewer, in which you edit the particular active workflow process, not the workflow template on which it is based. This method allows you to edit only one active workflow process at a time.

For more information about this method, see **Workflow Viewer Guide**.
Chapter

2 Using workflows processes to accomplish tasks

Initiate a workflow process using My Teamcenter ..................... 2-1

Sign off on tasks .................................................. 2-3
  Completing perform-signoffs tasks .................................. 2-3
  Sign off a task in My Teamcenter .................................... 2-4
  Signing off an Acknowledge or Review task ....................... 2-5
  Perform a signoff of an Acknowledge task in Workflow Viewer .... 2-6
  Sign off a Review task in Workflow Viewer ....................... 2-8

Performing tasks assigned to you ..................................... 2-11
  Determining task status ............................................ 2-11
  Performing interactive tasks ....................................... 2-13
    Complete a Do task using My Teamcenter ....................... 2-14
    Performing manual condition tasks ............................. 2-14
    Complete a started manual Condition task using My Teamcenter 2-15
  Complete a Customized task using My Teamcenter ............... 2-15
  Perform a Route task using My Teamcenter ...................... 2-16
  Performing tasks in Workflow Viewer ................................ 2-17
    Perform a Do task in Workflow Viewer .......................... 2-19
    Perform a Condition task manually in Workflow Viewer ....... 2-19
    Perform a Route task in Workflow Viewer ....................... 2-21
    Perform a Custom task in Workflow Viewer ...................... 2-22

Altering started workflow processes ................................. 2-23
  Overriding task actions .......................................... 2-23
  Perform action .................................................... 2-23
  Altering started workflow processes using My Teamcenter ....... 2-25
    Skip a task in a process and start the next one .............. 2-25
    Demote a process by putting a task in the Pending state .... 2-25
    Start a paused task ............................................. 2-26
    Suspend a task .................................................. 2-26
    Resume a task ................................................... 2-26
  Altering started workflow processes using Workflow Viewer .... 2-27
    Skip a task in a process and start the next one .............. 2-27
    Demote a task .................................................. 2-27
    Suspend a task .................................................. 2-28
    Resume a task ................................................... 2-28
    Starting a paused task ......................................... 2-29
    Reset a paused task ............................................. 2-29
Working with remote tasks ........................................ 2-29
   Using remote inboxes ........................................... 2-29
   Working with task data in remote inboxes ..................... 2-31
   Subscribe to a remote inbox .................................... 2-31
   Check out data to your local site from a remote site ......... 2-32
   Export data to your local site from a remote site ............ 2-32

Stopping a workflow process in Workflow Viewer .............. 2-33

Delete a workflow process in My Teamcenter .................... 2-34

Viewing workflow and schedule progress ....................... 2-34
   Reviewing workflow and schedule progress by viewing the process history ........................................ 2-34
   Customize the process history display ....................... 2-35
   Process reports .................................................. 2-36
   Print the process history report .............................. 2-36
   Export audit logs or process history to Microsoft Excel ... 2-37
Chapter

2 Using workflows processes to accomplish tasks

Initiate a workflow process using My Teamcenter

   The system displays the New Process Dialog dialog box.

2. Type a name for the process in the Process Name box.

3. Type a description to identify the process in the Description box.

4. Click the Process Template list to view process templates and make a selection.

5. Select a Process Template Filter option.
   • (Optional) Select the Show Under Construction Templates check box.
   • To view all available process templates, select the All option.
   • To view only those process templates assigned to your group, select the Assigned option.

   Note The CR_allow_alternate_procedures preference determines whether this property is displayed and whether you can select alternate workflow processes from the New Process Dialog dialog box using the Process Template Filter list.

6. Click the Attachments tab to view or assign target and reference attachments.
   It is not necessary to assign target data at the initiation of a process.
   • If necessary, generate a list of objects from several sources, including search results, Structure Manager, and other active Teamcenter applications, that can be pasted as references or attachments.
   For more information about pasting objects, see Advanced Paste to generate a list of objects as target or reference attachments.

7. Click the Process Template tab to view the process template selected as the basis of the new process.

8. (Optional) Assign all tasks in the process.
   a. Click the Assign All Tasks tab.
Chapter 2  

*Using workflows processes to accomplish tasks*

The system displays the assignment list information.

b. Select a list from the **Assignment Lists** list.

Teamcenter applies the assignment list to the tasks in the process. Users are displayed as nodes in the process tree and the action assigned to the user is displayed to the right of the tree under the **Actions** heading.

**Note** The select-signoff-team and perform-signoffs subtasks associated with **Route**, **Review**, and **Acknowledgement** tasks are not displayed in the tree.

c. (Optional) Assign responsible parties:

A. Select the task node in the tree.

B. Use the **Resource Pool Options** criteria and search capabilities to select the responsible party.

C. Click **Add (+)**.

The system displays the user information and action assigned to that user beneath the task node in the process tree.

D. Repeat the previous steps to assign a responsible party for other tasks in the process.

d. (Optional) Assign users:

A. Expand the task node in the tree to begin to assign users to review, acknowledge, or receive notification of a task.

The system displays either the **Users** node or **Profiles** node.

- The **Users** node allows you to assign resources using an ad hoc selection process.

- Profiles limit the pool of users that can be assigned to the task.

The system displays the **Profiles** node when user profiles were defined as part of the process template.

B. Select the **Users** or **Profiles** node.

C. Use the **Group**, **Role**, and **User** lists to select a user.

D. Select an action from the list.

The system displays the actions in this list based on the task template type. For example, if a **Route** task is selected, the **Review**, **Acknowledgement**, and **Notify** actions are displayed. If a **Review** task is selected, only the **Review** action is available; if an **Acknowledgement** task is selected, only the **Acknowledgement** action is available.

E. Click **Add (+)**.

The system displays the user information and action assigned to that user beneath the task node in the process tree.
F. Repeat the previous steps to assign users to review, acknowledge, or receive notification of other tasks in the tree.

Tip You can copy user nodes and paste them in to another task using the **Copy** and **Paste** buttons located beneath the tree.

e. (Optional) Modify or set the quorum value for **Review** and **Acknowledge** tasks in the **Rev Quorum** and **Acknow Quorum** boxes.

f. (Optional) To save modifications to the process assignment list, select the **Save Modifications Back to List** check box.

Note You can only save modifications to personal process assignment lists. Shared lists can be modified, but the changes cannot be saved.

9. Click **OK** to initiate the process.

Note Click **Cancel** at any time to cancel the operation without initiating a process.

### Sign off on tasks

#### Completing perform-signoffs tasks

The **Review**, **Acknowledge**, and **Route** tasks each contain a **perform-signoffs** subtask. The **perform-signoffs** subtask always follows the **select-signoff-team** subtask.

The members of the signoff team are typically selected by the process initiator.

For more information about the **select-signoff-team** task, see *Completing select-signoff-team tasks using My Teamcenter or thin client*.

Note The **Route** task contains a **Review** task, an **Acknowledge** task, and a **Notify** task. The **Route** task contains both signoff team subtasks.

- When you are a member of the signoff team, the **perform-signoffs** subtask appears in your worklist. Each member of the signoff team is responsible for reviewing the target object, then indicating a decision.
  - For **Acknowledge** tasks, the decision can be **Acknowledged** or **Not Acknowledged**.
  - For **Review** tasks, the decision can be **Approve**, **Reject**, or **No Decision**.

Note The **Not Acknowledged** and **No Decision** choices do not count toward the quorum count. If your decision is required to meet quorum requirements, this subtask cannot complete until you select either **Acknowledged** or **Approve**.

- If your company’s business practices dictate that you must be logged on under a specific group and role to complete a **perform-signoffs** task, the system displays a message and allows you to change your group and role to match the task requirements.
Chapter 2  Using workflows processes to accomplish tasks

• Group and role requirements are dictated by the SIGNOFF_required_group_and_role preference.

• When the functionality is enabled, you can see when other users are available for instant messaging with Microsoft Office Communicator. You can view the current status of other users on the signoff list, and you can click the Microsoft Office Communicator symbol to initiate communication.

For information about configuring Teamcenter instant messaging with Microsoft Office Communicator, see the Application Administration Guide.

Sign off a task in My Teamcenter

1. Select the perform-signoffs task in your Tasks to Perform folder.

2. Click the Viewer tab, and select the Task View option.

The system displays the Perform Signoff pane listing process information.

• Responsible Party

When the Responsible Party entry displays as an active link, you can reassign the parent task by clicking the link and selecting a new group, role, and user.

Reassigning the task transfers ownership of the parent task to the selected user, making that user the Responsible Party for the task. It does not, however, transfer your signoff responsibility.

• Instructions

When the Instructions link is displayed, there are instructions for the task. You can view the instructions by clicking the link.

• Attachments

When there are attachments to the workflow process, you can view them by clicking the Attachments link.

The system displays the Attachments dialog box. Target and reference attachments are listed beneath the signoff task in the task tree.

• All Comments

If the All Comments entry is present and is as an active link, comments are written for the task. You can view the comments by clicking the link.

3. (Optional) If you are a privileged user because you are the process owner, the responsible party, or a member of the administration group, you can delegate your signoff responsibility for the perform-signoffs subtask to another user.

   [Note]  If you are selected to a signoff team based on your inclusion under a signoff profile, you can only delegate the perform-signoffs subtask to another user who can match your signoff profile group and role. Otherwise, you can delegate the perform-signoffs subtask to any other user.

   a. Click your linked name in the User-Group/Role column.
The system displays the Delegate Signoff dialog box.

b. Select a new user from the Group, Role, and User lists.

c. Click OK.

Teamcenter assigns the task to the specified user and the task is placed in their Tasks to Perform folder.

4. Sign off the task:

a. Click the link in the Decision column to display the Signoff Decision dialog box.

b. Select an option.

- If perform-signoffs is a subtask of an Acknowledge task, select Acknowledged or Not Acknowledged.

- If perform-signoffs task is a subtask of a Review task, select Approve, Reject, or No Decision.

Note The Not Acknowledged and No Decision options do not apply to the quorum count. If your decision is necessary to meet quorum requirements, this subtask cannot complete until you select either Acknowledged or Approve.

c. (Optional) Type comments in the Comments box.

d. Click OK.

If user authentication is required to complete the task, type your password in the Password box, and click OK.

Note This authorization is determined by the creator of the process template. If your site employs Security Services, you must use the Security Services password rather than your Teamcenter password.

The task is complete and the Viewer tab now displays No View Data Available.

Sign off an Acknowledge or Review task

To perform a signoff task, complete the selected perform-signoffs task in the task tree. There are two types of perform-signoffs tasks:

- Review signoffs, with which the user can elect to Approve, Reject, or make No Decision for the selected task.

- Acknowledge signoffs, with which the user can elect to Acknowledge or Not Acknowledge the selected task.

Only members of the signoff team can sign off a task.

Note Siemens PLM Software recommends using your worklist in My Teamcenter to perform signoffs, as the worklist is designed specifically for performing tasks. If you are a responsible party, the Perform Signoff task is automatically sent to the Tasks to Perform folder in your worklist.
Information most pertinent to a signoff task is displayed in the Perform Signoff dialog box. The process name, task name, and task state are listed at the top of the dialog box. View any comments and instructions by clicking the respective links. Additional task information, such as task attributes, is displayed in other dialog boxes.

Click any linked entry to display its related dialog box. For example, click a linked entry in the Decision column to display the Signoff Decision dialog box and make your signoff decision.

Tool tips are available for each column in the dialog box. Activate the tool tips by moving your cursor over each column.

**Perform a signoff of an Acknowledge task in Workflow Viewer**

1. Select the perform-signoffs task to be completed, either in the task hierarchy tree or the process flow pane.

2. (Optional) If you know you have additional tasks to perform before you can perform the perform-signoffs task, you can create a subprocess from this task. The subprocess must complete before the perform-signoffs task can complete.
   
   For more information about creating a subprocess, see *Creating subprocesses from a workflow template*.

3. Click Perform Task ☑ on the toolbar.
   
   The Perform Signoff dialog box appears. The process name and task state appear at the top of the dialog box.

4. Review the contents of the Process Description box. If necessary, type additional information into the box.

5. If the Responsible Party entry contains a link, you can reassign the responsible party for this signoff task.
   
   a. Click the linked user name next to the Responsible Party entry.
      
      The Assign Responsible Party dialog box appears.

   b. The Organization and Project Teams tabs display the available groups, roles, and users to which you can reassign the role of responsible party.

   c. Select the desired group, role, or user and click OK.
      
      The task is reassigned to the selected responsible party and the dialog box closes.

6. If the All Comments entry is linked, comments have been written regarding this signoff task. View the comments by clicking the linked entry. The All Comments dialog box appears. Any comments that have been written by yourself and other users are displayed within the text box.

7. View attachments to the workflow process by clicking the Attachments link.
   
   The Attachments dialog box appears. Target and reference attachments are listed below the signoff task in the task tree.
8. If the **Instructions** entry appears, instructions have been written for this signoff task. View the instructions by clicking the linked entry.

   The **Instructions** box appears. All task instructions are displayed within the text box.

9. (Optional) If you do not want to perform this signoff, delegate the signoff task to a different user.

   a. Click on your user name in the **User-Group/Role** column.

      The **Delegate Signoff** dialog box appears.

   b. The **Organization** and **Project Teams** tabs display the available groups, roles, and users to which you can delegate your signoff responsibility.

   c. Select the desired group, role, or user and click **OK**.

      Your signoff responsibility is delegated to the selected user and the dialog box closes. The **perform-signoffs** task is removed from your worklist, and sent to the worklist of the selected user.

   **Note**  Signoff responsibility can also be delegated by the responsible party, or a member of the **System Administration** group.

10. Perform any signoff assigned to you. You can perform any entry in the **Decision** column that is linked. Typically, you are only listed once. However, it is possible that you hold multiple entries within the signoff team, for various groups or roles.

   a. Click a linked entry in the **Decision** column. By default, all entries begin as **Not Acknowledged**.

      The **Signoff Decision** dialog box appears.

   b. Select either **Acknowledged** or **Not Acknowledged** from the **Decision** section of the dialog box.

   c. Type any comments regarding your in the **Comments** box. It is particularly useful to include comments when you reject a signoff.

   d. Click **OK**.

      The signoff decision is recorded and the dialog box closes.
Chapter 2  Using workflows processes to accomplish tasks

Note You must be a member of the group/role required by the signoff task to perform a signoff. Whether you must also be currently logged on to that role, or may be logged on under another group/role is determined by the SIGNOFF_required_group_and_role preference. If this preference is changed from its default setting, you must be a registered member of the signoff’s required group and role, and you must be currently logged on as a member of that group and role to perform the signoff. If this situation exists at your site, and if you are logged on under another group/role, a Change User Setting notification appears:

Your current group/role does not match the required group/role --signoff group/signoff role Do you want to change your current user setting to --signoff group/signoff role?

signoff group/signoff role is the required group and role for the signoff task. Click Yes to automatically change your user settings to the required group/role.

11. If user authentication is implemented for this signoff task, a password box appears in the Signoff Decision dialog box and your logon password is required to perform the signoff. If this situation exists at your site, type your logon password in the Password box. This box appears only if user authentication is required for the completion of this task. This functionality is determined by the creator of the process template. It is implemented by attaching the EPM-require-authentication handler to the signoff task.

12. Complete the signoff of this task by performing one of the following steps:

- Click OK to save the changes to the database and close the Signoff Decision dialog box.

- Click Cancel at any time to cancel the workflow process and exit the Signoff Decision dialog box.

13. Click Close after you finish working with all the signoff information. The Perform Signoff dialog box closes.

Sign off a Review task in Workflow Viewer

Information most pertinent to a signoff task is displayed in the Perform Signoff dialog box. The process name, task name, and task state are listed at the top of the dialog box. View any comments and instructions by clicking the respective links. Additional task information, such as task attributes, is displayed in other dialog boxes.

Click any linked entry to display its related dialog box. For example, click a linked entry in the Decision column to display the Signoff Decision dialog box and make your signoff decision.

Tool tips are available for each column in the dialog box. Activate the tool tips by moving your cursor over the head of each column.

1. Select the signoff task to be completed, either in the task hierarchy tree or the process flow pane.
2. (Optional) If you know you have additional tasks to perform before you can perform the perform-signoffs task, you can create a subprocess from this task. The subprocess must complete before the perform-signoffs task can complete.
   For more information about creating a subprocess, see Creating subprocesses from a workflow template.

3. Click Perform Task on the toolbar.
   The Perform Signoff dialog box appears. The process name and task state appear at the top of the dialog box.

4. Review the contents of the Process Description box. If necessary, type additional information into the box.

5. If the Responsible Party entry contains a link, you can reassign the responsible party for this signoff task.
   a. Click the linked user name next to the Responsible Party entry.
      The Assign Responsible Party dialog box appears.
   b. The Organization and Project Teams tabs display the available groups, roles, and users to which you can reassign the role of responsible party.
   c. Select the desired group, role, or user and click OK.
      The task is reassigned to the selected responsible party and the dialog box closes.

6. If the All Comments entry is linked, comments have been written regarding this signoff task. View the comments by clicking the linked entry.
   The All Comments dialog box appears. Any comments that have yet been written by yourself and other users are displayed within the text box.

7. View attachments to the workflow process by clicking the Attachments link.
   The Attachments dialog box appears. Target and reference attachments are listed below the signoff task in the Task tree.

8. If the Instructions entry appears, instructions have been written for this signoff task. View the instructions by clicking the linked entry.
   The Instructions box appears. All task instructions are displayed within the text box.

9. (Optional) If you do not want to perform this signoff, delegate the signoff task to a different user.
   a. Click on your user name in the User-Group/Role column.
      The Delegate Signoff dialog box appears.
   b. The Organization and Project Teams tabs display the available groups, roles, and users to which you can delegate your signoff responsibility.
   c. Select the desired group, role, or user and click OK.
Chapter 2  Using workflows processes to accomplish tasks

Your signoff responsibility is delegated to the selected user and the dialog box closes. The perform-signoffs task is removed from your worklist, and sent to the worklist of the selected user.

**Note**  Signoff responsibility can also be delegated by the responsible party, or a member of the System Administration group.

10. Perform any signoff assigned to you. You can perform any entry in the Decision column that is linked. Typically, you are only listed once. However, it is possible that you hold multiple entries within the signoff team, for various groups or roles.

   a. Click a linked entry in the Decision column. By default, all entries begin as **No Decision**.

      The Signoff Decision dialog box appears.

   b. Select either **Approve**, **Reject**, or **No Decision** from the Decision section of the dialog box.

      • Choosing **Approve** performs a signoff of the task. The link in the Decision column changes to green and reads **Approve**.

      • Choosing **Reject** performs a signoff of the task. Your decision does not count towards the quorum approval count required to complete the task. If the quorum requires all signoffs to approve, your rejection stops the workflow process. The link in the Decision column changes to red and reads **Reject**.

      • Choosing **No Decision** allows you to abstain from the signoff of the task. **No Decision** is the default setting for this dialog box. Your decision does not count towards the approval of the task. The link in the Decision column changes to blue and reads **No Decision**.

   c. Type any comments regarding your decision in the Comments box. It is particularly useful to include comments when you reject a signoff.

      If you want, you can also add a comment, but leave the decision set to **No Decision**.

   d. Click OK.

      The signoff decision is recorded and the dialog box closes.
Using workflows processes to accomplish tasks

Note You must be a member of the group/role required by the signoff task to perform a signoff. Whether you must also be currently logged on to that role, or may be logged on under another group/role is determined by the SIGNOFF_required_group_and_role preference. If this preference is changed from its default setting, you must be a registered member of the signoff’s required group and role, and you must be currently logged on as a member of that group and role to perform the signoff. If this situation exists at your site, and if you are logged on under another group/role, a Change User Setting notification appears:

Your current group/role does not match the required group/role -- signoff group/signoff role
Do you want to change your current user setting to -- signoff group/signoff role?

signoff group/signoff role is the required group and role for the signoff task. Click Yes to automatically change your user settings to the required group/role.

11. If user authentication is implemented for this signoff task, a password box appears in the Signoff Decision dialog box and your password is required to perform the signoff. If this situation exists at your site, type your password in the Password box. This box appears only if user authentication is required for the completion of this task. This functionality is determined by the creator of the process template. It is implemented by attaching the EPM-require-authentication handler to the signoff task.

12. Complete the signoff of this task:
- Click OK to save the changes to the database and close the Signoff Decision dialog box.
- Click Cancel at any time to cancel the workflow process and exit the Signoff Decision dialog box.

13. Click Close when you have finished working with all the signoff information.

The Perform Signoff dialog box closes.

Performing tasks assigned to you

Determining task status

Each task within a workflow process is either Pending, Started, or Completed. The task’s status displays in the upper-left corner of the task.
### Symbol Example

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Example</th>
<th>Status</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="symbol1.png" alt="Symbol" /></td>
<td><a href="#">perform-signoffs</a></td>
<td><strong>Pending</strong></td>
<td>The task has not yet started. A task cannot start until the previous task completes. The gray background of the task and the symbol at the top-left corner of the task indicate that the status of this task is <strong>Pending</strong>.</td>
</tr>
<tr>
<td><img src="symbol2.png" alt="Symbol" /></td>
<td><a href="#">select-signoff-team</a></td>
<td><strong>Started</strong></td>
<td>The task is now active and action can be taken upon the task. The yellow background of the task and the symbol at the top-left corner of the task indicate that the status of this task is <strong>Started</strong>.</td>
</tr>
<tr>
<td><img src="symbol3.png" alt="Symbol" /></td>
<td><a href="#">Review Timesheet</a></td>
<td><strong>Completed</strong></td>
<td>The actions required for the task are performed. A <strong>Completed</strong> state for a <strong>Review</strong> task means that all signoffs have been performed and the number of approvals are equal to that specified in the quorum for the task. The green background of the task and the symbol at the top-left corner of the task indicate that the status of this task is <strong>Completed</strong>.</td>
</tr>
<tr>
<td><img src="symbol4.png" alt="Symbol" /></td>
<td><a href="#">Start design</a></td>
<td><strong>Skipped</strong></td>
<td>The actions required for the task are not performed, but the workflow continues on as if the task is successfully performed. Only privileged users can use the <strong>Actions→Promote</strong> command to skip a task. If this is a <strong>Review</strong> task, all signoff subtasks show the <strong>No Decision</strong> image, indicating the release task was skipped, rather than completed. The green background of the task and the symbol at the top-left corner of the task indicate that the status of this task is <strong>Skipped</strong>.</td>
</tr>
</tbody>
</table>

---

**Note** If you see the symbol instead, the task is processing in the background.
Symbol Example  |  Status  |  Definition
--- | --- | ---
Failed | The actions required for the task are not performed, or have failed. A task’s state is set to Failed if the task is configured with a failure path and if the failure conditions are met. 
   | Note | The Failed state does not appear on the Actions menu, because it can only be triggered internally.
   |  | The red background of the task and the symbol at the top-left corner of the task indicate that the status of this task is Failed.
   | Note | A completed state for a perform-signoff task means that all signoffs have been performed, and the number of approvals are equal to the required number specified in the quorum for the task.
   | If the Wait For Undecided Reviewers check box is selected, the task completes when the last reviewer approves or rejects the task. If the check box is not selected, the task completes as soon as the quorum is satisfied.
A task can have the following statuses as well.

| Task state  | Description |
--- | ---
Suspended | The task has been suspended. If this is a Review task, all signoff tasks are removed from the Worklist. |
Unassigned | The signoff team for a Review task is not yet assigned. |
Aborted | The task is canceled and the workflow process is exited without being completed. |

Performing interactive tasks

You can use workflow to complete assigned interactive tasks. For example, you can review and approve a change to a product or process.

- You use your My Worklist inbox to complete tasks assigned to you, including those originating at a remote site, and you can use and manage address lists and resource pools. For example, you can perform a select-signoff-team task.

- You can also complete tasks using the Workflow Viewer. For more information about performing workflow tasks in the Workflow Viewer, see the Workflow Viewer Guide.

Interactive tasks are displayed in your Tasks to Perform folder.
Chapter 2  Using workflows processes to accomplish tasks

Performing manual condition tasks

To perform a manual Condition task, you can follow the directions in the Instructions box. The instructions pose a question or define a set of parameters that can be set to True, False, or Unset. If the task is Unset, it cannot be completed and the workflow process cannot proceed.

- If a condition task fails, a log file and corresponding dataset are added to the process as a reference attachment in the Tasks Attachments References folder.

Complete a Do task using My Teamcenter

1. Click the Do task in your Tasks to Perform folder.

2. (Optional.) If you know you have additional tasks to perform before you can perform the current task, you can create a subprocess from this task. The subprocess must complete before the current task can complete.

   For more information about creating a subprocess, see Creating subprocesses from a workflow template.

3. Click the Viewer tab and select the Task View option.

4. Complete the task according to the instructions in the Instructions box.

5. Type your password in the Password box.

   The system displays this box if user authentication is required for the completion of the task.

   Note  If your site employs Security Services, you must use the Security Services password rather than your Teamcenter password.

6. Select the Complete check box.

   Note  An Unable to Complete check box is displayed when a failure path is defined for the Do task. Select the Complete check box to proceed on the success path to the next task or select the Unable to Complete check box to proceed on the failure path.

7. Click Apply.

The task is complete and the Viewer tab now displays No View Data Available.
You can complete Condition tasks that are in a pending state. However, this prevents the task from appearing in the assigned user's Inbox.

Performing an automatic Condition task while it is pending preempts the query results, allowing you to override the query and manually set the task to True or False.

If you perform a Condition task while it is still in a pending state, you can return to the task and reset the True/False/Unset setting at any point before the task reaches a started state.

**Note** Condition tasks can be configured to proceed automatically during the workflow process. Such tasks display milestones in the workflow process but have no associated user actions.

### Complete a started manual Condition task using My Teamcenter

1. Select the Condition task in your Tasks to Perform folder.
2. (Optional) If you know you have additional tasks to perform before you can perform the current task, you can create a subprocess from this task. The subprocess must complete before the current task can complete.
   
   For more information about creating a subprocess, see [Creating subprocesses from a workflow template](#).

3. Click the Viewer tab and select the Task View option.

4. Complete the task according to the instructions in the Task Instructions box.

5. Set the Task Result to True or False, based on the requirements listed in the Instructions box. This setting determines whether the workflow process continues along the true or false branch from the Condition task.

   Setting the condition path to Unset prevents the task from completing and pauses the workflow process.

   **Note** An Unable to Complete check box is displayed when a failure path is defined for the Condition task. Select the Unable to Complete check box to proceed to the failure path.

6. Type your password in the Password box.

   The Password box is displayed if user authentication is required to complete the task.

   **Note** If your site employs Security Services, you must use the Security Services password rather than your Teamcenter password.

7. Click Apply to complete the task.

   The task is complete and the Viewer tab now displays No View Data Available.

### Complete a Customized task using My Teamcenter

1. Select the Task task in your Tasks to Perform folder.
Chapter 2  Using workflows processes to accomplish tasks

Note  Customized tasks generally involve custom forms that are unique to your company’s processes. Incorporating company forms into a customized task further automates the workflow process.

2. Click the **Viewer** tab and select the **Task View** option.

Note  The selected custom task varies depending on the form and other tasks in the process.

3. Complete the steps listed in the dialog box, following instructions provided by the system administrator.

   Click the button provided to complete the task and close the dialog box.

The task is complete and the **Viewer** tab now displays **No View Data Available**.

Perform a Route task using My Teamcenter

Note  A **Route** task is the electronic equivalent of a routing sheet; the task is used to assign different responsibilities for the same task to multiple users. After you complete a **Route** task, the users are notified of their tasks using Teamcenter mail.

1. Assign review, acknowledgement, or notification task responsibility to one or more users by performing the following steps:

   a. Select the **Route** task in your **Tasks to Perform** folder.

   b. Click the **Viewer** tab, and then choose the **Task View** option at the top of the **Viewer** pane.

   c. Click **Users** to display the **Group**, **Role**, and **User** lists.

   d. Select a group, role, and user to whom the task will be assigned.

   e. Select an action from the list: **Review**, **Acknow**, or **Notify**.

   f. Click **Add**.

      The system displays the user information and action assigned to that user beneath the task node in the process tree.

   g. Click **Modify** to change the group, role, or user definition for a particular user or to modify the user action.

   h. Click **Delete** to delete a particular user.

2. Display the members of an entire address list and assign individual review, acknowledge, and notify responsibilities:

   a. Select the route task in your **Tasks to Perform** folder.

   b. Click the **Viewer** tab, and select the **Task View** option at the top of the **Viewer** pane.
Using workflows processes to accomplish tasks

c. Select the **Address Lists** option to display the **Address Lists** list.

d. Select an address list.
   The system displays the members of the address list.

e. Select an action from the list.
   The **Review**, **Acknowledge**, and **Notify** actions are displayed.

f. Click **Add**.
   The system displays the address list in the **Signoff Team** tree.

g. Repeat the previous steps to assign task responsibilities to members of additional address lists.

3. (Optional) Modify or set the quorum value for **Review** and **Acknowledge** tasks in the **Rev Quorum** and **Acknow Quorum** boxes.

4. Select the **Ad-hoc done** check box to indicate you have completed the task assignments.

5. Click **Apply**.

The task is complete and the **Viewer** tab now displays **No View Data Available**.

**Performing tasks in Workflow Viewer**

You can perform any interactive task from Workflow Viewer that is assigned to you and currently active. In other words, any task you can perform from **My Worklist** you can perform from Workflow Viewer.

Your **My Worklist** view is streamlined to display only tasks that are ready to be performed. Because Workflow Viewer displays the entire workflow process, selecting tasks to perform requires a basic understanding of the different task statuses in a workflow process.

**Example**

The following workflow process indicates that the **Change Admin I** task is complete ☑. You can no longer perform this task. The **Author Technical Recommendation task** has started 📘 and can be performed.
The **Author Technical Recommendation** task is a **Review** task. **Review** tasks are container tasks; they always contains two subtasks, a **select-signoff-team** subtask and a **perform-signoffs** subtask.

You must expand the **Review** task to view the status of the two subtasks and determine which subtask is ready to be performed. You can expand container tasks from either the task tree or by double-clicking the task within the process flow pane.

### Expansion method

<table>
<thead>
<tr>
<th>Container task</th>
<th>Container task expanded</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task tree</td>
<td></td>
</tr>
<tr>
<td>Process flow pane</td>
<td></td>
</tr>
</tbody>
</table>

Using either method to expand the **Author Technical Recommendation** task reveals that the **select-signoff-team** task is started and can be performed, and that the **perform-signoffs** task is pending and cannot yet be performed.

For more information about task status, see *Determining task status.*
Perform a Do task in Workflow Viewer

To perform a Do task, follow the instructions in the Instructions box. Select Done when the task criteria is met. To complete a Do task that has reached a Started state, perform the following steps:

1. Click the Do Task to be completed, either in the task hierarchy tree or the process flow pane.

2. (Optional) If you know you have additional tasks to perform before you can perform the Do task, you can create a subprocess from this task. The subprocess must complete before the Do task can complete.
   
   For more information about creating a subprocess, see Creating subprocesses from a workflow template.

3. Click Perform Task on the toolbar.
   
   The Perform Do Task dialog box appears.

4. Review the task instructions listed in the Instructions box.

5. (Optional) Review any contents in the Process Description box. If necessary, type additional information into the box.

6. Complete the task instructions.

7. (Optional) In the dialog box, type any comments regarding the task in the Comments box.

8. Select Complete.
   
   If the task is configured with a failure path, you can also select Unable To Complete.

9. Type your user password in the Password box.
   
   This box appears only if user authentication is required for the completion of this task. This authorization is determined by the creator of the process template.

10. Click OK to save the changes to the database and close the dialog box.

11. Click Cancel at any time to cancel the operation without making changes to the database.

Perform a Condition task manually in Workflow Viewer

To perform a Condition task, follow the instructions in the Instructions box. The instructions should pose a question or define a set of parameters that can be answered. Unset is the initial value of the task, which must be changed. The task cannot complete or the workflow process continue, while the task remains set at Unset. If the Condition task is configured with custom paths (paths that are set with result values other than true and false), the available options will reflect these custom results. The Unable To Complete option displays on Perform Condition Task dialog box, if the Condition task is configured with a failure path.
Note  An automatic **Condition** task is configured to proceed during the workflow process. It acts as a visual milestone in the workflow process. There is no action for a user to perform and no dialog box associated with the automatic **Condition** task.

1. Select the **Condition** task to be completed, either in the task hierarchy tree or the process flow pane.

2. (Optional) If you know you have additional tasks to perform before you can perform the **Condition** task, you can create a subprocess from this task. The subprocess must complete before the **Condition** task can complete.

   For more information about creating a subprocess, see *Creating subprocesses from a workflow template*.

3. Click **Perform Task** on the toolbar.

   The **Perform Condition Task** dialog box displays.

4. Complete the task instructions listed in the **Instructions** box.

5. (Optional) Review any contents in the **Process Description** box. If necessary, type additional information into the box.

6. Set **Task Result** to **true** or **false**, based on the requirements listed in the **Instructions** box. If the **Condition** task is configured with custom paths (paths that are set with result values other than **true** and **false**), the available options reflect these custom results. This setting determines whether the workflow process continues along the true or false flow line branching off the **Condition** task.

   Setting the condition path to **unset** prevents the task from completing and pauses the workflow process.

7. Select **Complete**.

   If the task is configured with a failure path, you can also select **Unable To Complete**.

8. Type your user password in the **Password** text box. This text box appears only if user authentication is required for the completion of this task. This authorization is determined by the creator of the process template.

9. Click **OK** to save the changes and close the dialog box.

10. Click **Cancel** at any time to cancel the operation without making changes.
Using workflows processes to accomplish tasks

Note You can set a Condition task result while it is still in a Pending state.

- Performing a manual Condition task while it is pending prevents the task from appearing in the assigned user's worklist.

- Performing an automatic Condition task while it is pending preempts the query results, allowing you to override the confines of the query and manually set the task to true or false.

If you perform a Condition task while it is still in a Pending state, you can return to the task and reset the true/false/unset setting at anytime until the task reaches a Started state.

Perform a Route task in Workflow Viewer

A Route task is the electronic equivalent of a routing sheet; the task is used to assign different responsibilities for the same task to multiple users. After you complete a Route task, the users are notified of their tasks by Teamcenter mail.

1. Select the Route task, either in the task hierarchy tree or the process flow pane.

2. (Optional) If you know you have additional tasks to perform before you can perform the Condition task, you can create a subprocess from this task. The subprocess must complete before the Condition task can complete.

   For more information about creating a subprocess, see Creating subprocesses from a workflow template.

3. Click Perform Task on the toolbar.

   The Select Signoff Team dialog box appears.

4. Click Users in the Signoff Team tree.

   The right pane displays the Organization pane.

   a. Search or select a user from the Organization or Project Teams tree. You can assign a resource pool to the task in the Resource Pool Options.

      For more information about using and defining resource pools, see the My Teamcenter Guide.

   b. Select a group, role, or user to whom the task will be assigned.

   c. Select either Review, Acknowledge, or Notify from the Action list.

   d. Click Add.

      Teamcenter displays the user information and action assigned to that user beneath the task node in the process tree.

   e. Repeat the previous steps to add additional users and task responsibilities.

5. If you want to use address lists to add other users, click Address Lists in the Signoff Team tree.

   The right pane displays the Address Lists pane.
Chapter 2  Using workflows processes to accomplish tasks

a. Select a list from the Address Lists list.

b. Select either Review, Acknowledge, or Notify from the Action list.

c. Click Add.

Teamcenter displays the address list information and action assigned to that address list beneath the task node in the process tree.

d. Repeat the previous steps to add address lists.

6. Optionally, modify or set the approval quorum value for the Review and Acknowledge tasks in the Review Quorum and Acknowledge Quorum boxes.

7. If you want the workflow process to wait for all reviewers before continuing, select the Wait for Undecided Reviewers check box.

8. Select the Ad-hoc done check box to indicate you have completed adding signoff team member assignments to this task.

9. Click OK.

Perform a Custom task in Workflow Viewer

To perform a Custom task, complete the form or instructions provided. Custom tasks usually involve custom forms that are unique to your company's processes. Incorporating company forms into a custom task further automates the workflow process.

1. Select the Custom task in either in the task hierarchy tree or the process flow pane.

   In the process flow pane, the custom task's subtasks appears.

2. Click Perform Task on the toolbar.

   The Perform dialog box for the selected custom task appears.

   Note  The Perform dialog box for the selected custom task varies depending on the form and/or other tasks the system administrator attaches to the selected task.

3. Complete the steps listed in the dialog box.

4. Select Complete.

   If the task is configured with a failure path, you can also select Unable To Complete.

5. Click Close or OK.

   Note  If the form attached to the Custom task is a simple form, the task may not automatically move to the Complete state when you click the Finish/Close button.
Alterning started workflow processes

Overriding task actions

As you work through a workflow process in Workflow Viewer, a task’s actions work behind the scenes, transitioning the task from one state to another according to the actions defined in the task. You can override the task’s defined actions, if necessary.

For example, the Start action is always used to transition a task from the Pending state to the Started state.

For a more detailed explanation of actions, see the Workflow Viewer Guide.

All tasks are transitioned by one or more of the following defined actions:

- Abort
- Assign
- Complete
- Perform
- Resume
- Skip
- Start
- Suspend
- Undo
- Failed

**Note** The Failed state does not appear on the Actions menu, because it can only be triggered internally.

When a task’s template is created in Workflow Designer, one or more actions become part of the task’s definition. As you work through a workflow process in Workflow Viewer, a task’s actions work behind the scenes, transitioning the task from one state to another according to the actions defined in the task.

If a task is designated to process in the background, all actions except Perfrom and Assign are processed in the background. The Perform and Assign action execute in the foreground.

However, there are some situations where it is necessary to override the task’s defined actions. For example, if a task is demoted, the workflow process moves backward to the preceding task. If the preceding task has an EPM-demote handler, it is automatically initiated. But if the preceding task does not have an EPM-demote handler, the task must be initiated manually. Thus, the responsible party or a privileged user must manually override the preceding task’s defined action and change the task state to Start.

Perform action

Several of these actions are used to place the task in a special state such as Suspended or Skipped. Not all tasks use all actions. The following figure shows the EPM task actions and corresponding states.
Task actions and states

In addition to task transition, from one state to another, actions are also used to implement rules. This is done by attaching one or more handlers to an action. There is one action, **Perform**, that does not transition a task to another state. The **Perform** action executes any handlers attached to it and displays an interactive panel.

All tasks require resources to perform actions. Resources are one of the following object types:

- Groups
- Roles
- Users
Altering started workflow processes using My Teamcenter

Skip a task in a process and start the next one

The **Promote** menu command moves the task to a **Skipped** state and starts the successor tasks in the workflow process.

**Note**  
To perform this action, you must be a privileged user.

1. Select the task you want to promote.

2. Choose `Actions→Promote`.  
The **Promote Action Comments** dialog box appears.

3. Enter your comments into the dialog box.

4. If the task is a **Review** or **Route** task and it has a reject path, click either the **Approve** or **Reject** decision to determine the path you want the workflow process to follow.  
This helps you to expedite the review process where you want to move the workflow process along despite rejections.

5. Click **OK**.

The selected task moves to the **Skipped** state and the next task in the process is started. The comments you entered are listed in the audit file.

**Note**  
If a task is designated to process in the background, the move to the **Skipped** state may be delayed.

Demote a process by putting a task in the Pending state

**Note**  
In My Teamcenter, the `Actions→Undo` command displays the **Demote Action Comments** dialog box and lets you change the state of a selected task to **Pending** from a **Started**, **Completed**, or **Skipped** state.

In Workflow Viewer, the `Actions→Demote` command displays the **Demote Action Comments** dialog box and lets you change the state of a task.

For more information about using Workflow Viewer to manage workflow processes, see the **Workflow Viewer Guide**.

1. In My Teamcenter, select the task you want to demote.

   When you demote a task, you change the state to **Pending** from a **Started**, **Completed**, or **Skipped** state.

   **Note**  
   - You must be a privileged user to demote a task.
   - Demoting a **Review** task voids any signoff decisions that have been made.

2. Choose `Actions→Undo`.  
The system displays the **Demote Action Comments** dialog box.
3. Type your comments in the box. These comments appear in the audit file.

4. Click OK to change the task state to Pending.
   
   The workflow returns to the previous task.
   
   **Note** If a task is designated to process in the background, the move to the Pending state might be delayed.

### Start a paused task

1. Select the task that is paused.
   
   **Note** Paused tasks can result when a subsequent task in a process is demoted and the previous task does not automatically start. You must be a responsible party or privileged user to reset a paused task to the started state.

2. Choose Actions→Start.
   
   The system displays the Start Action Comments dialog box.

3. Type your comments in the box. These comments appear in the audit file.

4. Click OK to move the task to a started state.
   
   **Note** If a task is designated to process in the background, the move to the Start state might be delayed.

### Suspend a task

1. Select the task you want to suspend.
   
   **Note** Suspended tasks stop a process from moving forward.

2. Choose Actions→Suspend.
   
   The system displays the Suspend Action Comments dialog box.

3. Type your comments in the box. These comments appear in the audit file.

4. Click OK to move the task to a suspended state.
   
   **Note** If a task is designated to process in the background, the move to the Suspend state might be delayed.

### Resume a task

1. Select the desired suspended task.
   
   **Note** Resuming a suspended task restores it to the state it was in prior to being suspended.

2. Choose Actions→Resume.
   
   The system displays the Resume Action Comments dialog box.
3. Type your comments in the box.

4. Click OK to move the task to the state that it was in prior to being suspended.

   Note: If a task is designated to process in the background, the move to the prior state might be delayed.

**Altering started workflow processes using Workflow Viewer**

**Skip a task in a process and start the next one**

The Promote menu command moves the task to a Skipped state and starts the successor tasks in the workflow process.

Note: To perform this action, you must be a privileged user.

1. Select the task you want to promote.

2. Choose Actions→Promote.

   The Promote Action Comments dialog box appears.

3. Enter your comments into the dialog box.

4. If the task is a Review or Route task and it has a reject path, click either the Approve or Reject decision to determine the path you want the workflow process to follow.

   This helps you to expedite the review process where you want to move the workflow process along despite rejections.

5. Click OK.

The selected task moves to the Skipped state and the next task in the process is started. The comments you entered are listed in the audit file.

Note: If a task is designated to process in the background, the move to the Skipped state may be delayed.

**Demote a task**

The Demote menu command is the method of moving an active workflow process back to some predefined release level. Performing a demote action upon a task changes the task's state from Started to Pending. The specific demote behavior of any given task is configured within the original process template. For subtasks to also demote when a parent task is demoted, the EPM-demote handler must be applied to the task's Undo action when the process template is configured. Demoting a Review task removes any signoff decisions previously made by members of the task's signoff team, but any comments are kept.

Note: To perform this action, you must be a privileged user.

1. Select the task you want to demote.

2. Choose Actions→Demote.
Chapter 2  

Using workflows processes to accomplish tasks

The **Demote Action Comments** dialog box appears.

3. Type your comments into the dialog box.
   The comments are listed in the audit file.

4. Click **OK**.
   The selected task moves to the designated state.

   **Note**  
   If a task is designated to process in the background, the move to the designated state might be delayed.

**Suspend a task**

1. Select the task you want to suspend.
   
   **Note**  
   You must be the responsible party or a privileged user to suspend a task.

2. Choose **Actions→Suspend**.
   
   The **Suspend Action Comments** dialog box appears.

3. Type your comments into the dialog box. The comments are listed in the audit file.

4. Click **OK**.
   
   The selected task moves to the **Suspend** state, and a red light button appears in the upper left corner.

   **Note**  
   If a task is designated to process in the background, the move to the **Suspend** state might be delayed.

**Resume a task**

1. Select the desired suspended task.
   
   **Note**  
   The only valid action for a suspended task is **Resume**. You must be the responsible party or a privileged user to resume a task.

2. Choose **Actions→Resume**.
   
   The **Resume Action Comments** dialog box appears.

3. Type your comments into the dialog box. The comments are listed in the audit file.

4. Click **OK**.
   
   The selected task moves to the state it was in prior to the **Suspend** action.

   **Note**  
   If a task is designated to process in the background, the move to the prior state might be delayed.
Using workflows processes to accomplish tasks

Starting a paused task

In rare cases, tasks become stalled and must be initiated manually.

To reset the tasks to Start, the responsible party or a privileged user with bypass ability can instruct the tasks to move to a new state by performing a Start action on the task.

**Note**
- To perform this action, you must be the responsible party or a privileged user.
- If a task is designated to process in the background, the move to the Complete state might be delayed.

Reset a paused task

1. Click the task that has stalled.
2. Choose Actions→Start.
   
   The Start Action Comments dialog box appears.
3. Enter your comments into the dialog box. The comments are listed in the audit file.
4. Click OK.
   
   The selected task moves to the Start state and the button of a green light appears in the upper left corner.

**Note** If a task is designated to process in the background, the move to the Start state might be delayed.

Working with remote tasks

Using remote inboxes

*Remote inboxes* are created when you subscribe to your account inbox at a remote site. This action creates a link in your local site worklist. When you click the link, a new Teamcenter client session is started that runs against the remote site. You can then see and perform tasks in your worklist on the remote site. There is an associated Remote Checkout command that lets you place data on your local site for work.

To enable remote inbox functionality, your site must be configured to use the application registry and interoperability linking. Information about configuring this functionality is currently available on the Global Technical Access Center (GTAC) Web site. Teamcenter administrators with valid WebKey accounts can access the Teamcenter Interoperability guide at the following location:


See the following topic areas in the Teamcenter Interoperability guide.

- In chapter 1, *Introduction*, see Understanding Components Required for Interoperability, Using Application Registry.
Chapter 2 Using workflows processes to accomplish tasks

- Chapter 2, Installing Application Registry.
- In chapter 3, Configuring for Basic Linking, see Linking Teamcenter Engineering To Remote Engineering.
- In chapter 4, Configuring Advanced Linking, see the following topics:
  o Understanding Teamcenter for engineering process management
  o Advanced Linking Terms
  o System Requirements
  o Configuration Overview
  o Deploying Teamcenter Application Registry
  o Configuring Teamcenter for engineering process management
  o Setting and Verifying Advanced Linking Properties
- Chapter 6, Troubleshooting.

Remote inboxes let you interact with workflow tasks that originated at remote sites.

- When you have a user account at a remote site, you can subscribe to that site to access your inbox, called your remote inbox, and access tasks assigned to you at the remote site.

- After you subscribe to your inbox at a remote site, your local site worklist displays a remote site link you can use to launch a client to let you access the remote site inbox.

  Note The remote site link also shows the number of tasks in your worklist at the remote site.

- Remote site links in the local site worklist cannot be expanded in the local tree display.

- When you click the link to the remote site, Teamcenter launches a full, separate Teamcenter session to display the remote inbox.
Using workflows processes to accomplish tasks

Note The remote site link launches the client specified by the TC_external_default_launch_ui setting.

- thin
  Displays the remote site in the thin client.
  This is the default setting.

- rich
  Displays the remote site in the rich client.

- dynamic
  Displays the remote site in the same type of client used to access the link to the remote site.

- Remote inboxes contain Tasks to Perform and Tasks to Track folders.

Working with task data in remote inboxes

You can use Remote Checkout and Remote Export commands to access to data for tasks in your remote inboxes.

- Remote Checkout lets you access modifiable replicas of the target data associated with the tasks assigned to you.
  
  - When a workflow task requires you to modify data located at a remote site, use Remote Checkout to check out and send an editable copy of the data to your local Home location.
    This checks out the data at the remote site and puts the data on the local site in the checked-out state.

  - When you have completed the data modification, use the standard Check-In option at the local site to undo the checkout at the remote site, move the modified data to the remote site.
    This checks in the data at the remote site.

- Remote Export lets you access read-only replicas of data. If necessary, you can also use this command to transfer site ownership of the data required to perform your tasks.

Subscribe to a remote inbox

1. Choose Tools→Remote Inbox Subscription.
   The system displays the Remote Inbox Subscription Dialog dialog box.

   - Sites with remote inboxes to which you are already subscribed are listed as Selected Inboxes.

   - Sites with remote inboxes to which you are not already subscribed are listed as Available Inboxes.
Chapter 2  Using workflows processes to accomplish tasks

2. To subscribe to an available inboxes, select the site in the Available Inboxes list and click Add(+).

   To unsubscribe from any of your subscribed inboxes, select the relevant inboxes in the Selected Inboxes list and click Remove (−).

3. When the subscriptions are listed correctly, click OK or Apply, and the system displays the Subscribe Remote Inbox dialog box. This dialog box shows the progress of each subscription request.

Check out data to your local site from a remote site

1. Start a client that accesses a remote site.

   Note When you subscribe to a remote inbox, your worklist displays a link that lets you launch a client that accesses the remote site.

2. Select the object to check out from the remote site, and choose Tools→Multi-Site Collaboration→Send→Remote Checkout.

   The system displays the Remote Checkout dialog box.

3. Type the following information in the dialog box:

   • Change ID
     Type the change number associated with the checkout request.

   • Comments
     Type the reason for the checkout request.

   • Target Site
     From the list of available sites, choose the site to which the object should be sent.

     Click Home on the right side of the Target Site box to choose sites from the list.

   • OK to remote checkout?
     Displays the status of objects being remotely checked out.

4. Click Yes.

   The system displays the current options in the Remote Checkout Options Settings dialog box.

5. Click Yes to continue or No to cancel the checkout operation.

   The system displays the status of the checkout operation. The checked-out data goes to your home folder on the target site.

Export data to your local site from a remote site

1. Start a client that accesses a remote site.
When you subscribe to a remote inbox, your worklist displays a link that lets you launch a client that accesses the remote site.

2. In the remote site client, select the object to export as a read-only replica.

3. Choose **Tools→Multi-Site Collaboration→Send→Remote Export**. The system displays the **Remote Export** dialog box.

4. Enter the following information in the dialog box:
   - **Reason**
     Type the reason for the data export.
   - **Target Sites**
     From the list of available sites, select the site to which the object should be sent.
     Click **Home** to the right of the **Target Site** box to select sites from the list.
   - **OK to remote export?**
     Displays the status of objects being remotely exported.

5. Click **Yes**.
   The system displays the current options in the **Remote Export Options Settings** dialog box.

6. Click **Yes** to continue or **No** to cancel the export operation.
   The system displays the status of the export operation. The exported data goes to your home folder on the target site.

### Stopping a workflow process in Workflow Viewer

There are three ways to stop a workflow process in Workflow Viewer:

- **Suspend**
  Stops the process from moving forward. Choose **Actions→Suspend**. You can resume a suspended process by choosing **Actions→Resume**.

- **Abort**
  Cancels the process, but keeps the process in the system. Choose **Actions→Abort**.

- **Delete**
  Removes the process from the system. Choose **Edit→Delete**.

If you have a subprocess attached to your workflow process, the following rules apply when you delete or abort the parent process or subprocess:

- **Delete or abort the parent process.**
  - If the parent process is the only parent for the subprocess, the subprocess is also deleted or aborted.
Chapter 2  Using workflows processes to accomplish tasks

- If there is more than one parent process for the subprocess, the subprocess is not deleted nor aborted unless it is the last parent process.

- Delete or abort a subprocess—the parent process is kept.

- Delete the task in the parent process that originates the subprocess—the subprocess is not affected.

- If the subprocess has its own subprocess, it follows the rules above.

Delete a workflow process in My Teamcenter

To delete the entire workflow process after it has been initiated, use one of these procedures:

- In My Worklist, select a workflow task for which you are the responsible party, and then click Delete.

- In the Impact Analysis view, select the workflow task, and then click Delete.

  Note  Deleting a task in the workflow, deletes the entire workflow process.

Viewing workflow and schedule progress

Reviewing workflow and schedule progress by viewing the process history

The Process History view displays the Workflow or Schedule Manager process of the business object selected in the Home, My Worklist, or Search Results view in My Teamcenter.

- If there is no audit data for the business object, the view displays a No process history data available for selected object. message.
If the selected object has passed through more than one workflow process, you can choose which process to display from the list to the right of the tab.

In the Process History view, you can review the progress of a workflow or schedule and do the following:

- Determine the progress of an object in a schedule or workflow and who has responsibility for the object.
- Review comments by other workflow participants.
- Verify that the appropriate participants completed the required reviews.
- Debug a workflow that proceeded down an unexpected path.
- Identify workflows that require attention to continue processing.
- Review user activity to verify the appropriate users signed off.

Customize the process history display

1. In the Process History view, click the View Menu button ▼ and then choose Column from the view menu.

   The Column Management dialog box appears.

2. Add or remove columns from the Process History view table.

   - To add a column, select a property from the Available Properties list and click the Add to Displayed Columns button ▶.
   
   - To remove a column, select a property in the Displayed Columns list and click the Remove from Displayed Columns button ◀.

3. (Optional) Click the Move Up ▲ and Move Down ▼ buttons, to the right of the Displayed Columns list, to adjust the order of the displayed columns.

4. Click Apply to apply the configuration to the current view, or click Save to save the configuration for later use.

   **Note** You can use the Apply Column Configuration command on the view menu to:

   - Apply a saved configuration.
   
   - Restore the default configuration. This is the only way to restore columns removed using the right-click Remove this column command.

   You can use the Save Column Configuration command on the view menu to save the current configuration of the table display.

5. Click Close to close the Column Management dialog box.
Process reports

The following audit reports are available when you choose the Tools→Reports→Report Builder Reports menu command in My Teamcenter:

- **Audit - Workflow Attachment Report**
  Displays all attachment object details for the specified workflow process.

- **Audit - Workflow Detailed Report**
  Displays all actions and their statuses for the specified workflow process.

- **Audit - Workflow Signoff Report**
  Displays the signoff results and comments for the specified object in a workflow process.

- **Audit - Workflow Summary Report**
  Displays the start, complete, approve, rejected, release status, demote, promote, fail, and update actions for the specified workflow process.

- **WF - Filtered Audit**
  Displays the start, complete, approve, and rejected actions for the specified workflow process. For more detailed information about this set of actions, including group and role of the performer and assignee information, use Audit - Workflow Summary Report.

- **WF - Items In Process**
  Displays the items currently in a workflow process and where they are in their respective processes.

- **WF - Objects In Process**
  Displays the objects currently in a workflow process and where they are in their respective processes.

- **WF - Signoffs**
  Displays the signoff results and comments for the specified object in a workflow process. For more detailed information, use Audit - Workflow Signoff Report.

- **WF - Unfiltered Audit**
  Displays all actions and their statuses for the specified workflow process. For more detailed information about this set of actions, including group and role of the performer and assignee information, use Audit - Workflow Detailed Report.

Print the process history report

1. Export the audit report to Excel.
   For more information, see Export audit logs or process history to Microsoft Excel.

2. Use Excel’s print function to print the report.
Export audit logs or process history to Microsoft Excel

1. Display the Process History view and choose the rows you want to export.

   OR

   Run a saved query and select the audit logs you want to export from the Details tab.

2. Choose Tools→Export→Objects To Excel.

   Teamcenter displays the Export To Excel dialog box.

3. Under Object Selection, select one of the following:
   • Select Export Selected Objects to export the rows you selected in the view.
   • Select Export All Objects in View to export all rows.

4. Under Output Template, select one of the following:
   • Select Export All Visible Columns to export all the columns in the view.
   • Select Use Excel Template to activate the template list.
     In the list, select the template that specifies the data that you want to export.

5. Under Output, select one of the following:
   • For a standard Excel file that is not connected to Teamcenter, select Static Snapshot.
   • For an interactive live Excel file that is connected to Teamcenter, select Live integration with Excel (Interactive).
   • For a live Excel file that is not connected to Teamcenter, select Live integration with Excel (Bulk Mode).
     You can accumulate changes and later connect the file to Teamcenter.
   • To export the data to an Excel file that also contains import processing information on a separate sheet, select Work Offline and Import.
   • To check out objects while exporting to live Excel, select Check out objects before export.

   [Note] The checkout applies to all objects being exported. Use this option carefully if you are exporting a large number of rows.

6. (Optional) Click Copy URL.
Chapter 2  Using workflows processes to accomplish tasks

- **Copy URL** is unavailable if you select more than one object to export.

- **Copy URL** is unavailable if you select any of the following dialog box options:
  - Work Offline and Import
  - Export All Visible Columns
  - Export All Objects in View

The export file is generated and the URL Generated message is displayed, confirming that the URL is in your Windows Clipboard and showing the URL details.

7. **Click OK** to generate the export Excel file.

Excel opens a temporary file. You can create a permanent file by choosing File→Save As in Excel to display the Save As dialog box.

If you save a live Excel file, you can open it later in My Teamcenter to reconnect it to the database.

- **Note**  Values that you cannot change in Teamcenter are unavailable in the cells of the live Excel file.
Chapter

3 View audit information

Viewing audit information .......................................................... 3-1
View audit logs in the Summary view .......................................... 3-1
Process reports ............................................................................ 3-3
Creating and running audit queries ............................................. 3-3
Export audit logs to Microsoft Excel ............................................. 3-4
View legacy audit log information .............................................. 3-5
### Chapter 3 View audit information

#### Viewing audit information

You can view audit information in the following ways:

- Go to the **Summary** view of the following Teamcenter applications, which shows audit logs in the **Audit logs** tab.
  - **My Teamcenter**
  - **ADA License**
  - **Structure Manager**
  - **Multi-Structure Manager**
  - **Manufacturing Process Planner**
  - **Schedule Manager**
  - **Workflow Viewer**
  - **Organization**

For more information, see *View audit logs in the Summary view*.

- Run predefined audit reports or create new reports, using the Report Builder application.
  
  For more information, see *My Teamcenter Guide*.

- Create custom saved queries, using the Query Builder application.
  
  For more information, see *Creating and running audit queries*.

- Run predefined audit queries, using the Teamcenter advanced search functionality.

#### View audit logs in the Summary view

- The **Summary** view of the following Teamcenter applications shows audit logs in the **Audit logs** tab.
  
  - **My Teamcenter**
  - **ADA License**
Legacy audit information is only accessible from a button in the Audit Logs tab in the Summary view when a legacy audit file is present.

The audit logs are grouped in the Summary view as follows:

<table>
<thead>
<tr>
<th>Log name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow Logs</td>
<td>Displays workflow logs.</td>
</tr>
<tr>
<td>License Change Logs</td>
<td>Displays logs of ADA License changes.</td>
</tr>
<tr>
<td>License Export Logs</td>
<td>Displays ADA License export logs.</td>
</tr>
<tr>
<td>File Access Logs</td>
<td>Displays file access logs.</td>
</tr>
<tr>
<td>Structure Logs</td>
<td>Displays structure logs.</td>
</tr>
<tr>
<td>Organization Logs</td>
<td>Displays organization logs.</td>
</tr>
<tr>
<td>Schedule Logs</td>
<td>Displays schedule logs.</td>
</tr>
<tr>
<td>General Logs</td>
<td>Displays all other general audit logs.</td>
</tr>
</tbody>
</table>

**Note**: Due to performance reasons, PSOccurrence audit logs are not immediately displayed in the Structure Logs table. To view the PSOccurrence audit logs, refresh the table.
Process reports

The following audit reports are available when you choose the Tools→Reports→Report Builder Reports menu command in My Teamcenter:

- **Audit - Workflow Attachment Report**
  Displays all attachment object details for the specified workflow process.

- **Audit - Workflow Detailed Report**
  Displays all actions and their statuses for the specified workflow process.

- **Audit - Workflow Signoff Report**
  Displays the signoff results and comments for the specified object in a workflow process.

- **Audit - Workflow Summary Report**
  Displays the start, complete, approve, rejected, release status, demote, promote, fail, and update actions for the specified workflow process.

- **WF - Filtered Audit**
  Displays the start, complete, approve, and rejected actions for the specified workflow process. For more detailed information about this set of actions, including group and role of the performer and assignee information, use Audit - Workflow Summary Report.

- **WF - Items In Process**
  Displays the items currently in a workflow process and where they are in their respective processes.

- **WF - Objects In Process**
  Displays the objects currently in a workflow process and where they are in their respective processes.

- **WF - Signoffs**
  Displays the signoff results and comments for the specified object in a workflow process. For more detailed information, use Audit - Workflow Signoff Report.

- **WF - Unfiltered Audit**
  Displays all actions and their statuses for the specified workflow process. For more detailed information about this set of actions, including group and role of the performer and assignee information, use Audit - Workflow Detailed Report.

Creating and running audit queries

You can create custom search queries for audit logs, using the Query Builder application. Saved queries identify the search criteria that are used to find information in Teamcenter.

For more information about creating saved queries, see the Query Builder Guide.
For information about running saved queries, see the *Rich Client Interface Guide*.

**Note** Ensure that audit definitions exist for the objects for which you have created saved queries.

Teamcenter provides the following predefined audit queries:

- Audit - File Access Logs
- Audit - General Logs
- Audit - License Change Logs
- Audit - License Export Logs
- Audit - Organization Logs
- Audit - Project Based Logs
- Audit - Schedule Logs
- Audit - Workflow Attachment Logs
- Audit - Workflow Detailed
- Audit - Workflow Signoff
- Audit - Workflow Summary

### Export audit logs to Microsoft Excel

1. Run a saved query and choose the audit logs you want to export from the *Details* tab.

2. Choose **Tools** → **Export** → **Objects To Excel**.
   Teamcenter displays the *Export To Excel* dialog box.

3. Under **Object Selection**, click one of the following:
   - Click **Export Selected Objects** to export the selected rows in the view.
   - Click **Export All Objects in View** to export all rows.

4. Under **Output Template**, select one of the following:
   - Select **Export All Visible Columns** to export all the columns in the view.
   - Select **Use Excel Template** to activate the template list.
     In the list, select the **AUDIT_log_excel_template_new** template.

5. Under **Output**, click **Static Snapshot**

6. Click **OK** to generate the export Excel file.
Microsoft Excel opens a temporary file. You can create a permanent file by choosing File→Save As in Excel to display the Save As dialog box.

If you save a live Excel file, you can open it later in My Teamcenter to reconnect it to the database.

Note Values that you cannot change in Teamcenter are unavailable in the cells of the live Excel file.

The export to Excel option is not available on UNIX clients.

**View legacy audit log information**

Note This data is available only if the TC_audit_manager preference is set to ON and the TC_audit_manager_version preference is set to 2.

1. (Optional) Select an object in the tree.

2. Choose View→Audit→View Audit Logs.

   OR

   Right-click an object in My Teamcenter and choose View Audit Logs.

   The system displays the Audit Log dialog box.

   • If you select an object, the object ID, name, revision, and object type are displayed in the Search Criteria section.

   • To select a project, select a project you have access to from the Project list.

   • If you want to search for a different object, click the Clear button to clear the existing search criteria and then type the object ID, name, and revision in the Audit Log dialog box.

3. (Optional) Specify additional search criteria, such as event type, user ID, and date created.

4. (Optional) Click the Advanced tab and type criteria to construct a query based on property values.

   Note The Advanced tab does not display any information if there are no logged properties in the audit definition object.
a. Select an object type from the **Object Type** list. After you select an object type, the **Event Type** list is enabled.

b. Select an event type from the **Event Type** list. The logged properties defined in the audit definition object are shown in the **Available Properties** list.

c. Select the properties for which you require audit logs from the **Available Properties** list, and click the **+** button to move the property to the **Selected Search Criteria** list.

   **Note** You can add up to 20 properties in the **Selected Search Criteria** list.

d. To search for properties based on old or new values, in the **Selected Search Criteria** list, enter the old value in the **Old Value** column and the new value in the **New Value** column.

e. Click **Find**. Audit logs that match your selected criteria appear.

5. Click **Find**.
The system displays the audit logs that match the search criteria.

Property value changes are shown in the **User Data** column of the audit log. The **User Data** column shows the property name, the old value of the property, and the new value of the property.

The old value of the property is the same as the new value of the property if the property value does not change.

**Note** Only persistent properties of objects are tracked. Run-time, compound, and relational properties are not tracked by Audit Manager.
Appendix

A  Glossary
Appendix

A  Glossary

A

access control entry (ACE)
In Access Manager, each pairing in the access control list of an accessor with the granted privileges.

access control list (ACL)
Access Manager component that contains a list of accessors and, for each accessor, the privileges granted, denied, and not set.

Access Manager (AM)
Teamcenter application that enables the system administrator to grant users access to Teamcenter objects.

ACE
See access control entry (ACE).

ACL
See access control list (ACL).

action handler
Handler used to extend and customize workflow task actions. Action handlers perform such actions as displaying information, retrieving the results of previous tasks (inherit), notifying users, setting object protections, and launching applications. See also task handler.

add status task
Task template that creates and adds a release status to the target objects of a workflow process. There is no dialog box associated with this template.

ad hoc process modification
Functionality that allows users to add tasks to, or delete tasks from, an active workflow process.

AM
See Access Manager (AM).

approver
User who has a signoff in a workflow process regardless of role and group membership. In Access Manager, the approver accessor is used to allocate privileges that apply to all signoffs (for example, read access). See also RIG approver, role approver, and group approver.
D

Do task
Task template that includes the **EPM-hold** handler, which stops the task from automatically completing when the task is started. This template has a customized dialog box that allows administrators to set a check box to indicate when the task is complete.

G

**group approver**
User who is a signoff in a workflow process with a specific group of users. In Access Manager, the group approver accessor is used in Workflow ACLs and matches the signoff definition (that is, group) for the release level associated with the Workflow ACL. The group approver accessor ensures that only signoffs are given privileges, not a user who matches the group. See also **approver**, **RIG approver**, and **role approver**.

P

**privileged user (workflow)**
Responsible party, process owner, or member of the system administration group. Privileged users have greater control over workflow tasks. For example, they can promote, demote, and skip workflow tasks.

**process owner**
User who initiates the workflow process; also known as the process initiator. When the process is initiated, the process owner becomes the responsible party for the process. Whenever any task in the process is not explicitly assigned to another user, person, or resource pool, the responsible party for the task defaults to the process owner.

**process template**
Blueprint of a workflow process defined by placing workflow and/or change management tasks (for example, do, perform signoff, route, and checklist) in the required order of performance. Additional process requirements, such as quorums and duration times are defined in the template using workflow handlers.

Q

**quorum**
Number of users who must vote to approve a task for that task to be approved.

R

**release status**
Status associated with a workspace object when it is released through a workflow process.

**review task**
Task template that includes the **select-signoff-team** and **perform-signoffs** subtasks. Each subtask contains a unique dialog box for executing the process.
RIG approver
User who is a signoff in a workflow process with a specified role and group. In Access Manager, the RIG approver accessor is used in Workflow ACLs and matches the signoff definition (that is, role in group) for the release level associated with the Workflow ACL. This accessor ensures that only signoffs are given privileges, not a user who matches the role in group. See also approver, group approver, and role approver.

role approver
User who is a signoff in a workflow process with a specific role. In Access Manager, the role approver accessor is used in Workflow ACLs and matches the sign-off definition (that is, role in group) for the release level associated with the Workflow ACL. This accessor ensures that only signoffs are given privileges, not a user who matches the role. See also approver, group approver, and RIG approver.

rule handler
Handler used to integrate workflow business rules into Enterprise Process Modeling processes at the task level. Rule handlers attach conditions to an action. See also task handler.

task handler
Small Integration Toolkit program or function. Handlers are the lowest level building blocks in Enterprise Process Modeling. They are used to extend and customize tasks. There are two kinds of handlers: action handlers and rule handlers. See also action handler and rule handler.

W

workflow
Automation of the concept that all work flows through one or more business processes to accomplish an objective. Using workflow, documents, information, and tasks are passed between participants during the completion of a particular process.

Workflow Designer
Teamcenter application that enables administrators to graphically design workflow process templates, incorporating company business practices and procedures into the templates. Teamcenter users initiate workflow processes using these templates.

Workflow Viewer
Teamcenter application that enables users to view the progress of a workflow process. Users are not required to be participating members of the process being viewed. Depending on preference settings, Workflow Viewer also allows ad hoc process modification. See also ad hoc process modification.
Index

A
Access control list .......................... 1-52
Acknowledge task, signing off ................. 2-6
ACL ........................................ 1-52
Action handlers ................................ 1-6
Active processes updated in the background ................................ 1-71
Ad hoc signoff ................................ 1-24
Ad hoc subprocesses ........................... 1-22
Assigning
  Work contexts ................................ 1-46
Assigning a task ................................ 1-38
ASYNC_connection_retries preference .......... 1-72
ASYNC_connection_retry_interval preference .......... 1-72
async_invoker .................................. 1-72
asyncservice service .......................... 1-71
Attributes ..................................... 1-6

B
Background updating of active processes ................................ 1-71
Backspace key removes text ...................... 25
Boxes
  Duration ..................................... 1-51
  Year ......................................... 1-50
Browse mode ................................... 15

C
cleanup intervals in translator.xml file ......................... 1-72
Completing
  Custom task ................................ 2-22
  Do task ..................................... 2-19
  Manual condition task ....................... 2-19
Configure applying template edits to processes ................................ 1-78
Configure background process updates ............. 1-71
Configuring view tables ........................ 2-35
Copying tasks ................................... 25
Creating
  Process assignment lists ....................... 1-39
  Templates ................................... 1-1
  Work contexts ................................ 1-46
  Creating subprocesses ......................... 1-13
  Creating workflow subprocesses ............... 1-23
  Custom task, completing ..................... 2-22

D
Delete
  Workflow process ............................ 2-34
Delete key removes workflow objects .............. 25
Deleting
  Work contexts ................................ 1-46
Demoting tasks ................................ 2-27
Dialog boxes
  Export To Excel .............................. 2-37, 3-4
Do task, completing ................................ 2-19
Do tasks ....................................... 2-14
Docking the Handler dialog box .................... 26
Due Date ....................................... 1-50
Duration box ................................... 1-51

E
Edit mode effect on the Delete key ................. 25
Editing templates ................................ 1-77
Editing templates online and offline .............. 1-77
Editing workflow templates ........................ 1-75, 1-77
Edits applied to active processes .................. 1-80
EPM_enable_apply_template_changes preference .......... 1-78
EPM_valid_user_to_apply_assignment_list preference .......... 1-43
Export audit logs from Details view ................ 3-4
Export To Excel dialog box ........................ 2-37, 3-4

H
Handler dialog box docked versus undocked ........... 26
Handler dialog box moving and resizing ............. 26
Handler example 1
  ACMERP (Status task) ......................... 1-65
  Start node .................................. 1-63
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Handlers ........................................ 1-6</td>
</tr>
<tr>
<td>Action ........................................... 1-6</td>
</tr>
<tr>
<td>Retyping .......................................... 25</td>
</tr>
<tr>
<td>Rule ............................................... 1-6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>isactive attribute in translator.xml file ........................................ 1-72</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>M</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual condition task, completing ........................................ 2-19</td>
</tr>
<tr>
<td>Manual condition tasks ....................................................... 2-14</td>
</tr>
<tr>
<td>Manual custom tasks .......................................................... 2-15</td>
</tr>
<tr>
<td>maxlimit attribute in translator.xml file ................................... 1-72</td>
</tr>
<tr>
<td>Modifying</td>
</tr>
<tr>
<td>Process assignment lists ....................................................... 1-41</td>
</tr>
<tr>
<td>Moving the Handler dialog box ................................................. 26</td>
</tr>
<tr>
<td>Multi-Site Collaboration ....................................................... 1-66–1-67</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>No date set value .............................................................. 1-50</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offline template editing ..................................................... 1-77</td>
</tr>
<tr>
<td>Online template editing ...................................................... 1-77</td>
</tr>
<tr>
<td>origin_uid ................................................................. 1-68</td>
</tr>
<tr>
<td>Out of office assistant ....................................................... 1-31</td>
</tr>
<tr>
<td>Out of office status .......................................................... 1-31</td>
</tr>
<tr>
<td>Overdue tasks ................................................................. 1-50</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>P</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pasting tasks ................................................................. 25</td>
</tr>
<tr>
<td>Paused task, starting ........................................................... 2-29</td>
</tr>
<tr>
<td>Paused tasks</td>
</tr>
<tr>
<td>Starting ................................................................. 2-26</td>
</tr>
<tr>
<td>perform-signoffs tasks ....................................................... 2-4</td>
</tr>
<tr>
<td>polling interval in translator.xml file ..................................... 1-72</td>
</tr>
<tr>
<td>Preferences</td>
</tr>
<tr>
<td>EPM_valid_user_to_apply_assignment_list ................................... 1-43</td>
</tr>
<tr>
<td>SIGNOFF_required_group_and_role ............................................ 2-8, 2-11</td>
</tr>
<tr>
<td>TC_wc_setting_modifiable_default ........................................... 1-46</td>
</tr>
<tr>
<td>Process assignment lists ...................................................... 1-39, 1-44</td>
</tr>
<tr>
<td>Assigning responsible parties ............................................... 1-40–1-41, 1-44, 2-2</td>
</tr>
<tr>
<td>Assigning tasks ................................................................. 1-40–1-41, 1-44, 2-2</td>
</tr>
<tr>
<td>Creating ................................................................. 1-39</td>
</tr>
<tr>
<td>Modifying ................................................................. 1-41</td>
</tr>
<tr>
<td>Replacing users in ............................................................. 1-42</td>
</tr>
<tr>
<td>Process template ............................................................... 15</td>
</tr>
<tr>
<td>Promoting tasks ............................................................... 2-25, 2-27</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>R</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reassigning a task ......................................................... 1-38</td>
</tr>
<tr>
<td>Recipients ................................................................. 1-51</td>
</tr>
<tr>
<td>Relations</td>
</tr>
<tr>
<td>TC_WorkContext_Relation ..................................................... 1-45</td>
</tr>
<tr>
<td>Remote inboxes ............................................................... 2-29</td>
</tr>
<tr>
<td>Checking out data ............................................................. 2-32</td>
</tr>
<tr>
<td>Export data ................................................................. 2-32</td>
</tr>
<tr>
<td>Subscribing ................................................................. 2-31</td>
</tr>
<tr>
<td>Using ................................................................. 2-29</td>
</tr>
<tr>
<td>Removing</td>
</tr>
<tr>
<td>Work contexts from objects .................................................. 1-46</td>
</tr>
<tr>
<td>Replicating workflow templates ............................................ 1-66</td>
</tr>
<tr>
<td>Resizing the Handler dialog box .......................................... 26</td>
</tr>
<tr>
<td>Resource pools</td>
</tr>
<tr>
<td>Assigning ................................................................. 1-47</td>
</tr>
<tr>
<td>Subscribing ................................................................. 1-47</td>
</tr>
<tr>
<td>Using ................................................................. 1-47</td>
</tr>
<tr>
<td>Review task ................................................................. 2-8</td>
</tr>
<tr>
<td>Route tasks ................................................................. 2-16, 2-21</td>
</tr>
<tr>
<td>Rule handlers ................................................................. 1-6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>S</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample workflows</td>
</tr>
<tr>
<td>Change Manager ............................................................ 1-54</td>
</tr>
<tr>
<td>Replace status of target objects ........................................... 1-62</td>
</tr>
<tr>
<td>Security Services for background processing ................................ 1-73</td>
</tr>
<tr>
<td>Signing off</td>
</tr>
<tr>
<td>Acknowledge task ............................................................ 2-6</td>
</tr>
<tr>
<td>Review task ................................................................. 2-8</td>
</tr>
<tr>
<td>Tasks ................................................................. 2-5</td>
</tr>
<tr>
<td>Signoff tasks</td>
</tr>
<tr>
<td>Assigning ................................................................. 1-26</td>
</tr>
<tr>
<td>Delegating ................................................................. 1-24</td>
</tr>
<tr>
<td>Reassigning ................................................................. 1-24</td>
</tr>
<tr>
<td>Signoff team, selecting ..................................................... 1-27</td>
</tr>
<tr>
<td>Signoff teams ................................................................. 1-26</td>
</tr>
<tr>
<td>SIGNOFF_required_group_and_role preference ................................ 2-8</td>
</tr>
<tr>
<td>SIGNOFF_required_group_and_role preference ................................ 2-11</td>
</tr>
<tr>
<td>Skipping tasks ............................................................. 2-25, 2-27</td>
</tr>
<tr>
<td>SOA URL for background processing ........................................ 1-73</td>
</tr>
<tr>
<td>Start node</td>
</tr>
<tr>
<td>Handler example 1 ............................................................ 1-63</td>
</tr>
<tr>
<td>Subprocess creation ......................................................... 1-23</td>
</tr>
<tr>
<td>Subprocesses ................................................................. 1-13</td>
</tr>
<tr>
<td>From a workflow template ................................................... 1-14</td>
</tr>
<tr>
<td>From an in-process task ...................................................... 1-22</td>
</tr>
</tbody>
</table>
Surrogate users ........................................... 1-32
Access privileges ...................................... 1-32
Defining ................................................. 1-33–1-34
Delegating tasks to .................................... 1-35
Removing ............................................... 1-35
Suspended tasks ...................................... 2-26
Synchronizing workflow templates ................. 1-67

T
Tables
  Configure view tables data display .................. 2-35
Task
  Delete .................................................. 2-34
Task attributes, editing ................................ 1-6
Task handlers .......................................... 1-9
  Creating .............................................. 1-10–1-11
  Deleting ................................................ 1-12
  Editing .................................................. 1-12
  Viewing ............................................... 1-9
Task template ......................................... 17
TASK_MONITOR_SLEEP_TIME value ................. 1-51
Tasks ...................................................... 13, 1-2
  Acknowledge ......................................... 2-6
  Attributes ............................................ 1-6
  Copying ................................................ 25
  Delegating to surrogate ............................ 1-35
  Demoting ............................................. 2-25, 2-27
  Linking manually .................................... 1-13
  Overdue .............................................. 1-50
  Overriding actions .................................. 2-23
  Pasting ............................................... 25
  Promoting .......................................... 2-25, 2-27
  Review ............................................... 2-8
  Signing off .......................................... 2-5
  Skipping ............................................. 2-25, 2-27
  Starting paused ..................................... 2-29
  Suspend .............................................. 2-26
  Undoing .............................................. 2-25
Tasks to Perform folder .............................. 9
Tasks to Track folder ................................ 10
TC_we_setting_modifiable_default preference .... 1-46
Template edits ........................................ 1-75, 1-77
Template edits applied to active processes ........ 1-80
Template edits applied to processes configuration .... 1-78
Templates
  Creating ............................................. 1-1
  Editing ............................................... 1-77
  Workflow process ................................... 15
  Workflow task ...................................... 17
  Templates edited online and offline .......... 1-77
  translator.xml file ................................. 1-71

U
Undocking the Handler dialog box ............... 26

V
View audit logs ........................................ 3-1, 3-5
  Audit queries ..................................... 3-3
  Summary view ...................................... 3-1
View tables
  Configuring ........................................ 2-35

W
Work contexts ......................................... 1-45
  Assigning ......................................... 1-46
  Creating .......................................... 1-46
  Deleted ............................................ 1-46
  Removing from objects ............................ 1-46
Workflow
  Ad hoc signoff teams ............................... 1-24
  Assigning a task .................................. 1-38
  Assigning all tasks ................................ 1-44
  Assigning tasks to resource pools ............... 1-47
  Completing custom tasks .......................... 2-15
  Completing do tasks ................................ 2-14
  Completing manual condition tasks .............. 2-14
  Completing perform-signoffs tasks .............. 2-4
  Completing route tasks ............................ 2-16
  Defining surrogate users ......................... 1-32
  Demoting tasks ................................... 2-25
  Initiating processes ................................ 2-1
  Out of office assistant ............................ 1-31
  Process assignment lists ......................... 1-39
  Reassigning a task ................................ 1-38
  Resource pools .................................... 1-47
  Resume tasks ...................................... 2-26
  Selecting signoff teams ......................... 1-26
  Setting a due date for a task ................... 1-48
  Setting a task duration ........................... 1-49
  Setting out of office status ..................... 1-31
  Starting paused tasks ............................. 2-26
  Suspend tasks ..................................... 2-26
  Tasks to Perform folder .......................... 9
  Tasks to Track folder ................................ 10
  Using process assignment lists .................. 1-44
Workflow Designer
  Refreshing .......................................... 25
  Tasks ............................................... 13
  Workflow process ..................................
## Index

<table>
<thead>
<tr>
<th>Delete ........................................</th>
<th>2-34</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow process template ................</td>
<td>15</td>
</tr>
<tr>
<td>Workflow subprocesses .....................</td>
<td>1-13, 1-23</td>
</tr>
<tr>
<td>Workflow task template ...................</td>
<td>17</td>
</tr>
<tr>
<td>Workflow template editing ................</td>
<td>1-77</td>
</tr>
<tr>
<td>Workflow template edits ...................</td>
<td>1-75</td>
</tr>
<tr>
<td>Workflow template edits applied to active processes</td>
<td>1-80</td>
</tr>
<tr>
<td>Workflow templates</td>
<td></td>
</tr>
<tr>
<td>Exporting</td>
<td>1-70</td>
</tr>
<tr>
<td>Importing</td>
<td>1-68</td>
</tr>
<tr>
<td>Multiple sites</td>
<td>1-66</td>
</tr>
<tr>
<td>Replicating</td>
<td>1-66</td>
</tr>
<tr>
<td>Synchronizing</td>
<td>1-67</td>
</tr>
<tr>
<td>Workflow templates and the Delete key</td>
<td>25</td>
</tr>
<tr>
<td>Workflow, Completing route tasks</td>
<td>2-21</td>
</tr>
<tr>
<td>Year box</td>
<td>1-50</td>
</tr>
</tbody>
</table>

Y